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Pl Integrator for Business Analytics 2020 R2
SP2

O Pl Integrator for Business Analytics transforma os dados do Pl System em um formato pronto para decisdao que
pode ser consumido por ferramentas de business intelligence (Bl), como Microsoft Power BI, Tableau, Tibco
Spotfire e QlikView. Com as ferramentas B, vocé pode executar analises retrospectivas em grandes conjuntos de
seus dados em tempo real do Pl System. Essas analises tornam visiveis comportamentos e padrdes operacionais
para que vocé possa identificar dependéncias e correlagGes entre diferentes aspectos das suas operagoes.

A edicdo Standard do Pl Integrator for Business Analytics publica views de ativos e eventos para muitos bancos
de dados relacionais, data lakes, armazéns de dados e destinos de arquivos. O Pl Integrator for Business Analytics
pode, nativamente, integrar-se ao Microsoft SQL Server, Amazon S3, Azure Data Lake Storage Gen2, Google
Cloud Storage, Azure SQL e muito mais! Para obter uma lista completa, consulte Edi¢cdes do Pl Integrator for
Business Analytics.

A edicdo Advanced do PI Integrator for Business Analytics fornece pacotes em tempo real de dados do Pl System
para plataformas de streaming, tais como o Apache Kafka. As plataformas de streaming auxiliam na
operacionalizacdo de modelos de aprendizagem de maquina e suportam as arquiteturas Kappa e Lambda para
consumo de dados. A edicdo Advanced do Pl Integrator for Business Analytics suporta todas as funcionalidades
da edicdo Standard e publica views de streaming para destinos populares de hub de mensagens, como Apache
Kafka, Azure loT Hub, Amazon Kinesis e Google Cloud Pub/Sub. Para obter uma lista completa, consulte EdicGes
do Pl Integrator for Business Analytics.

O Pl Integrator for Business Analytics 2020 R2 SP2 foi lancado e esta disponivel para download.
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O que é o Pl Integrator for Business
Analytics?

O Pl Integrator for Business Analytics apresenta dados do PI System adequados as ferramentas de inteligéncia
empresarial e, incluindo, entre outros, Tableau, Tibco Spotfire, QlikView e Microsoft Power Bl para relatério e
anadlise. As ferramentas cliente de Business Intelligence (Bl) oferecem a capacidade de executar analises
retrospectivas em um conjunto muito maior dos seus dados do Pl System em tempo real. O Bl ajuda-o a
aprender com os comportamentos e padrdes operacionais, identificando dependéncias e correlacGes de varios
fatores nas suas operagdes.

Dados de séries cronoldgicas nativos, contexto de ativo e contexto de evento sdo expostos por meio de
visualizagOes configuradas on-line. Os dados sao modelados em termos dimensionais, limpos e apresentados
com metadados adequados de modo que as ferramentas de Bl possam procurar, consultar e consumir
continuamente dados do PI System. Os dados podem ser integrados diretamente e carregados em plataformas
de data warehouse. O Pl Integrator for Business Analytics elimina a necessidade de conhecimento em
programacdo ou SQL e gerencia todo o ciclo de vida de dados, incluindo acesso, atualizacGes e procedéncia de
dados.

O Pl Integrator for Business Analytics requer um modelo do Pl Asset Framework (Pl AF) para selecionar dados do
Pl System para produzir dados prontos para decisdo. E possivel limpar os dados utilizando uma variedade de
filtros e aprimora-los com contexto de ativo, evento e tempo do Pl System. Os dados resultantes podem ser
imediatamente utilizados em ferramentas de Bl sem a necessidade de modificagGes.

Vantagens do Pl Integrator for Business Analytics

As vantagens de usar o Pl Integrator for Business Analytics sdo:

¢ Grandes conjuntos de dados podem ser facilmente selecionados e importados. Ndo ha necessidade de
codificacdo para preparar os dados e nenhum conhecimento dos dados de origem é exigido.

¢ O tamanho do conjunto de dados pode ser ampliado sem exigir personaliza¢do dos procedimentos de
importagdo de dados.

¢ Os dados do PI System podem ser mesclados com outros conjuntos de dados para analise de nivel agregado
e podem ser consumidos por uma variedade de ferramentas de business intelligence, armazéns de dados e
plataformas de streaming.

¢ Os dados publicados sdo sincronizados com o Pl System e automaticamente atualizados para refletir as
alteragdes nos destinos de publicagdo selecionados.

¢ Os dados sao atualizados em uma agenda ou em resposta as alteracdes nos valores principais.

¢ Ainterface do usuario on-line é facil de usar, ndo exigindo qualquer instalagdo por parte dos usuarios finais.

Adverténcias de uso do Pl Integrator for Business Analytics

Observe o seguinte sobre o Pl Integrator for Business Analytics:

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 8
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¢ O Pl Integrator for Business Analytics oferece suporte apenas a dados com timestamp no passado. Dados
futuros nao sdo suportados no momento.

¢ O Pl Integrator for Business Analytics publica dados do Pl System em uma ampla variedade de destinos. No
entanto, ele ndo grava as alteragdes dos destinos de volta no Pl Data Archive ou no servidor AF.

¢ Asviews de streaming foram criadas para ajudar vocé a operacionalizar um modelo de aprendizagem de
maquina ou uma analise, alimentando dados em tempo quase real. As views de streaming ndo se destinam a
atuar como uma sincronizagao em tempo real de todo o Pl System e podem encontrar problemas de
desempenho devido ao aumento da sobrecarga no Pl Integrator.

¢ As views de streaming acionadas por chave podem comecar a experimentar problemas de desempenho
com 100-200 correspondéncias em uma Unica view.

¢ Asviews de streaming agendadas podem lidar com milhares de correspondéncias por view, dependendo
de outros fatores de desempenho. Ha um limite rigido de 25.000 correspondéncias totais do formato de
busca por view.

e O servico Pl Integrator Sync requer que apenas um membro do coletivo Pl Data Archive tenha um nivel de
prioridade 1 a qualquer momento. Varios membros com o nivel de prioridade 1 ndo tém suporte para o PI
Integrator Sync.
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Edicbes do Pl Integrator for Business
Analytics

Ha duas edicdes do Pl Integrator for Business Analytics:

e Padrio

A edicdo Standard é uma solugdao empresarial para clientes que desejam publicar os dados do Pl System em
um armazém de dados externos. Uma vez exportados para esses armazéns de dados, os dados do Pl System
podem ser mesclados a dados de outros sistemas.

¢ Avangada

Além de publicar dados em armazéns de dados externos, a edicao Advanced suporta dados de streaming
para destinos de streaming suportados. Depois de publicados, esses dados podem ser usados para treinar
aplicativos de aprendizagem da maquina para descobrir padrdes e prever comportamento futuro.

Destinos de publicacao suportados

A tabela a seguir mostra os diferentes destinos de publica¢do suportados em cada edicdo e os tipos de views
suportadas em cada destino. Para obter mais informacgdes, consulte Views do Pl Integrator for Business Analytics.

Destino de
Tipo de Elementos . Edigao Edicao
Destino Monitorado Formato Views suportadas Standard Advanced
s
Views de Views de Views de
ativos eventos streaming
Geral Arquivo de | linha- J / / J
Texto coluna
Banco de Microsoft linha- / / / /
dados SQL Server | coluna
relacional
sanco de v v v v
dados
Oracle
panco de v v v v
dados do
Azure SQL
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Tipo de
Destino

Destino de
Elementos
Monitorado
s

Formato

Views suportadas

Edigao
Standard

Edigao
Advanced

SAP HANA
(ODBC)

AN

AN

Data
Warehouse

Apache
Hive

Pool de SQL
Dedicado
do Azure

Amazon
Redshift

Google
BigQuery

linha-
coluna

Data Lake

Hadoop
HDFS

Amazon S3

Google
Cloud
Storage

Azure Data
Lake
Storage Gen
2

linha-
coluna

AN NENE N NERNEANE VNI

AN AN NE NER NI NI NER N

AN NE NE N NERNENE VNI

Hub de
Mensagem

Apache
Kafka

Hub loT do
Azure

Hubs de
Evento do
Azure

transmissao

AN

AN NN NE NE NA NI NER N N TR
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Destino de
Tipo de Elementos . Edigao Edigao
Destino Monitorado Formato Views suportadas Standard Advanced

v
v

Amazon
Kinesis Data
Streams

AN

Google
Cloud Pub/
Sub

AN
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Arquitetura do sistema

O diagrama a seguir mostra uma arquitetura tipica de um sistema do Pl Integrator for Business Analytics.

Arquitetura do Sistema do PI Integrator for Business Analytics

Hadoap Arurg MS S0 e 9 »

- Represents separate processes
B  Represents required services

Destination Targets

O seguinte descreve os componentes necessarios para os destinos do armazém de dados. Todos os processos do
Pl Integrator Framework, Pl Integrator Worker Nodes e Pl Integrator Sync residem no mesmo computador.

¢ Pl Integrator Framework
O Pl Integrator Framework executa as seguintes fung¢des:
¢ Fornece o aplicativo da web por meio do qual as views sdo criadas, publicadas e gerenciadas.
e Agenda trabalhos a serem publicados.

¢ Distribui trabalhos entre o Pl Integrator Worker Nodes para equilibrar a publicagdo de views entre as
maquinas. Neste diagrama, ha somente uma maquina de trabalho.

¢ Controla e gerencia os streams de saida usados nas views.

¢ Registra estatisticas da view incluindo o tempo para publicar a view, o nimero de linhas gravadas, o
numero de linhas filtradas e a contagem de erros.

¢ Pl Integrator Sync
O PI Integrator Sync monitora os seguintes dados:

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 13
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¢ Formato das views e alteragdes de dados de views de ativos agendados e views de transmissao
agendada

¢ Alteracbes do formato das views de streaming enviadas pelo valor principal
¢ Pl Integrator Worker Node

O Pl Integrator Worker Node publica trabalhos em seus destinos. Mdquinas de trabalho adicionais podem
ser instaladas para melhorar o desempenho.

¢ Pl Asset Framework (Pl AF)

O Pl Integrator for Business Analytics recupera e atualiza definicdes de view armazenadas no banco de dados
de configuracdo do Pl AF.

e SQL Server
Tabelas de metadados, logs e estatisticas sdo armazenados no SQL Server.
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Requisitos do sistema

Requisitos para Pl Integrator for Business Analytics

Esta secdo descreve os requisitos do sistema para uma instalacdo do Pl Integrator for Business Analytics e para
cada um dos destinos de publicacdo compativeis.

A seguir, estdo os requisitos do sistema para o Pl Integrator for Business Analytics:

Pl Server 2018 ou posterior
* Pl Asset Framework
e Data Archive

PI AF SDK 2024

Nota: o Pl AF SDK 2024 estd incluido na ferramenta cliente do Pl AF 2024. A ferramenta cliente do Pl AF 2024
é fornecida com o Pl Integrator for Business Analytics 2020 R2 SP2. Para usar os recursos de idioma e
localidade, o recurso de Pacotes de Idiomas para a ferramenta cliente do Pl AF 2024 deve ser instalado.

16 GB de memoria e dois nucleos de CPU modernos

Nota: isso é suficiente para o minimo de um processo do Worker Node instalado. Para cada processo
adicional do Worker Node na mesma maquina, adicione 4 GB de memédria e dois nucleos de CPU modernos.

Microsoft Windows Server 2016, 2019, 2022

Nota: o Microsoft Windows Server deve ser parte de um dominio e ndo pode ser instalado em um
computador ndo conectado a um Active Directory do Windows. (As maquinas unidas ao GRUPO DE
TRABALHO ndo sdao compativeis com a implementagdo deste produto.)

Microsoft SQL Server 2016, 2017, 2019, 2022. Instale o servidor do Microsoft SQL no mesmo dominio do
usuario instalador ou em um dominio que confie no dominio do usudrio instalador. O usudrio instalador deve
ser capaz de autenticar, usando a autenticacdo do Windows, no SQL Server back-end, mesmo que a
autenticacdo SQL seja especificada. Nao instale o SQL Server back-end do Pl Integrator for Business Analytics
em um grupo de trabalho ou em um dominio que nao confie no dominio do usuario instalador.

Nota: a versdao completa do servidor do SQL é recomendada para melhor desempenho.

O componente Full-Text Search do Microsoft SQL Server é um requisito do Pl Integrator for Business
Analytics. O Full-Text Search permite que o servico do Pl Integrator Framework faca a indexacdo e gerencie
numeros grandes de tags do Pl e controle as altera¢des nos formatos da view. Observe que o Full-Text Search
é um componente opcional do SQL Server Database Engine e pode ser adicionado durante a instalacdo do
Microsoft SQL Server ou posteriormente executando o SQL Server Setup. Instalar antes de atualizar o PI
Integrator for Business Analytics.

Requisitos do navegador da Web

Use um dos seguintes navegadores da web:

Versao recente do Google Chrome

Versdo recente do Microsoft Edge
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Requisitos de destino de publicacdao do Banco de dados Oracle
O destino de publica¢cdo do banco de dados Oracle requer:
¢ Oracle Client for Microsoft Tools 19c (64 bits)
O Pl Integrator for Business Analytics é compativel com as seguintes versdes do Banco de dados Oracle:

¢ Banco de dados Oracle 23c Versdo para Microsoft Windows (x64)

Requisitos do destino de publicacao do SAP HANA ODBC

Os destinos do SAP HANA ODBC exigem:

e SAP HANA Client
Pl Integrator for Business Analytics foi testado com as seguintes versdes do SAP HANA Client:
e SAP HANA Client Versao 2.3.144 Windows x64
e SAP HANA
Ha suporte para as seguintes versdes do SAP HANA:
e SAP HANA Versao 2.0 SPS 03

Requisitos de destinos da Amazon Web Services

A Amazon Web Services exige a versdo atual dos seguintes Amazon Web Services:

e Amazon Kinesis Data Streams
e Amazon Redshift

e Amazon S3

Driver ODBC do Amazon Redshift
O Pl Integrator for Business Analytics foi testado com as seguintes versdes do driver ODBC do Amazon Redshift:

e Driver ODBC versdo 1.5.9.1011 do Amazon Redshift (x64)

Versoes testadas do Apache Hadoop

Pl Integrator for Business Analytics foi testado com os seguintes software:

e HortonWorks —HDP 3.1.0.0
¢ Apache Hive - 3.1.0
e HDFS —3.1.1

Nota: o Pl Integrator for Business Analytics ndo foi testado com o Apache Hive com CDH (Cloudera).
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Versoes testadas do Apache Kafka

Pl Integrator for Business Analytics foi testado com as seguintes versdes do Apache Kafka: 3.9x, 3.8x, 3.7x.

Versoes testadas do Apache Thrift

O Pl Integrator for Business Analytics foi testado com o Apache Thrift 0.9.3.0. O PI Integrator for Business
Analytics provavelmente é compativel com outras versdes também.

Requisitos do Google Cloud

Versdo atual de um ou mais dos seguintes servicos do Google Cloud Platform:

¢ Google Cloud Storage
e Google BigQuery
¢ Google Cloud Pub/Sub

Requisitos do Microsoft Azure

Versdo atual de um ou mais dos seguintes servicos do Microsoft Azure:

¢ Hubs de Evento do Azure

e Hub loT do Azure

¢ Banco de dados do Azure SQL
e Pool de SQL Dedicado do Azure
¢ Azure Data Lake Storage Gen 2

Versoes testadas do registro do esquema

O PI Integrator for Business Analytics foi testado com Confluent Schema Registry 4.0.0. O Pl Integrator for
Business Analytics, provavelmente, também é compativel com outras versoées.
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Como instalar o Pl Integrator for Business
Analytics

O Pl Integrator for Business Analytics é composto pelas seguintes fases de instalacdo:

¢ Fase 1: preparar a instalacao

Essa fase garante que vocé tenha o acesso e as permissdes apropriadas para os componentes que interagem
com o Pl Integrator for Business Analytics: PI AF Server, Pl Data Archive e Microsoft SQL Server. Esses pré-
requisitos devem ser atendidos antes da execuc¢do do kit de instalacdo para o Pl Integrator for Business
Analytics.

¢ Fase 2: instalar o Pl Integrator for Business Analytics

Nesta fase, vocé instala o Pl Integrator for Business Analytics, especificando o Pl AF Server e o Microsoft SQL
Server. Novos bancos de dados do Pl Integrator sdo criados no Microsoft SQL Server para Pl Integrator for
Business Analytics.

¢ Fase 3: verificar a instalagao

Essa fase verifica se os servicos do Pl Integrator for Business Analytics inicializaram e se estdo rodando.
Os tdpicos a seguir descrevem as etapas para cada fase da instalagdo em mais detalhes:

e Fase 1: prepare-se para instalar o Pl Integrator for Business Analytics
e Fase 2:instalar o Pl Integrator for Business Analytics

¢ Fase 3: verificar a instalagao

Fase 1: prepare-se para instalar o Pl Integrator for Business
Analytics

Os seguintes componentes sdo necessdrios para uma instalacdo bem-sucedida do Pl Integrator for Business
Analytics: Pl Server (que inclui o Pl Asset Framework Server e o Pl Data Archive) e Microsoft SQL Server (que
incluird os bancos de dados que armazenam metadados para views continuas e os bancos de dados de
estatisticas e os logs do Pl Integrator for Business Analytics).

1. Certifique-se de que os requisitos minimos sejam atendidos e que o software exigido esteja instalado.
Consulte Requisitos do sistema.

2. Considere onde vocé instalard os componentes na instalacdo do Pl Integrator for Business Analytics.

O produto PI Integrator pode ser instalado usando contas virtuais do Windows ou contas de usuario de
dominio do Windows. As senhas das contas virtuais e das contas de servigo gerenciado sdo gerenciadas pelo
sistema operacional Windows. A opc¢ao de instalacdo padrao é usar contas virtuais que nao exigem
especificacdo de nome de usudrio ou senha. Se estiver usando contas de usuario de dominio do Windows,
obtenha um nome de usuario de conta de servigo do Windows. Se vocé nao estiver usando uma conta de
servigo gerenciada (MSA) ou uma conta de servigo gerenciada por grupo (gMSA), vocé precisard de uma
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senha para seu dominio. Podera ser necessario entrar em contato com seu administrador de Tl para criar um
para vocé.

Nota: para a implementag¢do de seguran¢a mais alta, recomendamos usar uma Conta de Servigo Gerenciada
(MSA), uma Conta de Servigo Gerenciada por grupo (gMSA) ou Contas Virtuais, mas uma conta de usuario do
dominio padrdo dedicada a execuc¢do do servico também é compativel.

4. A conta de usuario usada para instalar o Pl Integrator for Business Analytics deve ser de um usudrio do
dominio com privilégios de administrador local, localizado no Microsoft Windows Server onde vocé instalara
o Pl Integrator for Business Analytics.

5. Certifique-se de que a conta de usudrio usada para instalar o software tenha privilégios sysadmin no SQL
Server no qual vocé instalara os bancos de dados do Pl Integrator. Isso é necessdrio para criar os bancos de
dados SQL de backend do Pl Integrator.

Nota: se ndo for possivel conceder os privilégios necessarios a conta de usuario, os bancos de dados SQL
deverdo ser criados manualmente por um usuario, geralmente, um administrador de banco de dados com
sysadmin. Nesta situacdo, os bancos de dados SQL devem ser criados primeiro, antes da instalacdo do PI
Integrator for Business Analytics.

Nota: acesse o Portal do Cliente da OSlsoft para fazer o download do Pl Integrator for Business Analytics SQL
Utility, que contém o script que cria os bancos de dados. Depois de instalar os bancos de dados SQL, adicione
a conta de usuario que instalara o Pl Integrator for Business Analytics como login no SQL Server.

O usuario que fard a instalacdo do Pl Integrator for Business Analytics deve ter as seguintes permissées:

Associagdo de fung¢do no banco de dados db_accessadmin nos bancos de dados PlintegratorDB,
PlintegratorStats e PlintegratorLogs

associagdo da fungdo do banco de dados db_datareader no banco de dados PlintegratorStats

6. A conta de usudrio usada para instalar o Pl Integrator for Business Analytics precisa ser mapeada para a
identidade de administrador no Pl AF.

7. Verifique se as portas a seguir estdo disponiveis. A tabela a seguir descreve como essas portas sdo usadas na
arquitetura do PI Integrator for Business Analytics.

Funcionalidade Aplicativo Protocolo Porta Direcao Configurado em
remoto

Conexdo do PI Pl AF TCP 5457 Entrada Servidor PI AF

Integrator for

Business

Analytics com PI

AF

Conexdo do Pl | Pl Data Archive | TCP 5450 Entrada Servidor PI Data

Integrator for Archive

Business

Analytics com PI

Data Archive

Conexdao do Pl | Pl Integrator for | TCP 14331 Entrada SQL Server

Integrator for Business

Business Analytics

Analytics com o
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Funcionalidade Aplicativo Protocolo Porta Direcao Configurado em
remoto

banco de dados

sQL

Conexdes do Navegadorda | TCP 443 2 Entrada Servidor do Pl

cliente com a web do cliente Integrator for

interface de Business

usudrio do PI Analytics

Integrator for

Business

Analytics

Dados de saida | Hub loT do TCP 5671 3 Saida Servidor do PI

do Pl Integrator | Microsoft Azure Integrator for

for Business ou Hub de Business

Analytics Evento do Analytics

(obrigatério Microsoft Azure

apenas para

Microsoft Azure

loT Hub ou

Microsoft Azure

Event Hub)

1 Esta conexdo pode ser configurada para usar uma porta dinamica.

2 A porta padrdo para HTTPS é 443, mas uma porta alternativa pode ser especificada durante a instalagdo do Pl Integrator for

Business Analytics. A porta 80 ndo pode ser usada devido a convencdo da internet.
3 A Microsoft pode alterar essas portas ao longo do tempo. Consulte a documentagdo da Microsoft para obter as informagdes
mais recentes.

8. (Opcional) Entre em contato com o administrador de Tl para solicitar um certificado de uma Autoridade de
Certificacdo emitida para o servidor que executa o Pl Integrator for Business Analytics. A Entidade do
certificado deve incluir o nome do dominio totalmente qualificado (FQDN) do servidor, e o Nome Alternativo
da Entidade deve incluir tanto o FQDN e o nome da hospedagem desse servidor.

O certificado também precisa atender aos seguintes critérios:

¢ O certificado deve estar instalado no armazenamento pessoal da maquina local. Para referéncia, o
certificado do Pl Web API tem os mesmos requisitos e eles estdo listados na se¢do de problemas comuns
de instalacdo no guia do usudrio do produto.

¢ O certificado ndo pode estar expirado.

¢ O certificado deve ter uma chave privada.

¢ O certificado deve ser do tipo SHA-2.

¢ O certificado deve ter uma cadeia de confiancga valida e verificavel.

9. (Opcional) Entre em contato com o administrador de Tl se estiver instalando o PI Integrator for Business
Analytics em um ambiente em que existem varios controladores de dominio ou um controlador de dominio
somente leitura. Pode haver requisitos de porta adicionais para esses ambientes. Para obter mais
informacdes, consulte a documentagao da Microsoft sobre Requisitos de porta do Active Directory e Active
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Directory Domain Services.

Se a conta que estiver executando o servico da estrutura do Integrador Pl for uma conta de servico
gerenciado de grupo (gMSA), o mddulo do Active Directory do Windows PowerShell deverd estar instalado
no computador em que o Integrador Pl para Business Analytics esta instalado; consulte Instalar o médulo do
PowerShell do Active Directory.

Se houver uma ou mais instancias do Pl Integrator 1.x instaladas no Pl AF Server em que vocé esta instalando
essa instancia, primeiro faga upgrade de todas as instancias de 1.x para 2.x. Isso garantird que suas views do
Pl Integrator 1.x continuem sendo publicadas apés a instalagao da instancia 2.x.

Se preferir configurar pré-requisitos e configuracdes de permissdo em seus destinos de publicagdo antes de
instalar o Pl Integrator for Business Analytics, consulte a secdo Configurar destinos de publicacdo para obter
mais informacdes.

Implementacao do Pl Integrator

A seguir, sdo descritas diferentes maneiras de implantar o Pl Integrator for Business Analytics. O diagrama abaixo
mostra varias implementacdes independentes do Pl Integrator for Business Analytics. Cada instancia do Pl
Integrator aponta para sua prépria instancia do Pl AF Server e do SQL Server.

2y B ==
l *—l¢l
25 8
l "—l®-
2y 8 ==
l l@i

Pl AF Pl Integrator for  S0L Server

Business Analytics

Também é possivel instalar varias instancias do Pl Integrator for Business Analytics no mesmo Pl AF Server, como
mostrado abaixo. Um elemento da instancia do Pl AF novo e exclusivo é criado no mesmo banco de dados do PI
AF para cada instancia instalada.
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Pl Integracor for S0L Server
Business Analytics

Como alternativa, diversas instancias do Pl Integrator for Business Analytics podem apontar para o mesmo SQL
Server, conforme mostrado abaixo. Quando cada instancia for instalada, ela compartilhard os mesmos bancos de
dados SQL que as outras instancias, mas um conjunto separado de tabelas especificas da instancia serd criado
nesses bancos de dados do servidor do SQL para cada instancia do Pl Integrator for Business Analytics.

B~ B
B

B~ Biw-

Pl AF Pl Integrator for QL Server
Business Analytics

Nota: O SQL Server também pode ser instalado em uma mdaquina que esteja totalmente separada de quaisquer
instancias do PI Integrator for Business Analytics.

Em todos os casos, vocé pode instalar somente uma instancia do Pl Integrator em uma maquina.

Fase 2: instalar o Pl Integrator for Business Analytics

A Fase 2 envolve instalar o Pl Integrator for Business Analytics e especificar o Pl AF Server e o Microsoft SQL
Server.

Antes de instalar o Pl Integrator for Business Analytics:

¢ Certifique-se de que vocé atenda a todos os pré-requisitos de Fase 1: prepare-se para instalar o Pl Integrator
for Business Analytics.

Nota: cada instancia de qualquer produto do PI Integrator criada no Pl Integrator Framework deve ser
instalada em seu préprio computador.
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Faca logon no computador em que vocé instalarad o Pl Integrator for Business Analytics.

Faca o download da ultima versado do kit de instalacdo do Pl Integrator for Business Analytics em Portal do
Cliente.

Clique com o botdo direito do mouse na configuracdo executavel e clique em Executar como Administrador
para executar o assistente de instalagdo.

A janela Executavel de Extragdo Automatica é aberta.
Especifique o caminho da extracdo para o instalador e clique em OK.

A janela Boas-vindas a Configura¢ao do Pl Integrator for Business Analytics é aberta e apresenta a listagem
dos mddulos separados incluidos na instalacdo. O assistente de instalacdo instala cada mdodulo ou certifica
gue a versao correta do mdédulo ja estd instalada em seu sistema.

Clique em OK.

Se nenhum produto AVEVA tiver sido previamente instalado neste computador, vocé deve seguir os passos
seguintes. Em caso contrario, pule para o passo seguinte.

a. Najanela Servidores Padrao, especifique o Pl Data Archive Server e, de maneira opcional, o Pl AF Server,
e clique em Avangar.

b. Na janela Diretdrios de Instalagao, especifique os locais para instalar os produtos AVEVA. Vocé pode
tanto aceitar os padrdes ou especificar um local diferente.

Nota: o Pl Integrator for Business Analytics estd instalado em %PIHOME64%.

c. Clique em Préximo.
Na janela Boas-vindas a Instalagao do Pl Integrator for Business Analytics, clique em Préximo.
A janela Melhoria da Experiéncia do Cliente é exibida

Na janela Informagdes de Logon, selecione as contas virtuais ou as contas de usudrio de dominio. Se estiver
usando contas de usuario de dominio, especifique o Nome de Usuario (incluindo o dominio) e a Senha para
a conta de servico do Windows que executard os servicos Pl Integrator Framework, Pl Integrator Sync e PI
Integrator Worker Node(s).

Nota: se a conta de servico do Windows for uma Conta de Servico Gerenciado de grupo (gMSA), especifique
seu nome de usuario no seguinte formato: nomedeusudarioS e omita a senha.

Clique em Préximo.
A janela Conexao do Servidor AF é aberta.

Especifique o Pl AF Server no qual o Pl Integrator for Business Analytics armazenara as definicdes da view e
outros metadados.

No campo Servidor AF, insira 0 nome ou local (endereco IP) do PI AF Server.

Nota: se vocé encontrar um erro, certifique-se de que a conta de usuario usada para instalar o Pl Integrator
for Business Analytics seja mapeada para a identidade dos administradores AF no Pl AF Server.

Clique em Préximo.
A janela SQL Server é aberta.

Especifique o Microsoft SQL Server no qual o Pl Integrator for Business Analytics armazenara metadados de
view, dados estatisticos e logs do Pl Integrator for Business Analytics.

Especifique apenas o nome do host (ou o nome do dominio totalmente qualificado) se estiver usando a
instancia padrdo. Se estiver usando uma instancia nomeada, especifique o nome do host (ou o nome do
dominio totalmente qualificado) e a instancia, por exemplo: mySQLserverBA1\PIViewlnstance.

Especifique como o Pl Integrator for Business Analytics sera autenticado no banco de dados Microsoft SQL
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Server especificado. Escolha uma das seguintes opgdes:
¢ Autenticacdo do Windows (Padréo)

O usuario da conta de servico do Windows é usado como as credenciais para conectar o Microsoft SQL
Server.

Nota: se vocé estiver usando uma Conta de Servico Gerenciada por grupo (gMSA) ou Contas Virtuais,
serd preciso usar a autenticacdo do Windows.

¢ Autenticacdao do SQL Server

Nota: a autenticacdo do SQL Server nao é recomendada. Crie um login especifico para o servigo do Pl
Integrator Framework.

Cligue em Autentica¢ao do SQL Server para usar a autenticacdo do SQL Server para se conectar ao
banco de dados do Microsoft SQL Server especificado.

Insira o nome de usudrio e a senha para o usudrio dedicado do Microsoft SQL Server que tem o acesso
necessdario ao Microsoft SQL Server.

14. Cliqgue em Proximo.
A janela Configuragao de Certificado de Porta e TLS é aberta.

15. Insira um numero de porta valido disponivel no campo Insira um nimero de porta e clique em Validar Porta.

Nota: essa porta é usada em um navegador da web para conexdo ao Pl Integrator for Business Analytics.

A porta 80, por convencao, esta associada ao protocolo http que ndo é seguro. Como apenas https é
suportado (protocolo seguro criptografado), o uso da porta 80 é restrito.

Dica: se vocé usar a porta padrao, 443, serd possivel omitir esse nUmero da porta ao especificar a URL para o
Pl Integrator for Business Analytics.

16. Escolha um certificado TLS usando uma das seguintes fontes:

¢ (Recomendado) Certificado TLS de uma autoridade de certificacdo. Escolha Importar certificado e clique
em Selecionar Certificado para escolher um certificado que foi emitido por uma autoridade de
certificacdo e importado na maquina em que o Pl Integrator for Business Analytics estd sendo instalado.

¢ Certificado autoassinado que é gerado durante a instalagdo. Este é o padrao. Escolha Certificado
autoassinado.

Nota: caso vocé escolha essa op¢ao, os usuarios que fazem logon em mdaquinas remotas podem ver uma
mensagem de aviso de seguranca. Para evitar esse aviso para certificados autoassinados, o certificado
deve ser explicitamente de confianga na maquina do cliente. Consulte a solugao alternativa no artigo
Certificate error returned when navigating to a Pl Vision or Pl Web API web site using a self-signed
certificate da base de conhecimento.

17. Cligue em Proximo.

Nota: se ocorrer um erro, certifique-se de que a porta ndo estd sendo usada ou aberta.

18. Na janela Pl Integrator Worker Nodes, clique na seta e selecione o nimero de maquinas de trabalho que
vocé deseja que sejam instaladas e clique em Préximo.

A janela Verificacdo Obsoleta do Pl View é aberta.

Nota: cada worker node requer CPU e RAM adicionais. Para obter mais informacgdes sobre os recursos
exigidos, consulte Requisitos do sistema.

19. A etapa Verificacdo Obsoleta do Pl View exige que vocé reconheca que o destino Pl View esta obsoleto.
Todas as views existentes que usam o destino Pl View serdo desativadas da publicacdo apds a instalacgao.

¢ (Recomendado) Um scan estd disponivel para detectar quaisquer views em seu sistema que usem o
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destino Pl View. Se o scan for concluido, havera uma lista dos nomes de views para views detectadas,
bem como um link para o arquivo de lista exportado no diretério %PIHOME%\dat. Vocé pode usar esse
scan para identificar views do Pl View que podem ser excluidas ou migradas para o destino do Microsoft
SQL Server como alternativa. Para obter instrugdes sobre como migrar views usando o destino Pl View

para o Microsoft SQL Server, consulte Migrar o destino do Pl View para o destino do Microsoft SQL

Server.

e Se ocorrer um erro durante o scan, uma mensagem de erro aparecera. Clique em OK para fechar a

caixa de didlogo de erro.

¢ Se o scan for bem-sucedido, mas a lista ndo for exportada, anote manualmente os nomes das views.

Clique na caixa de sele¢do de reconhecimento para continuar a instalacdo. Clique em Préximo.
A janela Pronto para Instalar o Aplicativo é aberta.

20. Clique em Instalar.
A janela Sistema de Atualiza¢do é aberta e mostra o progresso da instalacdo.

21. Quando ainstalac¢do é finalizada, a janela Instalagdo Completa aparece. Clique em Fechar (Close).

Fase 3: verificar a instalacao

Depois de concluir a instalacdo do Pl Integrator for Business Analytics, verifique se os servicos estdo em
execugao.

1. Fazer logon no computador que hospeda o Pl Integrator for Business Analytics.
2. Abra os Servigos.
Verifique se os servigos do Pl Integrator for Business Analytics estdo listados e em execugao.
Vocé deve ver os seguintes servigos:
¢ Pl Integrator Framework
¢ Pl Integrator Sync
e Maquina de trabalho 1 do PI Integrator

¢ Pl Integrator Worker Node n (Vocé vera um servigo para cada maquina de trabalho criada.)

Nota: os servicos do Pl Integrator Sync e Pl Integrator Worker Node sao instalados com o tipo de inicializacao
definido como Manual. O servigo do Pl Integrator Framework reinicia automaticamente os servigos conforme

necessario. Se for necessaria uma reinicializacdo manual do servico, desligue todos os servigos do Pl

Integrator e inicialize o Pl Integrator Framework Service. Nao inicie os outros servicos manualmente, isso

resultard em um comportamento inesperado.

4. Abra um navegador da Web.
Insira o URL do PI Integrator for Business Analytics.

O URL aponta para a maquina host e a porta do Pl Integrator for Business Analytics. O URL é

https://<hostname>:<port number> ou https.//<fqdn>:<port number>, em que FQDN é o nome do dominio

totalmente qualificado.

Se vocé tiver instalado o Pl Integrator for Business Analytics em um host denominado /ab5 no dominio

prod.onet.com e o tiver configurado para usar a porta 7777, vocé poderd inserir qualquer uma das op¢des a

seguir:
e https://lab5.prod.onet.com:7777

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved.

Page 25



'AV EVA\TM Pl Integrator for Business Analytics

Como instalar o Pl Integrator for Business Analytics

e https://1ab5:7777

Instalacao silenciosa

Esta secdo descreve como instalar o Pl Integrator for Business Analytics em segundo plano.

Antes de instalar o Pl Integrator for Business Analytics, certifique-se de que vocé atenda a todos os pré-requisitos
de Fase 1: prepare-se para instalar o Pl Integrator for Business Analytics.

Nota: instale qualquer produto do Pl Integrator criado no Pl Integrator Framework em sua prépria maquina. Por
exemplo, o Pl Integrator for Business Analytics e o Pl Integrator for SAP HANA ndo podem ser instalados na
mesma maquina e também ndo podem duas instancias do Pl Integrator for Business Analytics.

Para instalar o Pl Integrator for Business Analytics em segundo plano:

Faca logon no computador em que vocé instalard o Pl Integrator for Business Analytics.

2. Faga o download da ultima versao do kit de instalagdo do Pl Integrator for Business Analytics em Portal do
Cliente.

3. Clique com o botdo direito do mouse na configuracdo executavel e clique em Executar como Administrador
para executar o assistente de instalagdo.

A janela Executavel de extragdao automatica é aberta.
4. Especifique o caminho da extragdo para o instalador e clique em OK.

Os arquivos sdo extraidos para o local especificado. A janela Boas-vindas a configuracdo do Pl Integrator for
Business Analytics 2020 sera exibida quando isso for concluido.

Clique em Cancelar.
Localize o arquivo de configuragao silent.ini na pasta.

Edite o arquivo de configuracao. Especifique os seguintes parametros na linha de componentes do PI
Integrator da secdo [LINHA DE COMANDO], modificando o valor padrdo "7 = /q ALLUSERS=1
REBOOT=Suppress REINSTALLMODE=dmus SENDTELEMETRY=0".

Parametro Descri¢ao

SERVICEACCOUNT Esse valor é, por padrdo, definido como NT
SERVICE\<PI Integrator Service Name>, que instalara
o Pl Integrator usando contas virtuais. Vocé também
pode especificar uma conta de servico do Windows
que executa o servico do Pl Integrator Framework.

SERVICEPASSWORD Senha da conta de servico.

Nota: se vocé estiver usando uma Conta de Servigo
Gerenciada por grupo (gMSA) ou Contas Virtuais,
ignore esse parametro.

AFSERVER O PI AF Server que armazena informacdes de
configuracao do Pl Integrator.

SQLSERVER Servidor SQL que o Pl Integrator usa para armazenar
metadados de views. Se vocé estiver usando uma
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instancia nomeada, também devera especificar a
instancia.

USERPORT

Porta que o Pl Integrator usa para conectar-se ao
navegador da web.

SQLHOSTNAME

Nome da maquina que hospeda o SQL Server. Se
houver uma instancia nomeada, especifique
também a instancia nomeada.

SENDTELEMETRY

(Opcional) Se definido como o padrao, 1, vocé
concorda em participar do Programa de feedback do
cliente do PI System. Defina como O para optar por
nao participar do programa.

INSTANCEELEMENTNAME

(Opcional) O elemento do PI AF que contém as
informagdes especificas da instancia do Pl
Integrator. Use a préxima instancia disponivel. Caso
nao seja especificado, o padrao é Instancel. Procure
pela préxima instancia disponivel no banco de dados
de configuracdo no Pl AF Server.

CERTIFICATE_SELECTED

(Opcional) Se estiver usando um certificado
personalizado, defina como 1. Se nao for
especificado, o certificado autoassinado criado pelo
instalador sera usado.

CERTIFICATE_THUMBPRINT

(Opcional) Impressao digital do certificado
personalizado que o Pl Integrator usara. Se uma
impressao digital for usada, CERTIFICATE_SELECTED
deverad ser definido como 1.

SQLUSERACCOUNT

(Opcional) Se vocé estiver usando autenticagdo SQL,
defina a conta SQL que o Pl Integrator usa para
acessar a instancia do SQL Server.

Nota: se vocé estiver usando uma conta de gMSA ou
contas virtuais, ndo podera usar a autenticagao SQL.
Omita este parametro.

SQLUSERPASSWORD

(Opcional) Senha da conta SQL.

Nota: se vocé estiver usando uma conta de gMSA ou
contas virtuais, ndo podera usar a autenticagdo SQL.
Omita este parametro.

8. Abra um command prompt como administrador e execute o seguinte comando: Setup.exe -f silent.ini
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Tarefas pos-instalacao

Depois de instalar o Pl Integrator for Business Analytics, navegue até o URL de servico do PI Integrator
Framework. Para obter mais informacGes, consulte Iniciar o Pl Integrator for Business Analytics.

Em seguida, execute as seguintes tarefas antes de comecar a usar o Pl Integrator for Business Analytics:

¢ Adicione os Pl AF Servers e os bancos de dados dos quais vocé acessara seus dados do Pl System. Consulte
Adicionar servidores e bancos de dados PI AF.

¢ Adicione usuarios que poderao criar views. Consulte Adicionar e configurar identidades.

¢ Conclua quaisquer etapas de configuracdo necessarias para o seu destino de publicagdo. Consulte Configurar
destinos de publicagao.

¢ As permissdes para os dados de origem usados pelo Pl Integrator Views ndo sdo concedidas pelo Pl
Integrator. A identidade do usudrio que cria a view ja deve ter acesso de leitura e leitura de dados aos dados
de origem no AF. Verifique se a conta de servico do Windows Pl Integrator for Business Analytics tem as
seguintes permissoes:

¢ Acesso de leitura e leitura de dados no nivel do servidor AF para todos os servidores do Pl AF que o PI
Integrator for Business Analytics precisa acessar para publicar dados

e Acesso de leitura e leitura de dados em qualquer banco de dados do Pl AF e qualquer um de seus
objetos filhos (elementos, categorias, modelos, etc.) que o Pl Integrator for Business Analytics precisa
acessar para publicar dados

¢ Acesso de leitura no Pl Data Archive para a tabela de tags do Pl em Seguranga do banco de dados

e Acesso de leitura no Pl Data Archive para seguranca de pontos e dados em todas as tags do Pl que o PI
Integrator for Business Analytics precisa acessar para publicar dados

Nota: a conta de servico requer permissdes do Pl Data Archive porque o servico do Pl Integrator
Framework consulta o Pl Data Archive diretamente sobre dados de atributos do Pl AF que sao
referéncias de dados da tag do PI.

Adicionar servidores e bancos de dados Pl AF

E possivel especificar servidores do Pl AF adicionais que contenham dados que possam ser usados nas suas
views.

Clique no icone de menu E e cligue em Administragao.
2. Na pagina Administracdo, clique na guia Bancos de Dados do AF.

Na secdo Adicionar um novo Servidor AF da pagina, insira o nome e o local (enderego IP) do PI AF Server no
campo Servidor AF.

4. Se o seu Pl AF Server ndo estiver usando a porta padrdo (5457), especifique a porta a ser usada no campo
Porta.

5. Cligue em Adicionar AF Server.
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Adicionar e configurar identidades

Veja abaixo para consultar passos para criacdo de uma nova identidade, adicionar usuarios a identidade e
configurar o acesso da identidade aos destinos e as views de publicacdo. Essas identidades gerenciam o acesso
do usudrio a interface do usuario (Ul) do Pl Integrator for Business Analytics, bem como permissdes para acessar
e configurar views e destinos de publicacao.

Clique no icone de menu E e clique em Administragao.

=

2. Na pagina Administragao, clique na guia Usuarios.
A pagina Permissdes de Acesso do Usuario serd aberta.
3. Clique em Adicionar Identidade.
A caixa de didlogo Adicionar Identidade abrira.
4. Execute uma destas etapas:
¢ Insira o nome de uma nova identidade no campo nome de identidade e clique em Criar.
¢ Selecione uma identidade da lista e clique em OK.

A lista mostra todas as identidades que estdo associadas com o Pl AF server que hospeda a configuracdo
para o Pl Integrator for Business Analytics.

A identidade preencherda o campo Nome.

Identities Users and Groups
Identity Description

. Pi Integrator Service Created by P Integrator Setup Kit

Created By Advanced Edition

Created By Ady

ced Edition

Edition

& Administrators

curity access

F) Add ldentity () Remave

Description Created By ABvanced Edition

View Permissions

ermissions

5. Clique em Adicionar Usuario a Identidade para adicionar usuarios do Windows Active Directory a
identidade.

6. Na caixa de dialogo Adicionar Usuarios e Grupos, insira o dominio e o nome do usuario no campo dominio\
usudrio.

Use o formato dominio\usuario. Se preferir, vocé pode inserir o nome completo do usudario no campo
nome completo.

7. Clique em Search.

Uma lista de usuarios do Active Directory que correspondem aos critérios inseridos sera exibida.
8. Selecione um usuario na lista e clique em OK.

O usuario aparece na lista Usuarios e Grupos.
9. Clique em Adicionar Destino para conceder a identidade acesso aos destinos de publicacdo.

Se os destinos desejados ndao aparecerem nessa lista, crie primeiro o destino e, em seguida, conceda a
identidade acesso a ele.
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Na caixa de didlogo Adicionar Destinos de Publica¢do, selecione os destinos aos quais vocé quer conceder
acesso a identidade e clique em OK.

Os destinos aparecem na lista Destinos de Publicagao Permitidos.
Clique em Adicionar Permissoes de View para conceder a identidade acesso a todas as views existentes.

Na caixa de didlogo Adicionar Permissdes de View, selecione as views as quais vocé quer conceder acesso e
clique em OK.

As views aparecem na lista PermissGes de View.
Clique na seta e selecione uma das seguintes permissées (consulte Permissdes de View para obter detalhes):
e Leitor
¢ Proprietério
Clique na caixa de selecdo Administrador para conceder a identidade do AF selecionada acesso a pagina de
Administracdo do Pl Integrator for Business Analytics.
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Upgrade do PI Integrator for Business
Analytics

Vocé pode fazer upgrade para o Pl Integrator for Business Analytics 2020 R2 SP2 das seguintes versdes:

e 2020 R2SP1

Upgrades provisdrios

Para versdes anteriores a 2020 R2 SP1, primeiro, é necessario realizar o upgrade para o Pl Integrator for Business
Analytics 2020 R2 SP1.

¢ N3do ha um caminho de upgrade direto do Pl Integrator for Business Analytics 2020 R2 Patch 2 e anterior ao
Pl Integrator for Business Analytics 2020 R2 SP2.

Para versdes anteriores a 2020, primeiro é necessdrio realizar o upgrade para o Pl Integrator for Business
Analytics 2020.

¢ N3&o ha um caminho de atualizacdo direto do PI Integrator for Business Analytics 2018 R2 SP2 e anterior para
o Pl Integrator for Business Analytics 2020 R2 SP1 ou posterior.

¢ Faca download do PI Integrator for Business Analytics 2020 SQL Utility, que contém o script que realiza o
upgrade dos bancos de dados.

Para versdes anteriores a 2018 R2, primeiro é necessario realizar o upgrade para o Pl Integrator for Business
Analytics 2018 R2.

e Se vocé estiver realizando o upgrade para o Pl Integrator for Business Analytics 2018 R2 como uma versao
intermedidria e o Pl Integrator for Business Analytics estiver em execugao no Pl AF Server 2014 ou anterior,
serad necessario realizar o upgrade para o Pl AF 2015 ou posterior antes de continuar. Caso contrario, os
usudrios existentes do PI Integrator for Business Analytics ndo serdo convertidos automaticamente para
identidades do PI AF. Para obter mais informagdes, consulte Permissdes de acesso do usudrio.

¢ Se vocé tiver varias instancias 1.x do Pl Integrator anteriores a 2018 instaladas no mesmo Pl AF Server, todas
elas deverdo receber upgrade para 2020 ou posterior (2.x). Se vocé atualizar algumas, mas nao todas as
instancias para 2.x, suas views 1.x poderdo falhar ao serem publicadas apds a atualizagao.

¢ Se a conta de usudrio usada para realizar o upgrade ao Pl Integrator for Business Analytics 2018 R2 possuir
uma associagao de fun¢do de banco de dados db_accessadmin nos bancos de dados PlintegratorDB,
PlintegratorLogs e PlintegratorStats, a conta de usudrio também devera ter privilégios SELECT, UPDATE e
ALTER no banco de dados PlintegratorStats. Se a conta de usuario ndo receber permissdes para o upgrade,
vocé devera atualizar manualmente os bancos de dados antes de realizar o upgrade.

Preparacao para o upgrade

Antes de realizar o upgrade:
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¢ Verifique se a conta de servico do Windows especificada executa o Pl Integrator for Business Analytics no
formato Dominio\Usuario. Se a conta de servigo usar o formato UPN (Nome Principal do Usudrio)
(account@domain.com), o upgrade falhara. Vocé precisara reverter manualmente a conta de servigo em
services.msc para o formato Dominio\Usudrio e depois prosseguir com o upgrade.

¢ Certifique-se de que vocé tem privilégios de administrador local no computador em que estd instalando o PI
Integrator for Business Analytics.

¢ Certifique-se de que a conta de usuario usada para realizar o upgrade do software tenha privilégios de
sysadmin no servidor do SQL onde vocé esta realizando o upgrade dos bancos de dados do Pl Integrator. Isso
€ necessario para realizar o upgrade dos bancos de dados SQL de back-end do PI Integrator.

¢ Se a conta de usuario ndo receber os privilégios necessarios, um usuario que tenha privilégios de
sysadmin, normalmente um administrador de banco de dados, devera realizar manualmente o upgrade
dos bancos de dados SQL. Realize o upgrade dos bancos de dados SQL primeiro, antes do Pl Integrator
for Business Analytics.

¢ Depois de instalar os bancos de dados SQL, adicione a conta de usuario que fard o upgrade do PI
Integrator for Business Analytics como login no SQL Server. O usuario que fard o upgrade do PI Integrator
for Business Analytics deve ter as seguintes permissoes:

1. Associacdo de fun¢do no banco de dados db_accessadmin nos bancos de dados PlintegratorDB,
PlintegratorStats e PlintegratorLogs

2. PermissGes SELECT no banco de dados PlintegratorStats

Nota: durante o upgrade, ndo sera possivel especificar um novo Pl AF Server ou SQL Server.

¢ Se a configuracdo de seguranca de personificacao do aplicativo estiver ativada durante a instalacao e seu PI
Integrator for Business Analytics estiver instalado em um ambiente confidvel de dominio unidirecional,
execute a ferramenta de migracdo de identidade no mesmo dominio que seus usuarios do Pl Integrator for
Business Analytics, antes do upgrade. Consulte Como executar a ferramenta de migracao de identidade para
obter mais informacdes.

Procedimento de upgrade

O Pl Integrator for Business Analytics instala arquivos executaveis. Se alguma view estiver em execug¢do quando o
upgrade comecar ou estiver agendada para ser executada enquanto o upgrade estiver ocorrendo, o Pl Integrator
for Business Analytics interrompera ou adiara as tarefas antes de iniciar o upgrade dos arquivos executdveis.
Assim que o upgrade for concluido, ele reinicia as tarefas ou retoma a execucdo das tarefas.

Se preferir, vocé pode interromper manualmente qualquer tarefa em execuc¢do. No entanto, sera necessario
reiniciar as tarefas assim que o upgrade for concluido.

1. Facga o download do kit de instalagao do Pl Integrator for Business Analytics do Pagina de produtos do Portal
do cliente da AVEVA.

2. Clique com o botdo direito do mouse na configuracdo executavel e clique em Executar como Administrador
para ativar o assistente de instalagao.

A janela executdvel de extracao automatica é aberta.
3. Especifique o caminho da extragao para o instalador e clique em OK.

A janela Boas-vindas a Configuracdo do Pl Integrator for Business Analytics é aberta e apresenta a listagem
dos médulos separados incluidos na instalagao. O assistente de instalagdo realiza o upgrade de cada mdédulo
ou certifica se a versao correta do mddulo ja esta instalada em seu sistema.
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4. Clique em OK.

A janela bem-vindo a instalacdo do PI Integrator for Business Analytics Installation é aberta.
5. Clique em Préximo.

A janela Informacgdes de Logon é aberta.

6. Especifique a Senha para a conta de servico do Windows que executa os servicos do Windows do Pl
Integrator for Business Analytics.

7. Clique em Préximo.
A janela Configuragao de Certificado de Porta e TLS é aberta.

8. Insira um numero de porta vélido disponivel no campo Insira um nimero de porta e clique em Validar
porta.

A interface do usudrio do PI Integrator for Business Analytics usa essa porta para se conectar ao componente
de servico do Pl Integrator Framework.

Dica: se vocé usar a porta 443, serd possivel omitir esse nUmero da porta ao especificar a URL para o PI
Integrator for Business Analytics.

9. Escolha um certificado TLS usando uma das seguintes fontes:

¢ (Recomendado) Certificado TLS de uma autoridade de certificacdo. Escolha Importar Certificado e clique
em Selecionar certificado para escolher um certificado que foi emitido por uma autoridade de
certificacdo e importado na maquina em que o Pl Integrator for Business Analytics estd sendo instalado.

¢ Certificado autoassinado que é gerado durante a instalacdo. Este é o padrao.

Nota: caso vocé escolha essa opgao, os usuarios que fazem logon em maquinas remotas podem ver uma
mensagem de aviso de segurancga. Para evitar esse aviso para certificados autoassinados, o certificado deve
ser explicitamente de confianga na maquina do cliente. Consulte a solucdo alternativa no artigo Certificate
error returned when navigating to a Pl Vision or Pl Web APl web site using a self-signed certificate da base de
conhecimento.

10. Na janela Pl Integrator Worker Nodes, clique na seta e selecione o nimero de Worker Nodes que vocé deseja
gue sejam instalados e clique em Préximo.

A janela Pronto para Instalar o Aplicativo é aberta.

Nota: cada worker node requer CPU e RAM adicionais.

Nota: se ocorrer um erro, certifique-se de que a porta ndo esta sendo usada ou aberta.

11. Clique em Préximo.

Se vocé tiver uma view, a janela Fazer Backup de Views Existentes é aberta. Caso contrario, va para a etapa
13.

12. Cliqgue em Realizar backup.

Esta etapa faz um backup da configuracdo da view existente do banco de dados de configuragado do AF. Se o
backup for concluido, essa caixa de didlogo lista o status do backup e um link para o arquivo do backup no
diretorio %PIHOME%\dat.

Se ocorrer um erro, uma mensagem de erro aparecerd. Clique em OK para fechar a caixa de didlogo de erro.
Neste ponto, vocé pode:

e Solucionar o erro e clicar em Realizar backup.

¢ Fazer um backup manualmente no Pl System Explorer. Para isso:

¢ Na mdaquina em que o Pl Integrator for Business Analytics esta instalado, localize o arquivo
%PIHOMEG64\Integrators\BA\CAST.Ul.WindowsService.exe.config.
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¢ Abra o arquivo de configuragao e anote o valor da chave InstancePath.

¢ No Pl System Explorer, navegue até o elemento indicado pelo elemento InstancePath.

¢ Expanda o elemento usando a seta a esquerda para expor o elemento Views.

¢ Cliqgue com o botdo direito do mouse em Elemento de view e selecione Exportar para Arquivo.

¢ Selecione as op¢Ges Objetos Referenciados Incluidos e Incluir strings de seguranga. Anote a
localizagdo do arquivo de backup.

¢ Clique em OK.
¢ Continuar sem realizar um backup (ndo recomendado).

13. A etapa Verificagdo Obsoleta do PI View exige que vocé reconheca que o destino Pl View esta obsoleto.
Todas as views existentes que usam o destino Pl View serdo desativadas da publicagdo apés a instalagao.

¢ (Recomendado) H4 um scan disponivel para detectar quaisquer views em seu sistema que usem o
destino Pl View. Se o scan for concluido, havera uma lista dos nomes de views para views detectadas,
bem como um link para o arquivo de lista exportado no diretério %PIHOME%\dat. Vocé pode usar esse
scan para identificar views do Pl View que podem ser excluidas ou migradas para o destino do Microsoft
SQL Server como alternativa. Para obter instrucGes sobre como migrar views usando o destino Pl View
para o Microsoft SQL Server, consulte Migrar o destino do Pl View para o destino do Microsoft SQL
Server.

e Se ocorrer um erro durante o scan, uma mensagem de erro aparecerad. Cliqgue em OK para fechar a
caixa de didlogo de erro.

¢ Se o scan for bem-sucedido, mas a lista ndo for exportada, anote manualmente os nomes das views.
Cligue na caixa de selecdo de reconhecimento para continuar a instalacdo. Cligue em Préximo.
A janela Pronto para Instalar o Aplicativo é aberta.
14. Clique em Instalar (Install).
A janela Sistema de Atualizacdo é aberta e mostra o progresso da instalagao.

15. Quando a instalagdo for concluida, a janela Instalagdo Completa sera exibida. Clique em Fechar (Close).
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Configurar destinos de publicacao

Este procedimento é uma visdao geral de todas as etapas que vocé deve concluir para configurar o destino de
publicacdo, incluindo todas as etapas que vocé deve concluir antes de criar e configurar o destino de publicacdo.

Nota: a partir do Pl Integrator for Business Analytics 2020 R2 SP2, o destino Pl View foi descontinuado. Para
migrar qualquer view usando o destino Pl View para um destino do Microsoft SQL Server como alternativa,
consulte Migrar o destino do Pl View para o destino do Microsoft SQL Server.

1. Se vocé estiver publicando seus dados do Pl System em um dos destinos a seguir, siga as instrucées no tépico

mencionado para configurar o destino. Para todos os outros destinos, passe para a proxima etapa.

Banco de dados Oracle — Consulte Configurar o destino de publicacdo do Banco de dados Oracle

Destino do banco de dados Azure SQL ou pool de SQL dedicado do Azure — Consulte Configurar o destino

do banco de dados Azure SQL ou do Pool de SQL Dedicado do Azure.

Amazon Redshift — Instale o driver ODBC do Amazon Redshift no computador em que o Pl Integrator for
Business Analytics estd instalado — Consulte Instale e configure o drivers ODBC do Amazon Redshift.

SAP HANA ODBC —instale o cliente do SAP HANA na mdaquina onde o Pl Integrator for Business Analytics

esta instalado. Consulte Configurar o destino de publicacdo do SAP® HANA® ODBC.

2. Adicione o destino de publicagdo ao Pl Integrator for Business Analytics. Consulte Adicionar um destino de
publicacdo.

3. Configure o destino de publicacdo. Consulte o tépico para o seu destino.

4. Conceda aos usudrios acesso ao destino de publicagdo. Consulte Conceder acesso a destinos.

Configure o destino do Amazon Kinesis Data Streams
Configure o destino do Amazon Redshift

Configurar o destino Amazon S3

Configurar o destino do Apache Hive

Configurar o destino do Apache Kafka

Configurar o destino do Azure Data Lake Storage Gen 2
Configurar o destino dos Hubs de Evento do Azure
Configurar o destino do Hub IoT do Azure

Configurar o destino do banco de dados do Azure SQL
Configuracao de destino do Pool de SQL dedicado do Azur
Configurar o destino do Google BigQuery

Configurar o destino do Google Cloud Storage

Configurar o destino do Google Cloud Pub/Sub

Configure o destino do Hadoop Distributed File System (HDFS)
Configurar o destino do Microsoft SQL Server

Configure o destino do Oracle

Configurar o destino de publicacdo do SAP® HANA® ODBC

Configurar destino do arquivo de texto
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Adicionar um destino de publicacao

Este tépico descreve como adicionar destinos de publicagdo.

Nota: as saidas do destino disponiveis sdo determinadas pela edi¢gdo do software.

1. Clique no icone de menu E e clique em Administragao.
2. Clique na guia Destinos.

A pagina Configuracdo do Destino de Publicacdo se abre.
3. Clique em Adicionar Destino de Publicagao.

A caixa de didlogo Criar Novo Destino de Publicagao se abre.

4. Insira o nome do destino de publicagdo no campo Destino de Publicagdo. Clique em Tipo do Destino e
selecione o tipo de saida na lista.

5. Clique em Criar Novo Destino.

Configure o destino do Amazon Kinesis Data Streams

Conclua o procedimento abaixo para configurar o destino do Amazon Kinesis Data Streams e verifique se é
possivel gravar o fluxo de dados do Amazon Kinesis Data Streams.

¢ Certifique-se de que a Chave de acesso da AWS inserida na configuracao de destino do PI Integrator for
Business Analytics seja para um usudrio da AWS que tenha as seguintes permissdes no destino do Amazon
Kinesis Data Streams: ag¢des ListStreams, DescribeStream, PutRecord/PutRecords.

e Crie o destino do Amazon Kinesis Data Streams antes de configura-lo. Para obter mais informacdes, consulte
Adicionar um destino de publicacao.

1. Na pagina Administrac¢do, clique na guia Destinos. Em seguida, selecione o destino na lista Destinos de
Publicacao.

Nota: caso vocé ja tenha selecionado seu destino, va para a proxima etapa.

2. Va até a tabela a seguir e insira as informagdes necessarias. Clique nos botdes conforme sdo habilitados.

Parametro Description

ID de Chave de Acesso a AWS Usada em combinag¢ao com a Chave de Acesso
Secreto para autenticar solicitagdes no stream.

Chave de Acesso a AWS Usada em combinacdo com a ID de Chave de Acesso
ao AWS para autenticar solicitacdes no stream.

Kinesis Data Stream Nome do fluxo de dados do Kinesis no qual os dados
sao gravados.
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Parametro

Description

Regiao

Se a regido desejada ndo estiver incluida na lista
suspensa, tente digita-la manualmente no campo de
entrada.

Verifique se o formato é um cédigo de regido da
Amazon valido e ndo o nome da regido. O formato
deve corresponder ao formato das regides
suportadas abaixo:

Padrdo: us-east-1
Com suporte:
af-south-1
ap-east-1
ap-northeast-1
ap-northeast-2
ap-northeast-3
ap-south-1
ap-south-2
ap-southeast-1
ap-southeast-2
ap-southeast-3
ap-southeast-4
ca-central-1
ca-west-1
cn-north-1
cn-northwest-1
eu-central-1
eu-central-2
eu-north-1
eu-south-1
eu-south-2
eu-west-1
eu-west-2
eu-west-3
il-central-1
me-central-1
me-south-1
sa-east-1

us-east-1
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Parametro

Description

us-east-2
us-west-1

us-west-2

Regides sem suporte

Areas geograficas com as quais este cliente ndo
pode se comunicar:

AWS GovCloud (Leste dos EUA)
AWS GovCloud (Oeste dos EUA)
ISO dos EUA Leste de Ohio

ISO dos EUA Leste da Virginia
ISO dos EUA Oeste de Colorado

As zonas locais da AWS ndo tém suporte

Formato de Armazenamentos de Dados

(Opcional) Formato de arquivo no qual os dados sdo
armazenados. O padrdo é Parquet. Outras opc¢Ges
sao: JSON e JSON Indent.

Compressao

(Opcional) Tipo de compressdao em conjuntos de
mensagens. O padrdo é Nenhum. Outras op¢des sdo

gzip e Snappy.

Permitir Valores Nulos

(Opcional) Quando selecionados, os valores nulos
sdo validos.
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3. Clique em Verificar Gravador.
4. Cligue em Salvar Alteragoes.

5. Dé aos usuadrios acesso ao destino do Amazon Kinesis Data Streams. Para obter mais informacses, consulte
Conceder acesso a destinos.

Nota: qualquer regido nao listada de forma especifica na lista de regides com suporte acima é considerada
uma regido sem suporte (ndo ha garantia de que a regido tenha suporte). A AVEVA oferece suporte a essas
regidoes no momento desta versao e nao pode garantir suporte para regides adicionadas recentemente.

Instale e configure o drivers ODBC do Amazon Redshift

Vocé deve instalar e configurar o driver ODBC do Amazon Redshift na maquina onde o PI Integrator for Business
Analytics estd instalado antes de configurar o destino do Amazon Redshift.

1. Na pagina Instalar e configurar o driver ODBC do Amazon Redshift nos sistemas operacionais Microsoft
Windows, faga o download do arquivo do instalador, dependendo da arquitetura do sistema da ferramenta
cliente ou aplicativo SQL:

¢ 64-bit — Amazon Redshift (x64)
2. Execute o arquivo para instalar o driver ODBC do Amazon Redshift.

3. Siga as instrucdes para configurar o driver.

Configure o destino do Amazon Redshift

Conclua o procedimento abaixo para configurar o destino do Amazon Redshift e verifique se é possivel gravar o
banco de dados do Amazon Redshift.

¢ Certifique-se de que o usudrio do banco de dados inserido na configuragao do destino de publicagdo do PI
Integrator for Business Analytics tenha as seguintes permissdes minimas no banco de dados do Amazon
Redshift: SELECT, CREATE, DROP, UPDATE, INSERT e DELETE.

¢ Instale e configure o driver ODBC do Amazon Redshift. Consulte Instale e configure o drivers ODBC do
Amazon Redshift para obter mais informacoes.

¢ Crie o destino do Amazon Redshift antes de configura-lo. Consulte Adicionar um destino de publicacdo para
obter mais informacdes.

1. Na pagina Administracdo, clique na guia Destinos. Em seguida, selecione o destino na lista Destinos de
Publicagao.

Nota: Caso vocé ja tenha selecionado seu destino, pule para a préxima etapa.

2. Va até a tabela a seguir e insira as informagdes necessarias. Clique nos botdes conforme sdo habilitados.

Parametro Descrigao

Driver ODBC (Opcional) O driver ODBC que se conecta ao cluster
Amazon. O padrdo é o Amazon Redshift (x64).

Nome do Cluster Maquina do cluster Amazon para onde os dados sdo
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Parametro Descri¢ao
enviados.
Porta do Banco de Dados do Cluster (Opcional) Porta através da qual faz-se conexao com

0 banco de dados do cluster. O padrdo é 5439.

Nome do Banco de Dados do Cluster Banco de dados do cluster onde os dados sdo
gravados.
Nome de Usuario do Banco de Dados Nome de usudrio do banco de dados usado para se

conectar ao cluster.

Password Senha do nome de usuario do banco de dados
usado para se conectar ao cluster.

Clique em Verificar Gravador.
4. Clique em Salvar Alteragoes.

Dé aos usuarios acesso ao destino Amazon Redshift. Consulte Conceder acesso a destinos para obter mais
informacdes.

Configurar o destino Amazon S3

Conclua o procedimento abaixo para configurar o destino do Amazon S3 e verifique se é possivel gravar o banco
de dados do Amazon S3.

¢ Certifique-se de que a Chave de acesso da AWS inserida na configuracdo de destino do PI Integrator for
Business Analytics seja para um usudrio da AWS que tenha as seguintes permissdes no destino do Amazon
S3: s3:ListBucket, s3:PutObject, s3:GetObject, s3:DeleteObject e s3:GetBucketLocation.

¢ Se vocé estiver usando o banco de dados do Amazon Athena, certifique-se de que a Chave de acesso da
AWS inserida na configuragao de destino do PI Integrator for Business Analytics seja para um usuario da
AWS que tenha as seguintes permissdes no banco de dados: Athena — leitura e gravagao. O usudrio deve
receber todas as permissdes relacionadas a leitura e gravagao.

Servidor Acoes Recursos Condicoes de
solicitacao
Athena *(todas as agdes) Qualquer recurso de Nenhum

tipo = grupo de trabalho

Cola *(todas as agdes) Todos os recursos Nenhum

¢ Athena — leitura e gravacdo. O usudrio deve receber todas as permissodes relacionadas a leitura e
gravacdo. Leitura e gravagdo. O usuario deve receber todas as permissées relacionadas a leitura e
gravagao.

¢ Glue — leitura e gravagao. O usudrio deve receber todas as permissdes relacionadas a leitura e gravagao.

Nota: para gravar em um banco de dados do Amazon Athena, o banco de dados deve estar na mesma regido
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do bucket do Amazon S3. Gravar em um banco de dados Amazon Athena s é suportado quando usar o tipo

de armazenamento de dados Parquet.

e Crie o destino do Amazon S3 antes de configura-lo. Para obter mais informacdes, consulte Adicionar um

destino de publicacao.

Conclua o procedimento abaixo para configurar o destino do Amazon S3 e verifique se é possivel gravar o bucket

do Amazon S3.

1. Na pagina Administracdo, clique na guia Destinos. Em seguida, selecione o destino na lista Destinos de

Publicagao.

Nota: caso vocé ja tenha selecionado seu destino, va para a proxima etapa.

2. Va até a tabela a seguir e insira as informagdes necessarias. Clique nos botdes conforme sdo habilitados.

Parametro

Description

Formato de Armazenamentos de Dados

Formato de arquivo no qual os dados sdo
armazenados. O padrdo é Parquet. Outras opcGes
sdo: JSON, JSON Indent e texto.

Compressao

Tipo de compressdao em conjuntos de mensagens. O
padrdo é Nenhum. Outras op¢des sdo gzip e Snappy.

Nota: escolha a configuracao de compressao para
obter um melhor desempenho.

ID de Chave de Acesso a AWS

Usada em combinag¢ao com a Chave de Acesso
Secreta para autenticar solicitagdes no bucket.

Chave de Acesso a AWS

Usada em combinagdo com a ID de Chave de Acesso
ao Amazon para autenticar solicitacdes no bucket.

Incluir Cabegalho

Quando selecionado, os nomes de coluna sdo
adicionados ao inicio do arquivo.

Delimitador de campo

Caractere(s) que separam os campos de dados na
linha. Por padrdo, uma guia (\t), separa os campos.
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Regiao Abaixo vocé encontra a area geografica com a qual
este cliente se comunica. Se a regido desejada nao
estiver incluida na lista suspensa, tente digita-la
manualmente no campo de entrada.

Verifique se o formato é um cédigo de regido da
Amazon valido e ndo o nome da regido. O formato
deve corresponder ao formato das regides
suportadas abaixo:

Padrdo: us-east-2
Com suporte:
af-south-1
ap-east-1
ap-northeast-1
ap-northeast-2
ap-northeast-3
ap-south-1
ap-south-2
ap-southeast-1
ap-southeast-2
ap-southeast-3
ap-southeast-4
ca-central-1
ca-west-1
cn-north-1
cn-northwest-1
eu-central-1
eu-central-2
eu-north-1
eu-south-1
eu-south-2
eu-west-1
eu-west-2
eu-west-3
il-central-1
me-central-1
me-south-1
sa-east-1
us-east-1

us-east-2
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us-west-1

us-west-2

Regides sem suporte Areas geograficas com as quais este cliente ndo
pode se comunicar:

AWS GovCloud (Leste dos EUA)
AWS GovCloud (Oeste dos EUA)
ISO dos EUA Leste de Ohio

ISO dos EUA Leste da Virginia
ISO dos EUA Oeste de Colorado

As zonas locais da AWS ndo tém suporte.

Linha Delimitadora Caractere(s) que separam as linhas de dados. Por
padrdo, uma nova linha separa as linhas de dados.
Os caracteres que especificam uma nova linha sdo
especificos de plataformas. O padrdo fornece
automaticamente os caracteres corretos ao

ambiente.

Nome do Bucket Bucket do S3 para o qual os dados foram
carregados.

Caminho da Pasta (Opcional) Especificar com prefixos de nomes chave

e barras (/) para organizar as views no S3. O prefixo
de nome chave precisa existir no S3 antes de
configurar o destino. Para obter mais informacdes
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sobre criar uma hierarquia légica em S3, consulte
Object Key and Metadata.

Permite Valores Nulos Quando selecionados, os valores nulos s3do validos.

Maximo de Linhas/Objetos (Opcional) Nimero maximo de objetos em um
arquivo. Padrdo: 100 mil linhas. Veja a Nota abaixo.

Tamanho Maximo do Arquivo (KB) (Opcional) Tamanho mdaximo de arquivo em
kilobytes. Padrdo: 10 mil KB. Veja a Nota abaixo.

Tempo Maximo de Atualizagdo (s) (Opcional) Tempo maximo para atualizar o banco de
dados, em segundos, antes que o gravador atinja o
tempo limite. Padrdo: 86,4 mil segundos (1 dia).
Veja a Nota abaixo.

Banco de Dados da Amazon (Opcional) Nome do banco de dados do Amazon
Athena no qual os dados estdo gravados.

Nota: qualquer regido ndo listada de forma especifica na lista de regides com suporte acima é considerada
uma regido sem suporte (ndo ha garantia de que a regido tenha suporte). A AVEVA oferece suporte a essas
regidoes no momento desta versao e ndao pode garantir suporte para regides adicionadas recentemente.

Nota: especificar um dos trés parametros opcionais: Maximo de Linhas/Objetos, Tamanho Maximo do
Arquivo ou Tempo Maximo de Atualiza¢do. Se nenhum for especificado, as views serdo sempre publicadas
Nno mesmo arquivo e um novo arquivo jamais sera criado.

Os trés parametros tém valores padrao e todos os padrdes sdo impostos. O primeiro parametro alcangado
acionarad a criagdo de um novo arquivo. Para padronizar em um parametro para a criagao de um novo
arquivo, insira valores muito grandes que sejam impossiveis de alcangar pelos parametros restantes.

Clique em Verificar Gravador.
4. Clique em Salvar Alteragoes.

Dé aos usuarios acesso ao destino Amazon S3. Para obter mais informagdes, consulte Conceder acesso a
destinos.

Configurar o destino do Apache Hive

Complete o procedimento abaixo para configurar o destino do Apache Hive e teste sua conexdao com o banco de
dados Hive.

Crie o destino do Apache Hive antes de configura-lo. Consulte Adicionar um destino de publicacdo para obter
mais informacdes.

Nota: Insira as informagdes nos campos em ordem. Apds as informagdes necessdrias terem sido especificadas
nos campos, os botdes sao habilitados. Clique no botdo antes de continuar para o préximo campo.

1. Na pagina Administrac¢do, clique na guia Destinos. Em seguida, selecione o destino na lista Destinos de
Publicagao.

Nota: caso vocé ja tenha selecionado seu destino, pule para a proxima etapa.
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2. Va até a tabela a seguir e insira as informagdes necessarias. Clique nos botdes conforme sdo habilitados.

Parametro

Descrigao

HDFS URL

URL para acessar o HDFS por meio do WebHDFS
diretamente ou por meio do gateway Apache Knox
ou HttpFs.

Exemplos:
HDFS — http://host:50070/webhdfs/v1
HttpFS — http://host:14000/webhdfs/v1

Apache Knox — https://host:8443/gateway/default/
webhdfs/v1

Verificar o certificado TLS/SSL

Marque a caixa de selecdo se vocé estiver usando
um certificado TLS/SSL.

Nome do usuario

Nome do usuario utilizado para se conectar ao
HDFS. O usudrio deve ter permissdes para ler e
gravar no HDFS.

Senha

(Opcional) Senha para autenticar o usuario ou
guando estiver conectando a um HttpFS. Se uma
senha é fornecida, se usa uma autenticacao Hadoop
HTTP. Se nenhuma senha for inserida, o Pl Integrator
for Business Analytics usara a autenticagdo simples
Hadoop.

Diretorio

Diretério no qual os arquivos de texto sdo criados.
Cliqgue em Navegar para navegar pelo diretério em
gue vocé deseja que os arquivos sejam alocados. O
formato para especificagao da localizagdo do
diretdrio é: [frootfolder/folderl/folder2.

Nome do host Hive

Nome do host da maquina na qual Thrift estd
rodando. Esse nome pode ser um alias, um
endereco interno ou um endereco IP. O padrdo é o
nome do host na URL do HDFS.

Porta Hive

(Opcional) Porta na qual sera feita a conexao ao
Thrift.

Nome de usuario Hive

(Opcional) Nome do usudrio usado para conectar a
HCatalog.

Formato de tabela Hive

Formato em que se armazena tabelas no Apache
Hive. Os formatos de arquivo suportados atuais sao
texto (TEXTFILE) e optimized row columnar (ORC).

Nota: ORC requer Apache Hive 0.11 ou posterior.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 45



'AV EVA\TM Pl Integrator for Business Analytics

Configurar destinos de publica¢do

Banco de dados Hive Nome do banco de dados no Apache Hive no qual as
tabelas sdo criadas.

3. Cligue em Conectar-se ao Apache Hive.

O Pl Integrator for Business Analytics se conecta ao Apache Hive, consulta o banco de dados e preenche os
campos Hive Table Format e Hive Database com os formatos e bancos de dados de tabela suportados.

4. Clique em Verificar o Apache Hive Writer para verificar se o Apache Hive writer pode escrever para o banco
de dados Hive.

Nota: caso vocé ndo consiga escrever com sucesso no banco de dados Hive, consulte Dicas para configurar
Apache Hive.

5. Clique em Salvar Alteragdes.

Dicas para configurar Apache Hive

Para que o Apache Hive funcione com o PI Integrator for Business Analytics, é necessario concluir as seguintes
tarefas:

e Crie o usudrio HDFS.

e Crie o usuario HCat.

¢ Crie o diretdrio de usudrio e conceda as permissoes.
e Desabilite a SASL.

O procedimento a seguir descreve como concluir essas tarefas.

1. Crie o usuario HDFS.
a. Crie o usudrio HDFS na maquina em que o WebHDFS estd instalado.

b. Adicione o usudrio HDFS a um grupo.

Nota: O usudrio HDFS pode ser adicionado a qualquer grupo. Porém, para os propdsitos deste exemplo, esse
grupo sera chamado de grupo HDFS.

2. Crie o usudrio HCat.
(Opcional) Se o HCat estiver em uma maquina diferente, vocé devera adicionar o usuario HCat.
a. Crie o usudrio HCat na maquina em que o HCat foi instalado.
b. Adicione o usudrio HCat ao grupo HDFS.

3. Crie o diretério de usudrio e conceda as permissdes.

No procedimento a seguir, vocé criara um diretdrio de usuario e se certificard de configura-lo corretamente
para que o usuario HDFS possa gravar nele.

a. Crie um diretério de usuario no HDFS.
b. Altere o proprietdrio desse diretdrio para o usuario HDFS.
c. Altere o grupo ao qual esse diretério pertence para HDFS.
d. Conceda permissdes de leitura e escrita ao proprietario do diretério (ou seja, ao usuario HDFS).
e. Conceda permissées de leitura e gravagdo para o grupo ao qual o diretério pertence.
4. Desabilite a SASL.
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Nota: o Pl Integrator for Business Analytics suporta apenas destinos Apache Hive configurados com
autenticacdo NOSASL. Para obter mais informag&es sobre as op¢bes de autenticagao do Apache Hive,

consulte Configuracdo do HiveServer2.

Configurar o destino do Apache Kafka

Conclua o procedimento abaixo para configurar o destino do Apache Kafka e verifique se é possivel gravar no

banco de dados do Apache Kafka.

¢ Crie o destino do Apache Kafka antes de configura-lo. Consulte Adicionar um destino de publicacdo para

obter mais informagdes.

¢ (Opcional) Verifique se o OpenTLS esta instalado na maquina em que o Pl Integrator for Business Analytics
esta instalado. Esta etapa sera necessaria somente se vocé estiver usando o TLS/SSL para se conectar ao

Apache Kafka.

1. Na pagina Administracdo, clique na guia Destinos. Em seguida, selecione o destino na lista Destinos de

Publicagao.

Nota: caso vocé ja tenha selecionado seu destino, pule para a préoxima etapa.

2. Va até a tabela a seguir e insira as informagdes necessarias. Clique nos botdes conforme sdo habilitados.

Parametro Descrigao
Kafka Brokers Lista separada por virgula de Kafka Brokers.
Especificar usando o formato Host:Port, Host:Port.
Codec Tipo de compressao em conjuntos de mensagens. O
padrdo é Nenhum. As opg¢des validas incluem: gzip,
Snappy.
Usar TLS/SSL Use TLS/SSL (Transport Layer Security) ao se

conectar a Kafka Brokers.

Verificacdo do nome do host TLS/SSL

Algoritmo de verificacdo de nome do host TLS/SSL
do corretor (propriedade Apache Kafka
ssl.endpoint.identification.algorithm) usado. HTTPS
ou Nenhum (sem verificacdo de nome do host). O
valor padrao é None.

Certificado do cliente

Caminho completo para o certificado do cliente
(arquivo .pem). Necessario somente se o TLS/SSL for
usado e um mecanismo SASL ndo for usado. Entre
em contato com o administrador do Apache Kafka
para obter um certificado do cliente OpenTLS para o
Pl Integrator for Business Analytics.

Chave do cliente

Caminho completo para o arquivo de chave do
cliente (arquivo .key). Necessério somente se o TLS/
SSL for usado e um mecanismo SASL ndo for usado.
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Senha principal

Senha para o arquivo de chave de certificado do

TLS/SSL. Necessario somente se o TLS/SSL for usado

e um mecanismo SASL ndo for usado.

Certificado raiz da CA

Caminho completo para o Certificado raiz da CA
usado para assinar o certificado do cliente.
Necessario somente se o TLS/SSL for usado.

Mecanismo SASL

Mecanismo SASL usado. O padrdo é Nenhum.
Quatro mecanismos de autentica¢do sao
suportados: GSSAPI (também conhecido como
Kerberos), PLAIN, SCRAM-SHA-256 e SCRAM-
SHA-512. E uma pratica recomendada combinar
PLAIN, SCRAM-SHA-256 ou SCRAM-SHA-512 com
criptografia TLS/SSL para que as informacdes de
autenticagdo sejam sempre criptografadas em
transito.

Nome do usudrio

Nome de usudrio do Kafka da autenticagdo SASL.
Ndo usado com a autenticagcdo GSSAPI.

Senha

Senha do Kafka da autenticagdo SASL. Ndo usado
com a autenticacdao GSSAPI.

Clique em Verificar o gravador do Kafka.

4. Clique em Salvar Alteragoes.

e Fornece aos usudrios acesso ao destino do Apache Kafka. Consulte Conceder acesso a destinos para obter

mais informacdes.

e Se vocé estiver usando o TLS/SSL para se conectar ao Apache Kafka Brokers, sera necessario converter os
certificados do Windows em certificados do OpenTLS. Entre em contato com o administrador do Apache
Kafka se vocé precisar de ajuda para converter esses arquivos.

Dicas para configurar o ambiente Azure Data Lake

Antes de poder configurar o destino do Azure Data Lake Storage Gen 1, vocé precisara configurar o ambiente

Azure Data Lake. Ele inclui o seguinte:

e Obter a ID do locatario para Azure Active Directory

e Configure o aplicativo web para acessar as APIs da web

Para comecar a usar o Azure Data Lake Storage Gen 2, consulte o seguinte site da Microsoft: Introducdo ao Azure

Data Lake Storage Gen?2.

Ao criar o ambiente Azure Data Lake, vocé coletara as seguintes informacdes:

¢ ID do locatdrio — ID que identifica o Active Directory

¢ |ID do cliente — ID que identifica o aplicativo Azure Data Lake
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¢ Chave do cliente — Usada para autenticar o Pl Integrator for Business Analytics

¢ ID de assinatura — ID que identifica o Azure Data Lake Storage

Nota: recomendamos que vocé copie estes valores para um arquivo de texto para referéncia posterior. Vocé
precisara destas informacGes ao configurar os elementos monitorados do Microsoft Azure Data Lake Storage.
Estas informacgdes sdo utilizadas pelo Pl Integrator for Business Analytics para conexdao com o Azure Data
Lake Storage Gen 2.

Obter a ID do locatario para Azure Active Directory

Nota: ha varias maneiras de se obter o ID do locatério. Consulte a documentac¢do da Microsoft para ver outras
alternativas.

1. Por meio do portal Microsoft Azure, fagca login na conta para conectar-se ao servico Azure Data Lake.
2. Selecione o Azure Active Directory em que o aplicativo da web é criado.
3. Clique em Propriedades.

default di /] - Properties

sisoft (default directory) - Properties

i=l Custom domain names - Name
Default Directory
& Mobility (MDM and MAM)

eqion

Lountry o o

Password reset United States

Company branding Location
United States datacenters
ﬂ' User settings

NotUTication language

Properties English ~
B Notifications settings Global admin can manage Azure Subscriptions and Management Groups
Yes No
SECURITY Diractory 1D
Conditional access 73856¢71-7490-401b-2976-01dcd42c490 | ]

Nota: Com atualiza¢Ges subsequentes do portal, a tela pode estar diferente e os parametros podem estar
localizados em outro lugar.

O ID do locatario é o valor no campo ID do diretdrio.

4. Copie esta string para um arquivo de texto.

Configurar o destino do Azure Data Lake Storage Gen 2

Conclua o procedimento abaixo para configurar o destino do Azure Data Lake Storage Gen 2.

¢ Conclua a configuracdo do ambiente de armazenamento no Azure Data Lake e colete as informacgses exigidas
para configurar o destino. Consulte Dicas para configurar o ambiente Azure Data Lake para obter mais
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informacdes.
e Crie o destino do Azure Data Lake Storage Gen 2 antes de configura-lo. Consulte Adicionar um destino de
publicacdo para obter mais informacdes.

¢ Conceda ao usuario que se conectara ao Azure Data Lake Storage Gen 2 as seguintes permissdes minimas:
no diretério ativo do Azure, registre o novo acesso ao aplicativo com segredo de client ou use o acesso ao
aplicativo existente. Em sua conta de armazenamento, atribua a fun¢do Proprietario dos dados do Blob de
armazenamento para este acesso ao aplicativo.

1. Na pagina Administracdo, clique na guia Destinos. Em seguida, selecione Azure Data Lake Storage Gen 2 na
lista Destinos de publicacado.

2. Configure o destino do Azure Data Lake Storage Gen 2 com os seguintes parametros:

Parametro Descricao
ID do locatario Identificador para a conta do diretdrio Azure Active.
ID do aplicativo Identificador do aplicativo Azure Data Lake Storage

Gen 2 que autentica o aplicativo Pl Integrator for
Business Analytics com o Azure Data Lake Storage
Gen 2.

Chave secreta do cliente Chave usada para autenticar o Pl Integrator for
Business Analytics com o aplicativo AAD.

Nome da Conta de Armazenamento do Azure Nome da conta do Azure que esta fazendo a
autenticacdo para os servigos do Azure.

Formato de Armazenamentos de Dados Formato de arquivo no qual os dados sdo
armazenados. O padrdo é Parquet.

3. Clique em Autenticar para verificar se as credenciais fornecidas permitem que o Pl Integrator for Business
Analytics se conecte ao Azure Data Lake Storage Gen 2.

Se a autentica¢do for bem-sucedida, uma lista de contéineres de data lakes aparecerd na lista Contéiner do
Azure.

4. Continue a configuracdo dos seguintes parametros:

Parametro Descricao

Contéiner do Azure Contéiner do Azure Data Lake Storage Gen 2 onde
os dados s3ao armazenados.

Diretério ADLS Local no Azure Data Lake Storage Gen 2 em que 0s
dados sdo gravados.

Anexar timestamp Quando selecionado, um timestamp de publica¢do
da hora da visualiza¢do sera anexado ao nome do
arquivo e um novo arquivo serd criado toda vez que
a visualizac¢do for publicada. Um ndimero de
sequéncia anexado é usado no final dos nomes de
arquivo subsequentes, uma vez que o limite maximo
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Parametro Descri¢ao

de linhas/objeto tenha sido cruzado. Se n3o for
selecionada, a sequéncia GUID aleatdria serd usada
no nome do arquivo e varios eventos de publicacdo
podem anexar dados ao arquivo existente até que o
limite maximo de linhas/objeto seja atingido. A nova
sequéncia GUID é entdo gerada para o arquivo
subsequente.

Incluir Cabegalho Quando selecionado, os nomes de coluna serdo
adicionados no inicio da tabela.

Delimitador de campo Caractere(s) que separa(m) os valores de dados no
arquivo do Azure Data Lake Storage Gen2. O padrdo
é um espaco tabulado.

Maximo de Linhas/Objetos Numero maximo de objetos em um arquivo. Padrao:
100 mil linhas. Faixa permitida 0—10.000.000.

Tempo limite de transferéncia Tempo limite da transferéncia de dados em
segundos. Padrdo: 900 (s). Faixa permitida 0—-86.400
(1 dia) (opcional)

Tamanho inicial da transferéncia Tamanho inicial da transferéncia de dados em bytes.
Padrao: 4.194.304 (4 MB). Faixa permitida
0-1.073.741.824 (1 GB). Esse valor representa o
tamanho do pacote, ndo todo o tamanho do
arquivo. (opcional)

Tamanho maximo da transferéncia Tamanho mdaximo da transferéncia de dados em
bytes. Padrdo: 4.194.304 (4 MB). Faixa permitida
0-1.073.741.824 (1 GB). Esse valor representa o
tamanho do pacote, ndo todo o tamanho do
arquivo. (opcional)

Tentativas de transferéncia maxima Tentativas de transferéncia maxima de dados.
Padrdo: 6. Faixa permitida 0—-100. (opcional)

5. Cligue em Verificar o ADL Writer para verificar que o Pl Integrator for Business Analytics pode ser gravado no
local especifico do Azure Data Lake Storage Gen 2.

Nota: se vocé tiver varios contéineres no menu suspenso do contéiner do Azure, certifique-se de que a
estrutura de pasta no diretdrio ADLS corresponda ao contéiner do Azure selecionado.

6. Clique em Salvar Alteragdes.

Forneca aos usudrios acesso ao destino do Azure Data Lake Storage Gen 2. Consulte Conceder acesso a
destinos para obter mais informacdes.
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Anexar timestamp em ADLS Gen 2

Com o timestamp, cada evento de publicagdo é uma operacgdo discreta. Os dados ndo sdo anexados aos arquivos,
e um novo arquivo é automaticamente criado e publicado com um timestamp diferente. Isso faz contraste ao
GUID, onde a publicagdo ndo é tratada como uma operacdo discreta, e s6 cria um novo arquivo sob o mesmo
evento de publicagdo uma vez que vocé cruza o limite maximo de linhas/objetos.

Na pagina de configuracdo do ADLS Gen 2, se a caixa Anexar Timestamp ndo for selecionada, seu alvo publicado
tera um nome de arquivo, um sublinhado e, em seguida, um GUID aleatdrio. O timestamp é configuravel e o
numero padrdo de linhas/objetos em um arquivo é de 100.000.

Publish Target Configuraticn

Apphcaiion 10 ) " . . Adminisiraons Edrminisimior seourity pooess
L Al ralylics P Analysin Serdce ssecurily acins

33 AcToaETl F— Hatificaticns Pl Mosfications Serace scunty scoses

Foofand

Soregs Ga RTP Ergine BTGP Ergine ascurfty sccss

i COnas *) pedcl ickerraty

Rawwthjenis

Warily ADLE 2 Wiiter [

Configurar o destino dos Hubs de Evento do Azure

Conclua o procedimento abaixo para configurar o destino dos Hubs de Evento do Azure e testar sua conexdo com
os Hubs de Evento do Azure.

Crie os Hubs de Evento do Azure. Crie ou identifique a politica de acesso compartilhado dos hubs de evento do
Azure para o Pl Integrator for Business Analytics. A permissdo minima necessaria é Envio.

1. Na pagina Administragdo, clique na guia Destinos. Em seguida, selecione o destino na lista Destinos de
Publicagao.

Nota: caso vocé ja tenha selecionado seu destino, va para a proxima etapa.

2. Recupere a string de conexdo dos Hubs de Eventos do Azure. O formato da string de conexdo é mostrado
abaixo:

Endpoint=sb.//<NamespaceName>.servicebus.windows.net/;SharedAccessKkeyName=<KeyName>;SharedAccessKey=<
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Nota: essa string de conexao é originada do préprio Hub de Evento, ndo do barramento de servico pai dos
Hubs de Evento (que também tem seu préprio ConnectionString, que ndo tem suporte no Pl Integrator).

3. Configure os Hubs de Evento do Azure com os seguintes parametros:

Parametro Descricao

Endpoint O endpoint do Hub de Eventos no qual os dados sdo
publicados. Esse é o valor do Endpoint na cadeia de
conexao do Hub de Eventos.

Nota: certifique-se de que toda a string comece com
"sb://" e que a terminagdo
".servicebus.windows.net" seja usada como entrada.

Nome da Chave de Acesso Compartilhado Usado em combinag¢do com a Chave de Acesso
Compartilhado para se conectar ao Hub de Eventos.
Esse é o valor SharedAccessKeyName na string de
conexao do Hub de Eventos.

Chave de Acesso Compartilhado Chave primaria ou secunddria do Hub de Eventos
gue é usada em combina¢do com o Nome da Chave
de Acesso Compartilhado para se conectar ao Hub
de Eventos. Esse é o valor SharedAccessKey na string
de conexdo do Hub de Eventos.

Caminho da entidade A entidade do Hub de Eventos na qual os dados
serdo publicados. Esse é o valor EntityPath na string
de conexao do Hub de Eventos.

Codificagdo de caracteres Conjunto de caracteres nos quais os dados sdo
codificados. Padrdo: UTF-8. Outras opgdes sdo:
ASCII, UTF-7, UTF-32 e Unicode.

A captura de tela a seguir mostra onde encontrar esses parametros no Portal do Microsoft Azure.

N eventhub - Shared access policies SAS Policy: SendOnly
Event Hub
o @ Delets  *=* More
= Overview Manag
POLIC cLams
¥ Diagnose and solve problems Send
SendOnly Send
- i I:‘ Listen
SETTINGS
Shared access policies
Primary key
{5 Metrics [preview) P gk e B D0z |
Properties Secondary key E
ﬂ Locks
Connection string—primary key
Connection string—secondary key
£= Consumer groups
SUPPORT + TROUBLESHOOTING
New support request
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Nota: pode ser usada uma politica de acesso compartilhado do Azure ja existente para os Hubs de Evento
gue atendam as permissdes minimas ou uma nova politica de acesso compartilhado pode ser criada para
essa finalidade. Com atualizagdes subsequentes do portal, a tela pode estar diferente e os parametros
podem estar localizados em outro lugar.

4. Clique em Verificar a gravagao do Hub de Evento para verificar se os Hubs de Evento sdo validos.
Clique em Salvar Alteragoes.

6. Dé aos usuarios acesso ao destino dos Hubs de Evento do Azure. Para obter mais informacgdes, consulte
Conceder acesso a destinos.

Configurar o destino do Hub loT do Azure

Conclua o procedimento abaixo para configurar o destino do Hub IoT do Azure e testar sua conexao com o Hub
loT do Azure.

Crie 0 Hub IoT do Azure. Crie ou identifique a politica de acesso compartilhado do Hub loT do Azure que o PI
Integrator for Business Analytics usard. Se vocé criar um dispositivo no qual todas as views do Pl Integrator for
Business Analytics sdo gravadas por meio da especificacdo da ID do dispositivo, entdo, "Leitura do registro" sera
a permissdao minima necessaria. Se o Pl Integrator for Business Analytics criar automaticamente um dispositivo
para cada view, entdo, "Gravacdo do registro" serd a permissdao minima necessaria.

Nota: a chave simétrica é a Unica autenticacdo com suporte nesta versao.

1. Na pagina Administrac¢do, clique na guia Destinos. Em seguida, selecione o destino na lista Destinos de
Publicagao.

Nota: caso vocé ja tenha selecionado seu destino, va para a proxima etapa.

2. Recupere a string de conexdo do Hub loT. O formato da string de conexdo é mostrado abaixo:
HostName=<Host Name>;SharedAccessKeyName=<Key Name>;SharedAccessKey=<SAS Key>

3. Configure o Hub 10T do Azure com os seguintes parametros:

Parametro Descricao

Nome do host O nome do host do Hub loT no qual os dados sdo
publicados. Esse é o valor HostName na cadeia de
conexdo do Hub loT.

Nome da Chave de Acesso Compartilhado Usado em combinac¢do com a Chave de Acesso
Compartilhado para se conectar ao Hub IoT. Esse é o
valor SharedAccessKeyName na string de conexao
do Hub loT.

Chave de Acesso Compartilhado Chave primaria ou secundaria do Hub loT que é
usada em combina¢do com o Nome da Chave de
Acesso Compartilhado para se conectar ao Hub loT.
Esse é o valor SharedAccessKey na cadeia de
conexao do Hub loT.

Codificag¢do de caracteres Conjunto de caracteres nos quais os dados sdo
codificados. Padrdo: UTF-8. Outras opgdes sdo:
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Parametro Descri¢ao

ASCII, UTF-7, UTF-32 e Unicode.

ID do dispositivo (Opcional) ID do dispositivo do dispositivo loT ou do
dispositivo loT Edge. Este é o nome atribuido ao
dispositivo. O ID do dispositivo é necessario para
dispositivos loT Edge. Ele é opcional para
dispositivos loT. Se nenhum nome for especificado,
sera criado um dispositivo loT para cada view.

Nota: apenas uma view deve ser criada por destino do Hub 10T se o ID do dispositivo for fornecido na
configuracdo de destino. A combinacdo de string de conexao e ID do dispositivo deve ser exclusiva nos
destinos do Hub loT criados. Podem ocorrer erros de conexao quando varias views usam a mesma string de
conexdo e ID do dispositivo.

A seguinte captura de tela mostra onde encontrar a string de conexdo para o Hub loT no Portal do Microsoft
Azure. Observe que o PI Integrator for Business Analytics requer a string de conexdo das Politicas de acesso
compartilhado do Hub loT (ndo a string de conexdo no nivel do dispositivo). A politica selecionada nesta
pagina determina as permissGes para a string de conexdo. Portanto, selecione ou crie uma politica que
forneca as permissdes exigidas, dependendo se o ID do dispositivo esta selecionado ou ndo, e forneca a
string de conexao da politica selecionada para o destino do PI Integrator for Business Analytics. Ndo ha
suporte para strings de conexao no nivel do dispositivo.

Microsoft Azure P Sear rees, services, and docs
Home > Microsoft.lotHub Overvie - Shared access policies registryReadWrite X
Create a resource .X‘ #.m lemait ] - Shared access policies
L T Hu Mors
Al services PR
* FAVORITES
=1 Dashboard
4-‘ 10T Hub uses permissions to grant access to each loT hub endpoint. Permissions limit the access to an loT hub based on functionaiity.
| resources Permissions
& Resource groups °
& App senvices V| Registry write @
% Function Apps Events PoLICY PERMISSIONS
NS
® SQL databases Settings iothubowner registry write, service connect, device cont connect @

& Azure Cosmos DB Shared access policies service service connect

8 virtual machines
device device connect

4 Load balancers Shared access keys
registryRead registry read Primary key @

registryReadWrite registry write =t =

B storage accounts

Virtual networks

@ Azure Active Directory

. Monitor

@ advisor

W security Center 3 Automation script

A seguinte captura de tela mostra onde encontrar os parametros de ID do dispositivo e onde definir o Tipo
de Autenticacdo no Portal do Microsoft loT para o Hub loT do dispositivo.
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jdoe-iothub - loT Devices Add Device
N Overview
‘_. You can use this ool to view, create, update, and delete devices on your IoT Hub.
B Activity log
2 Access control (IAM) Query®
SELECT * FROM devices
R WHERE
optional (eg. tags location="US) 1
Shared access policies
2 Pricing and scale
Operations menitoring 1
T 1P Fiter Con
- P Fiiter by Device id |
i= Properties
8 Locks V| Plntegrator vie
£l Automation script
B loT Devices

Nota: com atualiza¢des subsequentes do portal, a tela pode estar diferente e os parametros podem estar
localizados em outro lugar.

4. Clique em Verificar a gravagdo do Hub loT para verificar se o Hub loT é vdlido.

Se for especificado um ID do dispositivo, o Pl Integrator for Business Analytics tentard encontrar o
dispositivo. Se nenhum ID do dispositivo for especificado, um dispositivo serd criado e, uma vez concluida a
verificacao, ele sera excluido.

Clique em Salvar Alteragdes.

6. Dé aos usudrios acesso ao destino do Hub loT do Azure. Para obter mais informagdes, consulte Conceder
acesso a destinos.

Configurar o destino do banco de dados Azure SQL ou do Pool de
SQL Dedicado do Azure

Conclua o procedimento para configurar o destino do banco de dados do Azure SQL ou do Pool de SQL Dedicado
do Azure.

1. Instale o banco de dados no Azure e conclua as tarefas a seguir:

a. Defina uma regra de firewall no Azure para conceder permissdo ao servidor (no qual o PI Integrator for
Business Analytics estd instalado) para enviar solicitacdes a esses destinos.

Por padrao, os firewalls do Azure impedem que aplicativos externos acessem os servidores do banco de
dados do Azure SQL ou do Pool de SQL Dedicado do Azure. Portanto, vocé deve conceder explicitamente
acesso ao servidor.

Dica: navegue até o portal Microsoft Azure, na maquina em que o Pl Integrator for Business Analytics esta
instalado. O campo de ID do cliente que identifica os clientes que podem acessar os servidores do banco de
dados sera automaticamente preenchido com o endereco IP da maquina.

a. Conceda ao usudrio SQL inserido na configura¢do do destino de publicagdo do Pl Integrator for Business
Analytics que se conectard ao banco de dados Azure SQL ou ao Pool de SQL dedicado do Azure as
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seguintes permissdes minimas no banco de dados Azure SQL ou no Pool de SQL dedicado do Azure:
CONNECT, SELECT, CREATE TABLE, ALTER, INSERT, DELETE.

2. Adicione o destino de publicacdo ao Pl Integrator for Business Analytics. Consulte Adicionar um destino de
publicacao.

3. Configure o destino de publica¢do. Clique no tépico abaixo adequado ao seu destino:
e Configurar o destino do banco de dados do Azure SQL
e Configuracdo de destino do Pool de SQL dedicado do Azur

4. Conceda aos usudrios acesso ao destino de publicacdo. Consulte Conceder acesso a destinos.

Configurar o destino do banco de dados do Azure SQL

Conclua o procedimento abaixo para configurar o destino do Pool de SQL dedicado do Azure e testar sua
conexdo com o Pool de SQL dedicado do Azure.

e Crie o Pool de SQL dedicado do Azure.

¢ Adicione o Pool de SQL dedicado do Azure como destino. Para obter mais informacgdes, consulte Adicionar
um destino de publicacao.

1. Na pagina Administragdo, clique na guia Destinos. Em seguida, selecione Banco de dados do Azure SQL na
lista Destinos de Publicagao.

Nota: caso vocé ja tenha selecionado seu destino, va para a proxima etapa.

2. Configure o destino do Pool de SQL dedicado do Azure com os seguintes parametros:

Parametro Descricao

Nome do host Nome do servidor que hospeda o banco de dados
SQL do Azure. O formato é:
server_name.database.windows.net.

Nome de usudrio de autenticagdo do SQL Nome de usudrio usado para se conectar ao Pool de
SQL dedicado do Azure.

Senha de autentica¢ao do SQL Senha usada para se conectar ao Pool de SQL
dedicado do Azure.

Limite de tempo de publicacao O tempo que o servico do Pl Integrator Framework
aguarda a conclusao da operagao de publicacao
antes de atingir o tempo limite. O padrdo é 30
segundos.

Usar alta disponibilidade (Opcional) Conecte-se a um SQL Server que suporte
clusters de alta disponibilidade e de failover. Usar
Alta Disponibilidade ativa a propriedade de conexao
MultiSubnetFailover na string de conexao. Para
obter mais informagdes sobre esta propriedade,
consulte o site da Microsoft.
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Parametro Descri¢ao

Banco de dados Nome do banco de dados no Pool de SQL dedicado
do Azure no qual as tabelas estdo localizadas.

Esquema Esquema SQL associado as tabelas em que os dados
estdo armazenados.

Clique em Conectar.
Selecione o banco de dados na lista Banco de Dados.

Clique em Salvar Alteragoes.

o v kW

Dé aos usuarios acesso ao destino do Pool de SQL dedicado do Azure. Para obter mais informacgdes, consulte
Conceder acesso a destinos.

Configuracao de destino do Pool de SQL dedicado do Azur

Conclua o procedimento abaixo para configurar o destino do Pool de SQL dedicado do Azure e testar sua
conexdao com o Pool de SQL dedicado do Azure.

e Crie o Pool de SQL dedicado do Azure.

¢ Adicione o Pool de SQL dedicado do Azure como destino. Para obter mais informacdes, consulte Adicionar
um destino de publicagao.

Nota: a Microsoft alterou o nome do produto SQL Data Warehouse do Azure (pool SQL dedicado). A partir da
primavera de 2024, o nome atual do produto da Microsoft para este servigo no Portal do Azure é Pool de SQL
Dedicado.

1. Na pagina Administracdo, clique na guia Destinos. Em seguida, selecione o destino na lista Destinos de
Publicagao.

Nota: caso vocé ja tenha selecionado seu destino, va para a proxima etapa.

2. Configure o destino do Pool de SQL dedicado do Azure com os seguintes parametros:

Parametro Descricao

Nome do host Nome do servidor que hospeda o banco de dados
do Azure SQL. O formato é:
server_name.database.windows.net.

Nome de usudrio de autentica¢do do SQL Nome de usudrio usado para se conectar ao Pool de
SQL dedicado do Azure

Senha de autentica¢dao do SQL Senha usada para se conectar ao Pool de SQL
dedicado do Azure

Limite de tempo de publicagao O tempo alocado para publicacdo de dados no
destino antes que o servico do Pl Integrator
Framework atinja o tempo limite. O padrao é 30
segundos se o campo for deixado em branco.
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Parametro Descri¢ao

Usar alta disponibilidade (Opcional) Conecte-se a um SQL Server que suporte

clusters de alta disponibilidade e de failover. Usar
Alta Disponibilidade ativa a propriedade de conexao
MultiSubnetFailover na string de conexdo. Para
obter mais informacdes sobre esta propriedade,
consulte o site da Microsoft.

Banco de dados Nome do banco de dados no Pool de SQL dedicado

do Azure no qual as tabelas estdo localizadas.

Esquema Esquema SQL associado as tabelas em que os dados

estdo armazenados.

3. Clique em Conectar.

4. Selecione o banco de dados na lista Banco de Dados.

5. Clique em Salvar Alteragoes.

Dé aos usuarios acesso ao destino do Pool de SQL dedicado do Azure. Para obter mais informacdes, consulte
Conceder acesso a destinos.

Configurar o destino do Google BigQuery

Conclua o procedimento abaixo para configurar o destino do Google BigQuery e verificar se vocé pode gravar no
recurso do Google BigQuery.

¢ No console do Google Cloud, em IAM, conceda a conta do servico do GCP as seguintes permissdes minimas
no projeto:

Nota: para obter mais informacgdes sobre as permissées e fun¢des do Google IAM, consulte
https://cloud.google.com/iam/docs/understanding-roles e https://cloud.google.com/iam/docs/creating-
custom-roles.

bigquery.datasets.create
bigquery.datasets.get
bigquery.datasets.update
bigquery.tables.create
bigquery.tables.list
bigquery.tables.delete
bigquery.tables.get
bigquery.tables.update
bigquery.tables.updateData
bigquery.jobs.create

Como alternativa, vocé pode atribuir a conta de servico do GCP as funcdes roles/bigquery.dataOwner e
roles/bigquery.jobUser, que incluem as permissdes minimas.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 59


https://msdn.microsoft.com/en-us/library/hh205662(v=vs.110).aspx
https://cloud.google.com/iam/docs/understanding-roles
https://cloud.google.com/iam/docs/creating-custom-roles
https://cloud.google.com/iam/docs/creating-custom-roles

'AV EVA\TM Pl Integrator for Business Analytics

Configurar destinos de publica¢do

¢ Crie o destino do Google BigQuery antes de configura-lo. Para obter mais informagdes, consulte Adicionar
um destino de publicagao.

1. Na pagina Administrac¢do, clique na guia Destinos. Em seguida, selecione o destino na lista Destinos de
Publicagao.

Nota: caso vocé ja tenha selecionado seu destino, va para a proxima etapa.

2. V3 até a tabela a seguir e insira as informacgdes necessarias. Clique nos botdes conforme sdo habilitados.

Parametro Description

Arquivo de chave de conta de servico do GCP Arquivo JSON que contém as credenciais de conta
de servico do GCP.

ID do Projeto BigQuery ID Unica para o seu projeto BigQuery na Google

Cloud Platform (GCP)

Dataset do BigQuery Contéiner de nivel superior que organiza e controla
0 acesso a tabelas e views. O dataset esta contido
em um projeto e deve ser criado antes que os dados
possam ser transmitidos ao BigQuery.

Tamanho da pagina de upload (Opcional) Nimero de linhas que sdo carregadas em
uma insercdo em massa. O tamanho padrao
recomendado é 500.

3. Clique em Verificar o Gravador do BigQuery do GCP.
4. Clique em Salvar Alteragoes.

5. Dé aos usuarios acesso ao destino do Google BigQuery. Para obter mais informacées, consulte Conceder
acesso a destinos.

Nota: nenhum registro em uma instancia do Google BigQuery pode ser modificado em 90 minutos apds ser
gravado ou atualizado. Para que o servigo do Pl Integrator Sync continue se comportando conforme
esperado (e ndo encontre essa limita¢do na gravagao de views no BigQuery), recomenda-se que o
AFMonitorUpdateFrequency seja definido em %PIHOMEG64%\Integrators\BA\
CAST.UL.WindowsService.exe.config para 120 minutos da seguinte maneira: <add
key="AFMonitorDataUpdateFrequency" value="120"/>.

O buffer de tempo extra (configuracao de 120 minutos versus limitagdo de 90 minutos), é para oferecer uma
janela ampla o suficiente para que o Google BigQuery tenha liberado o buffer de streaming. Sem esse buffer,
vocé pode acidentalmente encontrar a limitagdao definindo AFMonitorUpdateFrequency para o mesmo tempo
que a limitagdao (90 minutos). Se o buffer estiver definido corretamente, vocé vera a seguinte mensagem na
inicializagdo do aplicativo:

UnifiedAppConfig:AFMonitorDataUpdateFrequency: andlise bem-sucedida.

Valor AFMonitorDataUpdateFrequency de 'finalAppConfigFilePath’.

Usando o valor AFMonitorDataUpdateFrequency), '120'(minutos).
Se o buffer ndo estiver configurado corretamente e a limitagado for encontrada, clicar em Atualizar dados na
interface do usudrio ou sendo acionado pelo Pl Integrator Sync Service sem que AFMonitorUpdateFrequency seja
configurado corretamente, vocé vera a seguinte mensagem de erro:

A operag¢ao UpdateData foi interrompida devido a restrig¢ao PublishTarget (*-90 min maximo
de tempo final).
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Este PublishTarget, GcpBigQueryWriter, nao suporta linhas de exclusdo/atualizac¢ao de
dados que foram modificadas nos ultimos 90 minutos.
Resultado: nenhum dado foi alterado no PublishTarget.

Configurar o destino do Google Cloud Storage

Conclua o procedimento abaixo para configurar o destino do Google Cloud Storage e verificar se vocé pode
gravar no bucket do Google Cloud Storage.

Nota: para obter mais informacgdes sobre as permissdes e fungdes do Google IAM, consulte
https://cloud.google.com/iam/docs/understanding-roles e https://cloud.google.com/iam/docs/creating-custom-
roles.

¢ No console do Google Cloud, em IAM, conceda a conta de servigo do GCP acesso ao projeto do Google Cloud
Storage. As permissdes minimas sdo:

e storage.buckets.get
e storage.buckets.list
e storage.objects.create
e storage.objects.get
e storage.objects.delete

e Como alternativa, vocé pode atribuir a conta de servico do GCP a funcdo roles/storage.admin, que inclui as
permissdes minimas.

¢ Se o BigQuery estiver configurado, a conta de servico do GCP exigira as seguintes permissées adicionais:
e bigquery.datasets.create
e bigquery.datasets.get
e bigquery.tables.create
e bigquery.tables.list
e bigquery.tables.delete

e Como alternativa, caso o BigQuery esteja configurado, vocé pode atribuir a conta de servigo do GCP a funcao
roles/bigquery.dataOwner, que inclui as permissdes minimas.

¢ Crie o destino do Google Cloud Storage antes de configura-lo. Para obter mais informacgdes, consulte
Adicionar um destino de publicacao.

1. Na pagina Administracdo, clique na guia Destinos. Em seguida, selecione o destino na lista Destinos de
Publicacao.

Nota: caso vocé ja tenha selecionado seu destino, va para a proxima etapa.

2. V& até a tabela a seguir e insira as informacgGes necessdrias. Clique nos botdes conforme sdo habilitados.

Parametro Description

Formato de Armazenamentos de Dados Formato de arquivo no qual os dados sdo
armazenados. Padrdo: Parquet. Outras opgdes sdo:
JSON, JSON Indent e texto. Se o BigQuery for usado,
a Unica opgao suportada serd Texto.
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Compressao

Tipo de compressdo em conjuntos de mensagens.
Padrao: nenhum. Outras opgdes sdo gzip e Snappy.

Arquivo de chave de conta de servigo do GCP

Arquivo JSON que contém as credenciais de conta
de servico do Google Cloud Platform (GCP).

ID do Projeto BigQuery

(Opcional) ID unica para o seu projeto BigQuery no
GCP.

Incluir Cabegalho

(Opcional) Quando selecionado, os nomes de coluna
sdo adicionados ao inicio do arquivo.

Delimitador de campo

(Opcional) Caractere(s) que separam os campos de
dados nas linhas. Por padrdo, uma guia (\t), separa
0S Campos.

Delimitador de linhas

(Opcional) Caractere(s) que separam as linhas de
dados. Por padrdo, uma nova linha separa as linhas
de dados. Os caracteres que especificam uma nova
linha sdo especificos de plataformas. O padrao
fornece automaticamente os caracteres corretos ao
ambiente.

Nome do Bucket

Bucket do Google Cloud Storage para o qual os
dados sdo carregados.

Caminho da Pasta

(Opcional) Caminho para a pasta Google Cloud
Storage. Predefinido para a raiz do bucket
especificado.

Permitir Valores Nulos

Quando selecionados, os valores nulos sdo validos.
Padrdo: valores nulos sao permitidos

Maximo de Linhas/Objetos

(Opcional) Nimero maximo de objetos em um
arquivo. Padrdo: 100 mil linhas

Tamanho Maximo do Arquivo (KB)

(Opcional) Tamanho mdaximo de arquivo em
kilobytes. Padrao: 10 mil KB

Tempo Maximo de Atualizagdo (s)

(Opcional) Tempo maximo para atualizar o banco de
dados, em segundos, antes que o gravador atinja o
tempo limite. Padrdo: 86,4 mil segundos (1 dia)

Dataset do BigQuery

(Opcional) Contéiner de nivel superior que organiza
e controla o acesso a tabelas e views. O dataset esta
contido em um projeto e deve ser criado antes que

os dados possam ser transmitidos ao BigQuery.

3. Clique em Verificar o Gravador do GCP Storage.

4. Clique em Salvar Alteragoes.

5. Dé aos usudrios acesso ao destino do Google Cloud Storage. Para obter mais informagdes, consulte Conceder
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acesso a destinos.

Configurar o destino do Google Cloud Pub/Sub

Conclua o procedimento abaixo para configurar o destino do Google Cloud Pub/Sub e verificar se vocé pode
gravar no recurso do Google Cloud Pub/Sub.

Nota: para obter mais informacdes sobre as permissdes e fungdes do Google IAM, consulte
https://cloud.google.com/iam/docs/understanding-roles e https://cloud.google.com/iam/docs/creating-custom-
roles.

¢ No console do Google Cloud, em IAM, conceda a conta de servigo do GCP acesso ao projeto do Pub/Sub. As
permissées minimas no projeto sdo:

e pubsub.topics.list
e pubsub.topics.publish
e pubsub.topics.get
e pubsub.topics.create

e Como alternativa, vocé pode atribuir a conta de servico do GCP a fungdo roles/pubsub.editor, que inclui as
permissdes minimas.

¢ Crie o destino do Google Cloud Pub/Sub antes de configura-lo. Consulte Adicionar um destino de publicacdo
para obter mais informacgoes.

1. Na pagina Administracgdo, clique na guia Destinos. Em seguida, selecione o destino na lista Destinos de
Publicacao.

Nota: caso vocé ja tenha selecionado seu destino, pule para a préoxima etapa.

2. V& até a tabela a seguir e insira as informacgGes necessdrias. Clique nos botdes conforme sdo habilitados.

Parametro Descricao

Arquivo de chave de conta de servigo do GCP Arquivo JSON que contém as credenciais de conta
de servico do GCP

ID do projeto ID Unica do projeto Pub/Sub no console do GCP

Codificagao de caracteres Conjunto de caracteres nos quais os dados sao

codificados. Padrao: UTF-8. Outras opg¢des sao:
ASCII, UTF-7, UTF-32 e Unicode.

Compressao (Opcional) Tipo de compressdao em conjuntos de
mensagens. Padrdao: nenhum. Outras opgdes sdao

gzip e Snappy.

Clique em Verificar Gravador.
4. Clique em Salvar Alteragoes.

Dé aos usuarios acesso ao destino do Google Cloud Pub/Sub. Consulte Conceder acesso a destinos para
obter mais informagdes.
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Configure o destino do Hadoop Distributed File System (HDFS)

Conclua o procedimento a seguir para configurar o destino do Sistema de arquivos distribuidos Hadoop e

verificar se o gravador de HDFS esta funcionando.

Crie o destino do Sistema de arquivos distribuidos Hadoop antes de configura-lo. Consulte Adicionar um destino

de publicacdo para obter mais informagoes.

1. Na pagina Administracdo, clique na guia Destinos. Em seguida, selecione o destino na lista Destinos de

Publicagao.

Nota: caso vocé ja tenha selecionado seu destino, pule para a préxima etapa.

2. Configure o destino do Sistema de arquivos distribuidos Hadoop com os seguintes parametros:

Parametro

Descri¢ao

HDFS URL

URL para acessar o HDFS por meio do WebHDFS
diretamente ou por meio do gateway Apache Knox
ou HttpFs.

Exemplos:
HDFS — http://host:50070/webhdfs/v1
HttpFS — http://host:14000/webhdfs/v1

Apache Knox — https://host:8443/gateway/default/
webhdfs/v1

Verificar o certificado TLS/SSL

Marque a caixa de selegao se vocé estiver usando
um certificado TLS/SSL. Desmarque a caixa de
selecdo se vocé estiver usando um certificado
autoassinado.

Nome do Usudrio

Nome de usudrio utilizado para se conectar ao
HDFS. O usudrio deve ter permissdes para ler e
gravar no HDFS.

Senha

(Opcional) Senha para autenticar o usuario. E usada
ao conectar ao Apache Knox ou ao conectar ao
HttpFS se a seguranga estiver ativada. Se uma senha
é fornecida, se usa uma autenticacdo Hadoop HTTP.
Se nenhuma senha for inserida, o Pl Integrator for
Business Analytics usard a autenticacdo simples
Hadoop.

Diretdrio

Diretério no qual os arquivos de texto sdo criados.
Clique em Navegar para navegar pelo diretério em
gue vocé deseja que os arquivos sejam alocados.

Anexar timestamp

Quando selecionado, um timestamp de quando a
view é publicada é anexado ao nome do arquivo e
um arquivo é criado cada vez que a view for
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Parametro Descri¢ao

publicada. Se nado for selecionado, entdo os dados
serdo anexados ao arquivo existente.

Incluir Cabeg¢alho Quando selecionado, os nomes de coluna sdo
adicionados ao inicio do arquivo.

3. Clique em Verificar gravador de HDFS para verificar se o gravador de HDFS pode se conectar ao HDFS e

8

ravar nele.

Nota: se vocé ndo conseguir gravar com sucesso no HDFS, consulte Dicas para configurar o Hadoop
Distributed File System (HDFS).

4. Clique em Salvar Alteragoes.

Dé aos usuarios acesso ao destino do Sistema de arquivos distribuidos Hadoop. Consulte Conceder acesso a

d

Dicas pa

estinos para obter mais informacgdes.

ra configurar o Hadoop Distributed File System (HDFS)

Para que o HDFS funcione com o PI Integrator for Business Analytics, conclua as seguintes tarefas:

e C
e C

rie o usuario HDFS.

rie o diretdrio de usudrio e conceda as permissodes.

O procedimento a seguir descreve como concluir essas tarefas.

1. C

rie o usuario HDFS.

a. Crie o usudrio HDFS na maquina em que o WebHDFS estd instalado.

b. Adicione o usudrio HDFS a um grupo.

N

ota: o usuario do HDFS pode ser adicionado a qualquer grupo. Porém, para os propdsitos deste exemplo,

esse grupo sera chamado de grupo HDFS.

2. C

a.
b.

o

Configu

rie o diretdrio e conceda permissoes.

Crie um diretério no HDFS.

Altere o proprietdrio desse diretério para o usudrio HDFS.

Altere o grupo ao qual esse diretério pertence para HDFS.

Conceda permissées de Leitura e Gravacgdo ao proprietario do diretério (ou seja, ao usuario HDFS).

Conceda permissées de Leitura e Gravagdo para o grupo ao qual o diretdrio pertence.

rar o destino do Microsoft SQL Server

Conclua o procedimento a seguir para configurar o destino Microsoft SQL Server e testar sua conexao com o
banco de dados SQL.

Crieo

destino Microsoft SQL Server antes de configura-lo. Para obter mais informagdes, consulte Adicionar um

destino de publicagao.
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Nota: certifique-se de que a conta de servigo que executa o servi¢o do Pl Integrator Framework (ou o usuario
SQL, se vocé estiver usando a autenticacdo SQL) tenha as seguintes permissées no Microsoft SQL Server:

Nivel de servidor — CONNECT SQL, VIEW ANY DATABASE

Nivel de banco de dados — CONNECT, CREATE TABLE

Todos os esquemas, incluindo o esquema dbo — SELECT, ALTER, INSERT, DELETE

1. Na pagina Administragdo, clique na guia Destinos. Em seguida, selecione o destino na lista Destinos de

Publicacao.

Nota: caso vocé ja tenha selecionado seu destino, va para a proxima etapa.

2. Configure o destino Microsoft SQL Server com os seguintes parametros:

Parametro

Descri¢ao

Nome do host

Nome do host e instdncia (Nome de host\Instdncia)
da mdquina na qual o SQL Server esta sendo
executado.

Nome de usudrio de autenticagdo do SQL

Nome do usuario utilizado para conectar-se ao SQL
Server (especificar apenas se estiver usando a
autenticacdo SQL Server. Se estiver usando a
seguranca integrada do Windows, a conta de servico
do PI Integrator for Business Analytics sera usada.)

Senha de autentica¢ao do SQL

Senha utilizada para conectar-se ao SQL Server
(especificar apenas se estiver usando a autentica¢do
SQL Server. Se estiver usando a seguranga integrada
do Windows, a conta de servico do PI Integrator for
Business Analytics sera usada.)

Limite de tempo de publicagao

O tempo alocado para publicacdo de dados no
destino antes que o servi¢o do Pl Integrator
Framework atinja o tempo limite. O padrao é 30
segundos.

Usar alta disponibilidade

(Opcional) Conecte-se a um SQL Server que suporte
clusters de alta disponibilidade e de failover. Usar
Alta Disponibilidade ativa a propriedade de
conexdao MultiSubnetFailover na string de conexao.
Para obter mais informacdes sobre esta
propriedade, consulte o site da Microsoft.

Banco de dados

Nome do banco de dados no SQL Server em que as
tabelas estdo localizadas.

Esquema

Esquema SQL associado as tabelas em que os dados
estdo armazenados.

3. Clique em Conectar para verificar se vocé pode se conectar ao Banco de dados SQL.

4. Clique em Salvar Alteragoes.
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Dé aos usuarios acesso ao destino Microsoft SQL Server. Para obter mais informagdes, consulte Conceder
acesso a destinos.

Configurar o destino de publicacdo do Banco de dados Oracle

Conclua o procedimento para configurar o destino de publicagdo do Banco de dados Oracle.

1.

5.

Instale os componentes de acesso ao Banco de dados Oracle. Consulte Instalar os Componentes de acesso
ao Banco de dados Oracle para obter mais informacdes.

Adicione um Destino de Publicacdo ao Pl Integrator for Business Analytics. Consulte Adicionar um destino de
publicacdo.

Configurar o destino de publicacdo do Banco de dados Oracle. Consulte Configure o destino do Oracle para
obter mais informagdes.

Conceda ao usuario Oracle inserido na configuracdao do destino de publicacdo do Pl Integrator for Business
Analytics as seguintes permissées minimas da Oracle:

¢ Privilégios do sistema — CREATE SESSION, CREATE TABLE, DELETE TABLE
e Privilégios de tablespace — cota suficiente para criar tabelas

Conceda aos usudrios acesso ao destino de publicagdo. Consulte Conceder acesso a destinos.

Instalar os Componentes de acesso ao Banco de dados Oracle

Nota: Esta é uma etapa opcional. Os Componentes de acesso ao banco de dados Oracle (ODAC) é necessario
somente se vocé estiver publicando no Banco de dados Oracle.

Conclua este procedimento antes de adicionar e configurar o banco de dados Oracle como um destino de
publicacdo.

1.

Instale o software Componentes de acesso ao banco de dados Oracle no computador no qual o Pl Integrator
for Business Analytics esta instalado.

Nota: verifique os Requisitos do sistema para a versao especifica do software ODAC a ser instalada.

Localize o arquivo tnsnames.ora no \ODAC_install_directory\Network\Admin\Sample.
Edite o arquivo tnsnames.ora e adicione uma entrada para o Banco de dados Oracle.
A sintaxe é a seguinte:

Net_Service_ Name =

(DESCRIPTION=
(ADDRESS=(PROTOCOL=protocol _name) (HOST=Oracle_database_host_name) (PORT=port)
(CONNECT_DATA=

(SERVER=service_handler_type)

(SERVICE_NAME=(TNS_listener_service name)

O Net_Service_Name é o alias para o SERVICE_NAME. Ao configurar o destino de publicacdo Oracle, é
possivel definir o parametro Data Source para o Net_Service_Name. Para mais informacdes sobre o arquivo
tnsnames.ora, consulte a sua documentacao do Oracle.

Mova o arquivo tnsnames.ora para o diretorio \ODAC_install_directory\Network\Admin.

Adicione o local do software ODAC a variavel de ambiente PATH.
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6. Crie a varidvel de ambiente do sistema TNS_ADMIN e direcione-a para o diretdrio no qual o arquivo
tnsnames.ora esta localizado.

7. Continue adicionando o banco de dados Oracle como um destino de publica¢do. Para obter mais
informacgdes, consulte Adicionar um destino de publicacao.

Configure o destino do Oracle

Conclua o procedimento a seguir para configurar o destino Oracle e testar sua conexdao com o banco de dados
Oracle.

¢ Instale os Componentes de acesso ao Banco de dados Oracle.
Consulte Instalar os Componentes de acesso ao Banco de dados Oracle.

¢ Crie o destino Oracle. Consulte Adicionar um destino de publicacdo para obter mais informacgdes.

1. Na pagina Administracdo, clique na guia Destinos. Em seguida, selecione o destino na lista Destinos de
Publicagao.

Nota: Caso vocé ja tenha selecionado seu destino, pule para a préxima etapa.

2. Configure o destino Oracle com os seguintes parametros:

Parametro Descrigao

Fonte de dados Nome do Oracle Net Services, descritor de conexdao
ou alias que identifica o Banco de dados Oracle

Nota: consulte Instalar os Componentes de acesso
ao Banco de dados Oracle para obter informacgdes
sobre como 0 nome do Oracle Net Services é
especificado.

Nome do Usudrio Nome do usuario utilizado para conexdo ao banco
de dados Oracle

Senha Senha utilizada para conexdo ao Banco de dados
Oracle

3. Clique em Conectar para verificar se vocé pode se conectar ao banco de dados.
4. Clique em Salvar Alteragoes.

5. Dé aos usuarios acesso ao destino Oracle. Consulte Conceder acesso a destinos para obter mais informacoes.

Configurar o destino de publicacao do SAP® HANA® ODBC

Instale o servidor SAP HANA e o SAP HANA Database Client.

Crie o destino do SAP HANA ODBC antes de configura-lo. Consulte Adicionar um destino de publica¢do para
obter mais informagdes.

Verifique as seguintes permissdes para o destino do SAP HANA ODBC:
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e Por padrdao no SAP HANA, o acesso ODBC aos dados do SAP HANA esta habilitado para todos os usuarios.
Vocé pode limitar o acesso desativando o acesso ODBC no SAP HANA para usudrios especificos. No entanto,
certifique-se de que o usuario do SAP HANA inserido na configuragao do destino de publica¢do do PI
Integrator for Business Analytics tenha as seguintes permissdes de acesso:

¢ A permissao Select em SYS.SCHEMAS, SYS.TABLES e SYS.TABLE_ COLUMNS.
¢ As seguintes permissdes nos esquemas nos quais as tabelas serdo criadas:
e ALTER

e CREATE ANY

e DELETE

e DROP

e EXECUTE

e INSERT

e SELECT

e UPDATE

1. Configure o destino do SAP HANA ODBC com os seguintes parametros:

Parametro Descricao

Nome do host Nome do host ou endereco IP do servidor SAP
HANA.

Porta Numero da porta utilizado para conectar-se a

instancia do SAP HANA.

Nome do usudrio Nome do usuario utilizado para conectar-se a
instancia do SAP HANA.

Senha Senha utilizada para conectar-se a instancia do SAP
HANA.
Banco de dados (Opcional) Se houver varios bancos de dados na

instancia, o banco de dados ao qual se conectar.

Usar conector TLS/SSL Use o TLS/SSL para conectar-se ao servidor SAP
HANA.

Nota: sdo suportados apenas certificados
armazenados no armazenamento de certificados do
SAP HANA.

2. Clique em Obter esquemas para preencher a lista de esquemas.

3. Selecione na lista 0 esquema em que as tabelas sao gravadas.

Nota: Se a lista estiver vazia, um ou mais dos parametros estd incorreto.

4. Clique em Conectar para verificar se é possivel abrir a conexdao ODBC com o SAP HANA.

Clique em Salvar Alteragdes.

Dé aos usuarios acesso ao destino SAP HANA. Consulte Conceder acesso a destinos para obter mais informagdes.
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Configurar destino do arquivo de texto

Conclua o procedimento abaixo para configurar o destino do arquivo de texto.

Crie o destino de arquivo de texto antes de configura-lo. Para obter mais informagdes, consulte Adicionar um

destino de publicagdo.

1. Na pagina Administracdo, clique na guia Destinos. Em seguida, selecione o destino na lista Destinos de

Publicagao.

Nota: caso vocé ja tenha selecionado seu destino, va para a proxima etapa.

2. Configure o destino do arquivo de texto com os seguintes parametros:

Parametro Descricao
Diretdrio Diretdrio no qual o arquivo de texto é criado.
Anexar timestamp Quando selecionado, um timestamp de quando a

view é publicada é anexado ao nome do arquivo e
um arquivo é criado cada vez que a view for
publicada. Se ndo for selecionado, entdao os dados
serao anexados ao arquivo existente.

Incluir Cabegalho

Quando selecionado, os nomes de coluna sdo
adicionados ao inicio do arquivo de texto.

Delimitador de campo

Caractere(s) que separa(m) os valores de dados no
arquivo de saida. O padrdo é um espaco tabulado.
Para escolher um delimitador de guia, deixe o
campo em branco ou digite \t.

Nota: ndo use um caractere que aparece em seus
dados, por exemplo, um ponto. Se vocé usar um
ponto como delimitador, o ponto em seus dados
serd removido antes de ser gravado no arquivo.

Extensao do arquivo

Extensdo dos arquivos de saida. O padrdo é .txt.

Nota: a partir do Pl Integrator for Business Analytics
2020 R2 SP2, as extensdes de destino do arquivo de
texto sdo limitadas a .csv e .txt. Para destinos que
foram configurados com diferentes extensdes antes
de atualizar para 2020 R2 SP2, a extensao
continuard funcionando para o destino pré-
configurado.

Se o destino pré-configurado for modificado e a
extensdo for alterada para .csv ou .txt, a partir de
agora, a extensdo salva anteriormente ndo estara
mais disponivel.

3. Clique em Salvar Alteragdes.
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4. Dé aos usuarios acesso ao destino do arquivo de texto. Para obter mais informacgdes, consulte Conceder

acesso a destinos.

Conceder acesso a destinos

O procedimento a seguir descreve como um Administrador atribui permissdo aos usuarios para publicar views
em um destino de publicacdo.

el A

bl

Clique no icone de menu E e cligue em Administragao.
Clique na guia Destinos.
Clique no destino na lista Destinos de Publicacao.

Para conceder acesso ao destino de publica¢do selecionado, clique em Adicionar Identidade no painel
Acesso ao Destino.

Selecione a identidade e clique em OK.

Clique em Salvar Alteragoes.

Migrar o destino do PI View para o destino do Microsoft SQL Server

A partir do PI Integrator for Business Analytics 2020 R2 SP2, o destino PI View foi descontinuado e todas as
exibicdes existentes usando o destino Pl View terdo a publica¢do desativada. O destino Pl View ndo esta mais
acessivel na lista Publicar Destinos na guia Destinos na pagina Administragdo. O procedimento a seguir descreve
como migrar uma exibi¢ao usando o destino de publicacao Pl View para um destino de publicagao do Microsoft
SQL Server como alternativa.

Nota: se vocé ndo precisar mais da publicagao da view existente no destino Pl View, é recomendavel exclui-la
usando o botdo Remover Views. Isso excluira os dados da view e as tabelas de metadados no banco de dados
SQL PlintegratorDB no SQL Server. Facga isso somente se vocé ja tiver migrado sua visualizacdo para um destino
do Microsoft SQL Server ou tiver determinado que a view pode ser removida.

1.

Se vocé ndo tiver um destino de publicacdo do Microsoft SQL Server configurado, consulte Configurar o
destino do Microsoft SQL Server.

Crie uma cdpia da view usando o destino de publicacdo do Pl View selecionando-a na pdgina Minhas Views
e clicando em Modificar View.

Verifique se a visualizagdo copiada tem a configuracdo desejada nas paginas Selecionar Dados e Modificar
View.

Quando estiver pronto para publicar, navegue até a pagina Publicar.

Clique na lista Configura¢ao de Destino e selecione o destino do Microsoft SQL Server que vocé criou na
etapa 1.

Selecione o Modo de Exibicdo e o Tempo de Publicacdo desejados. Se vocé selecionou a opgdo Executar em
uma Agenda, especifique a frequéncia de publicacdo para as execugées subsequentes.

Clique em Publicar para publicar a view.
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Tarefas administrativas

Ha diversas tarefas administrativas que podem ser executadas no sistema Pl Integrator, incluindo a protecao de
views para usuarios especificos e a recuperagao de fluxos de saida.

Sobre o Pl Integrators Service Group

Ao instalar o Pl Integrator, o grupo do Windows PI Integrators Service Group é criado e a conta de servico do
Windows ou contas virtuais especificadas para executar o servico Pl Integrator Framework sdo adicionadas a este
grupo. O Pl Integrators Service Group atribui as contas de servigo do Windows ou virtuais o minimo de privilégios
necessario para executar o servico do Pl Integrator Framework. Portanto, é recomendado ndo adicionar a conta
de servico do Windows ou conts virtuais ao grupo de administradores local na maquina em que o Pl Integrator
estd instalado.

Remover servidores AF e bancos de dados Pl

E possivel remover Pl AF Servers que vocé n3o deseja mais usar nas views.

1. Clique no icone de menu E e cligue em Administragao.
2. Na pagina Administracdo, clique na guia Bancos de Dados do AF.

Selecione o Pl AF Server que deseja remover da lista Servidores AF.

Nota: Os bancos de dados no servidor selecionado sao exibidos ao lado da lista Servidores AF na lista Bancos
de Dados do AF.

4. Cliqgue em Remover Servidor AF para remover o Pl AF Server selecione e seus bancos de dados da lista de
servidores e bancos de dados disponiveis.

O PI AF Server ndao aparece mais na lista Servidores AF.

Editar um destino de publicacao

A secdo a seguir descreve como editar os parametros de configuragdo para o destino de publicagdo.

Nota: Quando vocé edita a configuracdo para um destino, as mudancas sdo propagadas a todas as views que
estdo publicadas subsequentemente a esse destino. Indo adiante, as views agendadas e as views de streaming ja
em progresso coletardo as novas configuracdes de destino no préximo scan.

Clique no icone de menu E e clique em Administragao.
2. Na pagina Administracao, clique na guia Destinos.
A pagina Configuragdo do Destino de Publicagdo se abre.

3. Selecione o destino de publicacdo na lista Destinos de Publicagao.
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Nota: Cada tipo de destino de publicacdo tem um conjunto de pardmetros de configuracao exclusivos.

4. Edite os parametros no painel Configuracdo do Destino.

Clique no link para o seu destino de publicacdo para obter uma descri¢dao dos parametros de configuragao:

Configure o destino do Amazon Kinesis Data Streams
Configure o destino do Amazon Redshift

Configurar o destino Amazon S3

Configurar o destino do Apache Hive

Configurar o destino do Apache Kafka

Configurar o destino do Azure Data Lake Storage Gen 2
Configurar o destino dos Hubs de Evento do Azure
Configurar o destino do Hub loT do Azure

Configurar o destino do banco de dados do Azure SQL
Configuracao de destino do Pool de SQL dedicado do Azur
Configurar o destino do Google BigQuery

Configurar o destino do Google Cloud Storage

Configurar o destino do Google Cloud Pub/Sub

Configure o destino do Hadoop Distributed File System (HDFS)
Configurar o destino do Microsoft SQL Server

Configure o destino do Oracle

Configurar destino do arquivo de texto

5. Clique em Salvar Alteragées.

Remover um destino de publicacao

Clique no icone de menu E e cligue em Administracao.

2. Na pagina Administracao, clique na guia Destinos.

A pagina Configuracdo do Destino de Publicagdo se abre.

Selecione o destino de publicagdo que deseja remover na lista Destinos de Publicagdo.

4. Cliqgue em Remover Destino de Publicagao.

Verifique se o destino de publicacdo selecionado ndo aparece mais na lista Destinos de Publicagdo.

Adicionar um registro do esquema

Nota: este recurso esta disponivel na edicdo Advanced do Pl Integrator for Business Analytics.

Esta versdao suporta o Registro do esquema confluente. Somente esquemas do Avro sdo suportados.
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Clique no icone de menu E e clique em Administragdo.

2. Cligue na guia Navegador do registro de esquema.

3. No painel Adicionar registro de esquema, insira um nome e a URL para o registro.
A URL deve ser iniciada por http:// ou https://.

4. Clique em Adicionar registro de esquema.

O painel Esquemas disponiveis é preenchido com quaisquer esquemas no registro. O painel Visualizar
esquema exibe os pares de nome-valor para o esquema selecionado.

Adicionar um esquema ao registro do esquema

Clique no icone de menu E e clique em Administragdo.
Clique na guia Navegador do registro de esquema.
Selecione o registro no painel Registros de esquema.

Na secdo Adicionar ou atualizar esquema, clique em Selecionar o arquivo do esquema.

i h N e

Na janela Abrir, navegue até o arquivo de esquema, selecione o arquivo e clique em Abrir.

Nota: Somente arquivos de esquema do Avro sdo suportados.

O nome do esquema aparece no painel Esquemas disponiveis e a estrutura do esquema aparece no painel
Visualizar esquema.

Gerenciar views

Como Administrador, vocé pode executar as seguintes acées nas views:

e Importar e exportar views
e Excluir views
e Adicionar usuarios as views

e Remover usudrios das views

Gerenciar o acesso a uma unica view

E possivel gerenciar o acesso para uma Unica view:

 E possivel adicionar identidades a uma Unica view ou remover identidades de uma Unica view.

e E possivel alterar permissdes para uma identidade.

Para obter informagdes sobre como gerenciar o acesso a mais de uma view de cada vez, consulte Gerenciar o
acesso a varias views.

1. Cligue noicone de menu E e clique em Administragdo.
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2. Clique na guia Views.
3. Cligue na caixa de sele¢do para selecionar uma view.

O painel Detalhes exibe o rétulo Acesso da view. O acesso de cada identidade pode ser modificado. Consulte
Permissdes de acesso de view para obter mais informacoes.

Nota: se a configuracdo de seguranca de personificacdo estiver ativada, as identidades de acesso a dados
também serdo exibidas.

Views Details
Name Run Status Type Run Mode Start Time End Time Last Run Time = View Name
& Baller View 3sbdsh Assel Once B . B2 T-38 PM Boller View
O Compressor . Publshad Assel Onoe *8h . BRI 738 PR View Accass ©
j N TEnm— —
L o1 intagrater

Add
Data Access @
A Administrators 4 Engineers

4 Plimegrator Service 4 Assat Analytics

Import ard Export

Delete

Femove 3elected View

4. Execute uma das acdes a seguir:
a. Cligue na seta préxima as permissoes e selecione na lista para alterar as permissdes para a identidade.
b. Clique em Adicionar e siga os prompts para dar o acesso especificado da identidade a view.

c. Selecione uma identidade e clique em Remover para remover o acesso da identidade a view.

Gerenciar o acesso a varias views

Vocé pode selecionar diversas views de uma vez e adicionar identidades de Acesso da view a elas.

Nota: N3o é possivel remover identidades de varias views. E possivel somente remover identidades de uma view
de cada vez.

As identidades que sdo adicionadas as views recebem permissdo de Proprietario por padrao.

A excecdo a isso é se uma identidade ja estiver atribuida a uma view. Se a view for uma entre outras views
selecionadas e a mesma identidade for atribuida a ela, ela mantera as permissdes definidas anteriormente. Por
exemplo, a identidade Engenheiros é atribuida a View ABC e é dada a permissdo Leitor a view. Em seguida, a
View ABC é selecionada juntamente com outras views e a identidade Engenheiros é atribuida a todas as views.
Neste caso, a identidade Engenheiros para a View ABC mantém a definicdo das permissGes existentes, ou seja,
Leitor. Todas as outras views recebem a permissao Proprietdrio padrao para a identidade Engenheiros.

Se uma maquina ficar inativa, o Gerenciador de Cluster reatribuira os trabalhos que foram atribuidos a ela as
maquinas de trabalho restantes. A maquina de trabalho offline é automaticamente reiniciada pelo Servico PI
Integrator Framework. Depois de reiniciada, os trabalhos existentes ndao sao reequilibrados para incluir a
maquina de trabalho reiniciada. No entanto, novos trabalhos sdo equilibrados entre todas as maquinas que
estdo funcionando. Se isso resultar em uma distribuicdo ndo equilibrada de trabalhos, vocé podera reequilibrar
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manualmente os trabalhos.

1. Cligue noicone de menu E e cligue em Administragao.
2. Clique na guia Views.

3. Cligue na coluna a esquerda das views que deseja selecionar.

Views Details
Name Run Status Type Run Mode Start Time End Time Last Run Time View Name
B Boller View Publishec Assel Once 8 . 9/8/22 7:38 PM Multiple Views Selected
@ Compressor Publishe Once 8 : 0/B/22 7:39 PM

View Access ©

Data Access @

Multiple Views Selected

Import and Export

Delete

Remove Selected Views

4. Cliqgue em Adicionar identidades as views selecionadas no rétulo Acesso da view.

Nota: se a configuragdo de seguranca de personificacdo estiver ativada, as identidades de acesso a dados
também serdo exibidas.

5. Najanela Adicionar Identidade, selecione as identidades que deseja adicionar e clique em Ok.

Nota: se a configura¢do de seguranca de personificacdo do aplicativo estiver ativada, o Acesso a dados
também sera exibido com uma observacgdo de "Diversas Views Selecionadas" em vez das identidades.

Movendo views entre ambientes

Em alguns navegadores, o protocolo padrao usado é o Web Sockets, que tem um limite de 64 K no tamanho do
pacote de dados. Vocé deve mudar o tipo de transporte para o Servidor Enviou Eventos para acomodar os
maiores pacotes de dados que sdo enviados ao importar e exportar views. Na pagina Minhas Views, clique no

icone da engrenagem H no canto superior direito e alterne Tipo de Transporte para Servidor Enviou Eventos.
O processo deve ser aplicado somente em navegadores Microsoft Edge.

Ao trabalhar no desenvolvimento de suas views, vocé provavelmente as criard em um ambiente de
desenvolvimento e verificara se elas geram os resultados desejados em um ambiente de teste, antes de,
finalmente, mové-las para o sistema de producdo. Use o Pl Integrator for Business Analytics para mover as views
entre esses ambientes, exportando-as de um sistema e importando-as para o outro sistema. As views podem ser
exportadas individualmente ou em massa para um arquivo de configuracdo de views.

O procedimento a seguir supde que vocé esteja exportando views do primeiro sistema e importando-as para o
segundo.
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Clique no icone de menu E e clique em Administragdo.
2. Na pdgina Administracdo, clique na guia Views.

A pagina Views exibe uma lista de todas as views em sua instancia do Pl Integrator for Business Analytics.
3. Selecione as views que deseja exportar e clique em Exportar Views Selecionadas.

Os arquivos sdo exportados para o diretério Downloads. As views Unicas sdo exportadas para um arquivo
com o nome da view, por exemplo, My Asset View.json. Vérias views sdo exportadas para um arquivo
chamado exportViews.json.

4. Mova o arquivo exportado para um local que possa ser acessado do segundo sistema, ou seja, o sistema para
o qual vocé deseja importar as views.

5. No segundo sistema, em PI Integrator for Business Analytics, clique no icone de menu e clique em
Administragao.
Na pagina Administracdo, clique na guia Views.

7. Cligue em Importar Views.
Na janela Abrir, selecione o arquivo exportado e clique em Abrir.

A pagina Importar Views exibe a view. Se vocé importou um arquivo view exportado, as views contidas no
arquivo serdo extraidas.

As exibi¢cGes importadas passardo pela validacdo do nome da view devido a caracteres especiais. Se um
nome da view for considerado invalido, a textbox Nome da view sera destacada em vermelho e vocé ndo
poderd importar essa exibicdo. Para importar essa view, vocé pode executar uma das duas agdes:

¢ Altere o campo ViewnameAllowedSpecialCharacters em C:\ProgramFiles\PIPC\Integrators\BA\CAST. UI.
WindowsService.exe.config para incluir caracteres especiais especificos e, em seguida, reiniciar os
servicos do integrador. Importe novamente as exibi¢cdes para passar na validacao.

¢ Modifique o nome da view diretamente na textbox Nome da View. Se a nova view tiver passado na
validagdo, a textbox Nome da View sera destacada em verde, permitindo que o nome da view passe na
validagdo e importagao. Para obter mais informacgdes, consulte Validagcdo do nome da view.

Import Views
100%
View Name AF Server AF Database Start Time End Time | Publish Target | Matches Autostart
Average Building || OAKPIAF v | & | Facilities-16 v | & *-8h - | Apache Kafl ¥ | & 223 3
[ | Daily Temperature| OAKPIAF v | & [ Facilities16 » | & | *-8h [Apache Kafl v | = 223
Weekly TemperatL | OAKPIAF v acilities-16 v | & ’an ’ Apache Kafl v | & 5223

Cancel Import Selected Views

O Pl Integrator for Business Analytics tentara localizar o Pl AF Server e o banco de dados usado para criar a
view no primeiro sistema. Se ndo for possivel encontrar o servidor ou o banco de dados, esses campos
ficardo em branco.

Nota: ndo é possivel importar uma view usando o destino de publica¢do do PI View, pois ele esta obsoleto.
Selecione outro destino de publicacdo para importar a exibicdo com éxito.
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9. Selecione o PI AF Server, o banco de dados do Pl AF e o destino de publicagdo.

A coluna Correspondéncias informa o niumero de correspondéncias encontradas para o formato com o Pl AF
Server e o banco de dados especificados.

10. (Opcional) Clique no campo Nome da View, Hora de inicio e Hora de término para alterar os valores.

11. (Opcional) Clique em Inicio automatico para iniciar automaticamente a publicagdo da view depois de
importada.

Nota: nao é possivel iniciar automaticamente uma view que nunca foi publicada.

Tenha cuidado ao importar varias views. Depois de importadas, elas comecarao a ser executadas
imediatamente e poderdo sobrecarregar os recursos do computador. Recomendamos definir manualmente a
agenda de publicagdo se vocé estiver importando mais do que algumas views.

12. Selecione as views que deseja importar e clique em Importar views selecionadas.

As views sdo anexadas ao final da lista de views. Depois de importadas, se o Inicio Automatico estiver
habilitado, elas comecardo a ser executadas imediatamente e poderdo sobrecarregar os recursos do
computador. Recomendamos agendar manualmente as views.

13. Retorne o Tipo de Transporte a sua configuracdo original. Na maioria das vezes, esse procedimento é
Automatico.

Revisar registros de log

E possivel revisar os registros de log para qualquer view da guia Logs da pagina Administrac3o.

E possivel filtrar os logs:

¢ Especificando o intervalo de tempo usando os campos Hora de inicio e Hora de término
¢ Selecionando uma view com a lista Nome da View

¢ Especificando o tipo de erro (Depurar, Informacées, Aviso, Erro)

E possivel copiar os logs exibidos para a area de transferéncia e fazer download deles para um arquivo.

Configurar escopos de log

Um escopo de log define um conjunto de parametros configurdveis que controlam o comportamento de log. Ele
da suporte a configuracdo de niveis de log, ajuste de verbosidade e limitagdo do comprimento da mensagem.

Ha trés tipos de escopos de log:

¢ Padrio: a configuracdo de log é aplicada a todos os logs
¢ NameSpace: a configuracdo de log é aplicada ao namespace especificado

¢ View: a configuracdo de log é aplicada a view selecionada

Nota: é altamente recomenddvel consultar a equipe de suporte técnico antes de configurar os escopos de
log. Configuragdes incorretas podem levar a perda de dados de log importantes ou registro excessivo, o que
pode afetar o desempenho do sistema e consumir espago em disco.

Para definir escopos de log para personalizar e filtrar o comportamento de log na guia Logs da pagina
Administragao:
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1. Cligque no botdo Configuragdao do Escopo de Log no painel esquerdo.
2. Navegue até o painel Configuracao.
3. Clique em Adicionar Escopo de Log.

e Se voceé estiver criando um escopo de log do tipo NameSpace, digite NameSpace para aplicar a
configuracao.

¢ Se vocé estiver criando um escopo de log do tipo View, selecione a View desejada na lista suspensa.
Para remover escopos de log da guia Logs da pagina Administragao:

1. Selecione o escopo de log listado em Escopos de Log.
2. Selecione Remover Escopo de Log.

¢ 0 escopo de log Todos (Padrdo) ndo pode ser removido.

Consulte a tabela a seguir para configurar um escopo de log com os seguintes parametros:

Parametro Descricdo

Nivel Informacdes, Aviso, Depuragdo ou Erro. O nivel padrao
é definido como Informacdes.

Detalhamento Baixo: registrar em log a mensagem de excecdo de
nivel superior

Agregado: registrar em log o nivel superior e todas as
mensagens de excecao aninhadas

Trago: registrar a exce¢do de nivel superior e o traco

Completo: registrar em log o nivel superior e todas as
mensagens de exceg¢ao aninhadas e tragos de até 10
niveis de profundidade. O padrao é Baixo.

Comprimento da mensagem Limita o tamanho da mensagem. Deve ser superior a
100. O padrao é ilimitado.

Definir as politicas de retencao de registro

Cada vez que uma view é publicada, os dados de log e de estatisticas sdo coletados e armazenados nos seguintes
bancos de dados:

¢ Os dados de log sdao armazenados no banco de dados SQL PlintegratorLogs.

Nota: Se vocé estiver consultando diretamente o banco de dados, os timestamps estardo no formato GMT.

¢ Os dados de estatisticas sdo armazenados no banco de dados SQL PlintegratorStats.

Com o passar do tempo, esses registros podem ocupar muito espac¢o no servidor e, portanto, o Pl Integrator for
Business Analytics exclui periodicamente os registros de log e de estatisticas. As configuracGes para as tarefas sdo
definidas no arquivo %PIHOME64%\Integrators\BA\CAST.Ul.WindowsService.exe.config.

O arquivo de configuragdo tem as seguintes se¢des separadas para configurar as politicas para registros de log e
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¢ Secdo <maintenanceTasks> , que determina quando os registros sdo excluidos. Ha duas tarefas,
logRetentionPolicies e statRetentionPolicies.

e SecOes <logRetentionPolicies> e <statsRetentionPolicies>, que determinam quais registros sdo excluidos

Politica de retencao de log

Para obter informacdes gerais sobre politicas de retencdo de registros, consulte Definir as politicas de retencao

de registro.

A tarefa logRetentionPolicies na secdo Tarefas de manutencdo do arquivo de configuracdo de aplicativo
determina quando os registros de log sdo excluidos. Por padrao, os registros de log sdo excluidos a cada 24 horas

as 7h.

A tabela a seguir descreve os parametros das tarefas.

Parametros da tarefa logRetentionPolicies

Parametros

Descri¢cdo do parametro

Valor padrdo

taskName

Nome da tarefa de retencdo dos
registros de log. Nao altere este
valor.

add
taskName="logRetentionPolicies'

!

runFrequency

Frequéncia com que a tarefa
logRetentionPolicies é executada.
Use o tempo do Pl para especificar
unidades de tempo. runFrequency
e timeOfDay juntos determinam
qguando a tarefa é concluida.

runFrequency="24hours"

timeOfDay

Tempo em que a tarefa
logRetentionPolicies é executada.
Use o tempo do Pl para especificar
unidades de tempo. runFrequency
e timeOfDay juntos determinam
guando a tarefa é concluida.

timeOfDay="7:00"

Politica de retencao de log

A politica na sec¢do logRetentionPolicies determina quais registros de log sdo excluidos. Os registros mais antigos

sao excluidos primeiro.

Nota: se a politica for excluida, os registros de log serdo mantidos indefinidamente.

E possivel excluir os registros de log com base em qualquer combinacio do seguinte:

¢ Aidade dos registros

¢ O numero de registros

¢ O tamanho total de todos os registros
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A politica padrao exclui registros de log mais antigos que 2 meses, mantém o niumero de registros em 100.000 ou
menos e mantém o tamanho maximo dos registros de log em 1.000 MB ou menos.

Nota: toda vez que a exclusdo agendada remove com sucesso qualquer nimero de registros, a politica também
executara uma operacao de reducdo automatica no banco de dados para reduzir seu tamanho.

Parametros da politica logRetentionPolicies

Parametro

Descri¢cdo do parametro

Valor padrao

uniquePolicyName

Nome da politica.

uniquePolicyName="LogsPolicy1"

maximumTableRecordAge

Idade maxima dos registros de log
especificada em meses. Usado com
maximumTableRowCount e
maximumTableSizeOnDisk para
determinar quais registros de log
sdo excluidos.

maximumTableRecordAge="2mont
hs n

maximumTableRowCount

Numero maximo de linhas dos
dados de log. Usado com
maximumTableRecordAge e
maximumTableSizeOnDisk para
determinar quais registros de log
sdo excluidos.

maximumTableRowCount="100000

n

maximumTableSizeOnDisk

Tamanho maximo de todos os
registros de log, especificado em
megabytes (MB). Usado com
maximumTableRecordAge e
maximumTableRowCount para
determinar quais registros de log
sdo excluidos.

maximumTableSizeOnDisk="1000"

Politica de retencao de estatisticas

Tarefa da politica de retencao de estatisticas

As estatisticas para cada view sdo armazenadas como uma tabela separada no banco de dados SQL
PlintegratorStats. O nome da tabela é o ID da view.

A tarefa statRetentionPolicies na secao maintenanceTasks do arquivo de configuracao de aplicativo determina
qguando os registros de estatisticas sdo excluidos. A tabela a seguir descreve os parametros da tarefa

statRetentionPolicies.

Parametros da tarefa statRetentionPolicies

Parametro

Descricdao do parametro

Valor padrao

taskName

Identifica o nome da tarefa de
retencdo de estatisticas. Nao altere

taskName="statRetentionPolicies"
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Parametro Descri¢ao do parametro Valor padrao
este valor.
runFrequency Frequéncia com que a tarefa runFrequency="24hours"

statRetentionPolicies é executada.
Use o tempo do Pl para especificar
unidades de tempo. runfrequency
e timeOfDay juntos determinam
guando a tarefa é executada.

timeOfDay Tempo em que a tarefa timeOfDay="7:00"
statRetentionPolicies é executada.
Use o tempo do Pl para especificar
unidades de tempo. runFrequency
e timeOfDay juntos determinam
guando a tarefa é executada.

Por padrdo, os registros de estatisticas sdo excluidos a cada 24 horas apds a inicializagao.

Politicas de retencao de estatisticas

As politicas na secdo statRetentionPolicies determinam quais registros de estatisticas sdo excluidos. As politicas
de retencdo de estatisticas supdem que as views sejam publicadas em intervalos agendados e a frequéncia de
publicacdo determina quais registros sao excluidos. Geralmente, quanto maior a frequéncia com que uma view é
publicada, mais estatisticas sdo geradas e vocé deseja excluir registros mais frequentemente. Isso é verdadeiro
para as views de ativo, views de evento e views de transmissdo agendada.

As views de streaming que sdo publicadas em resposta as altera¢des dos valores principais ndo sao publicadas
em intervalos regulares. Portanto, para gerenciar efetivamente a quantidade de dados estatisticos no banco de
dados, o Pl Integrator for Business Analytics supde que a streaming de dados para essas views ocorra com a
maior frequéncia possivel, ou seja, em intervalos de 30 segundos. Portanto, a politica que inclui a frequéncia de
publicacdo de 30 segundos é aplicada a todas as views de streaming enviadas pelo valor principal.

Nota: as estatisticas para views que sdo publicadas somente uma vez sdo mantidas indefinidamente até que a
view seja removida.

As politicas a seguir sdo definidas por padrao:

e StatsPolicyl — define uma politica para views publicadas com uma frequéncia entre 1 segundo e 5 minutos

e StatsPolicy2 — define uma politica para views publicadas com uma frequéncia entre mais de 5 minutos e até
1 hora

e StatsPolicy3 — define uma politica para views publicadas com uma frequéncia de mais de 1 hora

E possivel editar as politicas padrdo ou criar politicas adicionais e especificar o nivel de granularidade necessario.
Verifique se suas politicas abrangem todos os intervalos de tempo possiveis. Se um intervalo de tempo nao
estiver incluido, os registros de estatisticas para views publicadas no intervalo que esta faltando serdo mantidos
indefinidamente.

Para cada politica, é possivel excluir os registros para uma view com base em qualquer combinacdo do seguinte:

¢ Aidade dos registros na tabela
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e (O tamanho total da tabela
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O seguinte descreve os parametros da politica statRetentionPolicies e lista os valores padrdo para uma das

politicas, StatsPolicyl.

Parametros da politica statRetentionPolicies

Parametro

Descri¢dao do parametro

Valores padrao para StatsPolicyl

uniquePolicyName

Nome da politica. Os nomes de
politicas devem ser exclusivos. Se
houver varias politicas com o
mesmo nome, o arquivo de
configuracdo nao sera executado e
ocorrera um erro.

uniquePolicyName="StatsPolicy1"

filterMinimumRunFrequency

O limite inferior da frequéncia da
publicacdo de view. Usado com
filterMaximumRunFrequency para
determinar a quais views esta
politica se aplica.

filterMinimumRunFrequency="1sec
ond"

filterMaximumRunFrequency

O limite superior da frequéncia da
publicacdo de view. Usado com
filterMinimumRunFrequency para
determinar a quais views esta
politica se aplica.

filterMaximumRunFrequency="5mi
nutes"

maximumTableRecordAge

A idade dos registros mais antigos
gue sao mantidos. Usado com
maximumTableRowCount e
maximumTableSizeOnDisk para
especificar os registros que sdo
excluidos.

maximumTableRecordAge="24hrs"

maximumTableRowCount

O nimero maximo de linhas
mantidas na tabela. Se o numero
de linhas exceder este numero, os
registros mais antigos serao
excluidos primeiro. Usado com
maximumTableRecordAge e
maximumTableSizeOnDisk para
especificar os registros que sao
excluidos.

maximumTableRowCount="100000

n

maximumTableSizeOnDisk

O tamanho maximo da tabela em
megabytes (MB). Os registros mais
antigos sdo excluidos primeiro.
Usado com
maximumTableRecordAgemaximu

maximumTableSizeOnDisk="200"
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Parametro Descri¢ao do parametro Valores padrao para StatsPolicyl

mTableRecordAge e
maximumTableRowCount para
especificar os registros que sao
excluidos.

O seguinte descreve a StatsPolicyl com seus valores padrao. A politica StatsPolicyl se aplica as views que sao
publicadas com uma frequéncia de 1 segundo até 5 minutos. Para cada view, registros de estatisticas até 24
horas sdo mantidos, o nimero de linhas na tabela da view ndo excede 100.000 e o tamanho total da tabela ndo
excede 200 MB. Os registros que nao atenderem a todas as trés condi¢cdes serdo excluidos. Com todas as
politicas de retengdo, os registros mais antigos sao excluidos primeiro.

Nota: toda vez que a exclusdo agendada remove com sucesso qualquer nimero de registros, a politica também
executara uma operacao de reducdo automatica no banco de dados para reduzir seu tamanho.

Licenciamento e streams de saida

A guia Licenciamento na pdagina Administragdo apresenta informagdes sobre o nimero de streams de saida
utilizados e quais views utilizam os streams de saida.

Um stream de saida é uma tag do Pl (ponto de dados) que é publicada para um destino ou somente referenciada
em uma view. A stream de saida Unico é uma tag Pl distinta publicada em uma ou mais views.

Seu contrato de pacote e licenciamento de software especifico determina o nimero maximo de streams Unicos
gue vocé pode ter por vez.

Por exemplo, presuma que o Pl Integrator esteja configurado com trés views: ProcLab1, TestPrd e Fieldoutput. O
ProcLabl usa 20 streams de saida (15 streams de saida Unicos e 5 streams de saida ndo Unicos), o TestPrd usa
dois streams de saida Unicos e o Fieldoutput usa 22 streams de saida (2 streams de saida Unicos e 20 streams de
saida ndo Unicos). A lista streams de saida por view exibe as trés views com o total de streams de saida
utilizados em cada view. Os seguintes totais sdo exibidos:

e Streams de saida Unicos Consumidos exibe 19 streams de saida.

* A opgdo Streams de Saida Restantes exibe o saldo das streams de saida disponiveis. O total de streams
disponiveis depende do maximo permitido em sua licenca.

Aumentar os streams de saida disponiveis

Se o numero de streams de saida ndo for suficiente para atender as suas necessidades, vocé podera fazer uma
atualizacdo para uma versdao com um nimero maximo mais alto. Para obter mais informacg&es sobre as
contagens maximas de streams de saida disponiveis, fale com seu gerente de contas da AVEVA.

Recuperando streams de saida

Recuperar streams de saida Unicos de views excluidas libera o nimero de streams de saida exclusivos disponiveis
para novas views. E importante entender que remover uma view da pagina Minhas Views n3o altera
imediatamente o nimero de streams de saida Unicos contados em relagao ao seu limite de licenciamento.
Streams de saida Unicos ndo sdo recuperados imediatamente quando uma view é removida ou excluida; eles sdo
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recuperados apds 7 dias desde a ultima publicagdo dos dados da tag do PI.

O stream de saida é recuperado automaticamente por um servico interno. A primeira recuperag¢do ocorre na
inicializacdo do aplicativo Pl Integrator, e o servico é executado uma vez a cada 24 horas depois disso. Portanto,
nado é mais necessario clicar manualmente no botdo Recuperar Todos os Fluxos porque os streams elegiveis sdo
recuperados automaticamente uma vez por dia.

Alterar a conta de servico do Windows

Vocé pode alterar a conta de servigco que executa o Pl Integrator for Business Analytics. Vocé pode especificar
uma conta de servico do Windows ou uma conta de servico gerenciado de grupo (gMSA) ou contas virtuais do
Windows. Se vocé estiver mudando de ou para uma conta gMSA ou contas virtuais, esteja ciente do seguinte:

Se vocé estiver mudando de uma conta de servi¢co do Windows com autenticagao SQL para uma conta gMSA
ou contas virtuais, a conta gMSA ou as contas virtuais devem usar a autenticacao do Windows para
autenticar com o servidor do SQL de back-end que hospeda o Pl Integrator for Business Analytics. Ela ndo
pode ser configurada para usar autenticacdo SQL.

Se vocé estiver mudando de uma conta gMSA ou contas virtuais, ou mudando para uma conta gMSA ou
contas virtuais, depois que a conta for alterada, sera necessario reinserir as credenciais para cada destino de
publicagdo.

Verifique se a conta de usudrio que fez login ou a conta de usudrio que estd executando o utilitario Alterar a
Conta de Servigo tem as seguintes permissées:

Privilégios de Administrador Local no Microsoft Windows Server onde o PI Integrator for Business Analytics
estd instalado

Privilégios de Administrador no Pl AF Server onde o banco de dados de Configuragdo do PI Integrator for
Business Analytics estd instalado

Nota: o Pl AF Server é identificado no arquivo %PIHOMEG4%\Integrators\BA\CAST.Ul.WindowsService.exe
na se¢do <appSettings> com a chave InstancePath.

As seguintes permissdes também sdo necessarias para a conta de usuario que fez login ou a conta de usudrio
gue estd executando o utilitario Alterar a Conta de Servico:

A permissdao ALTER ANY LOGIN no SQL Server

a associacdo da func¢do do banco de dados db_owner para os bancos de dados PlintegratorDB,
PlintegratorLogs e PlintegratorStats

Nota: a Unica excecdo é se estiver usando a autenticacdo SQL e ndo quiser mudar a conta SQL, entdo estas
permissdes adicionais ndo sao exigidas.

Se o usuario que esta instalando ndo tem as permissoes exigidas nos bancos de dados SQL, entdo um usuario
com privilégios sysadmin deve, primeiro, rodar o arquivo Go.Bat, que pode ser encontrado em
%PIHOME64%\Integrators\BA\SQL.

Se vocé estiver usando a autenticacdo SQL e ndo quiser mudar a conta SQL, entdo vocé ndo precisa rodar
estes arquivos.

A nova conta de servico do Windows que executara o servico do Pl Integrator Framework deve receber
direitos de "Login como um servi¢o" na maquina em que o Pl Integrator for Business Analytics esta instalado.
Um usudrio com privilégios de administrador pode atribuir esse direito ao servigo. O procedimento para
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fazer essa atribuicdo varia de acordo com o sistema operacional do computador e a versao do software.

¢ A nova conta de servico do Windows também precisa ter perfil local. Faca login usando a nova conta de
servico para criar um perfil no Microsoft Windows Server em que o Pl Integrator for Business Analytics estd
instalado.

Assim terminar o processo, continue com o seguinte procedimento.

¢ Se vocé estiver mudando de uma conta de servigo do Windows com autenticagdo SQL para uma conta gMSA
ou contas virtuais, a conta gMSA ou as contas virtuais devem usar a autenticagcao do Windows para
autenticar com o servidor do SQL de back-end que hospeda o PI Integrator for Business Analytics. Ela ndo
pode ser configurada para usar autenticagao SQL.

¢ Se vocé estiver mudando de uma conta gMSA ou contas virtuais, ou mudando para uma conta gMSA ou
contas virtuais, depois que a conta for alterada, sera necessario reinserir as credenciais para cada destino de
publicacdo.

1. No diretério %PIHOME64%\Integrators\BA, execute o arquivo ChangelntegratorServiceAccount.exe como
Administrador.

2. Siga os prompts e forneca a senha para a conta que esta executando o servi¢o do Pl Integrator Framework.

Nota: vocé deve, primeiramente, fornecer a senha para a conta de servi¢o que estd executando atualmente
o servico do Pl Integrator Framework antes que vocé possa mudar a conta de servico.

Se a conta for uma conta gMSA ou contas virtuais, ndo forneca uma senha e pule esta etapa.

3. Siga os prompts e fornega a conta de servigo e a senha para a hova conta de servigo que executara os
servicos Pl Integrator for Business Analytics.

O utilitdrio Alterar a Conta de Servico adiciona a nova conta e suas permissdes ao Pl AF e ao SQL Server.

Nota: se a nova conta de servigo for uma conta gMSA, forneca o nome da conta de servigo e ndo forneca
uma senha. As contas virtuais ndo precisam da senha ou do nome da conta de servigo.

4. Pressione Enter para sair do utilitario.

Se vocé estiver mudando de ou para uma conta gMSA ou contas virtuais, sera necessdrio inserir novamente as
credenciais para cada um dos seus destinos de publica¢do.

Alterar a porta do Integrador Pl

Ao alterar a porta do Integrador PI, quaisquer usudarios conectados no aplicativo da web PI Integrator for
Business Analytics precisardo inserir novamente a URL com a nova porta. Quaisquer views que estiverem
rodando no momento em que a porta for alterada serdo concluidas com éxito.

No Painel de Controle da Microsoft, navegue até Programas e Recursos.

2. Clique com o botdo direito do mouse em PI Integrator for Business Analytics na lista e clique em Alterar no
menu.

A janela Instalacdo do Pl Integrator for Business Analytics 2020 é aberta.
Clique em Modificar e em Préximo.

4. Na janela Informacgées de Logon, insira o nome de usuario e a senha da conta de servico do Windows que
executa o Servigo Pl Integrator Framework. Clique em Préximo.
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5. Na janela Configuracgdo de Porta e de Certificado TLS, insira um nimero de porta diferente e clique em
Validar Porta para verificar a disponibilidade da porta.

6. Cliqgue em Préximo.
7. Na janela Pronto para Modificar o Aplicativo, clique em Instalar.

Quando a instalag¢do for concluida, o aplicativo usard a nova porta.

Alterar a configuracao de certificado TLS

1. No Painel de Controle da Microsoft, navegue até Programas e Recursos.

2. Clique com o botdo direito do mouse em PI Integrator for Business Analytics na lista e clique em Alterar no
menu.

A janela Instalagao do Pl Integrator for Business Analytics é aberta.
Clique em Modificar e em Préximo.

4. Na janela Informagdes de Logon, insira o nome de usudrio e a senha da conta de servigo do Windows que
executa o Servigo Pl Integrator Framework. Clique em Préximo.

5. Najanela Configuracao de Porta e de Certificado TLS, escolha um certificado TLS de uma das seguintes
origens:

¢ Certificado autoassinado gerado durante a instalagao — este é o padrdo. Escolha Certificado
autoassinado.

Nota: Caso vocé escolha essa opgdo, o inicio de sessdo de usudrios por maquinas remotas podera exibir
uma mensagem de alerta de seguranca. Para evitar esse aviso para certificados autoassinados, o
certificado deve ser explicitamente de confianca na maquina do cliente. Consulte a solucdo alternativa
no artigo Certificate error returned when navigating to a Pl Vision or Pl Web API web site using a self-
signed certificate da base de conhecimento.

¢ (Recomendado) Certificado TLS de uma autoridade de certificacdo — escolha Importar certificado e
cligue em Selecionar certificado para escolher um certificado que foi emitido por uma autoridade de
certificacdo e importado para a maquina em que o Pl Integrator for Business Analytics estd sendo
instalado.

6. Clique em Préximo.
7. Na janela Pronto para Modificar o Aplicativo, clique em Instalar.

Quando a instalac¢do for concluida, o aplicativo usara o novo certificado TLS.
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Tipos de dados nao suportados

Int16

O Pl Integrator for Business Analytics ndo suporta o tipo de dados do Int16 nas seguintes situacdes:

¢ Os dados gravados em destinos do AWS S3 ou Azure Data Lake Gen 2 usando o formato Parquet ndo podem
ser publicados como dados Int16.

¢ Dados serializados do Avro publicados em qualquer destino de streaming nao podem ser publicados como
dados do Int16.

Nestas situacdes, o Pl Integrator for Business Analytics converte automaticamente os dados do Int16 em tipo de
dados do Integer.
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Iniciar o Pl Integrator for Business Analytics

1. Abra um navegador da Web.
2. Insira o URL do aplicativo Pl Integrator for Business Analytics.

O URL aponta para a mdquina host e a porta do Pl Integrator for Business Analytics. O URL é
https://hostname:port number ou FQDN:port number, em que FQDN é o nome do dominio totalmente
gualificado. Se vocé usar a porta 443, sera possivel omitir este nimero da porta ao especificar o URL. Se vocé
instalou o Pl Integrator for Business Analytics em um host lab5 no dominio prod.onet.com e o configurou
para usar a porta 7777, vocé pode inserir um dos seguintes: https//lab5.prod.onet.com:7777,
https://lab5:7777.

Nota: se vocé nao tiver certeza de qual porta foi especificada durante a instalagao do Pl Integrator for
Business Analytics, navegue até a maquina em que o Pl Integrator for Business Analytics foi instalado. Abra o
arquivo %PIHOME64%\Integrators\BA\CAST.UI.SelfHost.exe.config e localize o valor da chave
"SelfHostPort". Verifiqgue o URL com o administrador do sistema PI Integrator for Business Analytics.

O aplicativo abre na pagina Minhas Views.

3. Clique no icone de menu E para abrir o menu PI Integrator for Business Analytics.

O menu a seguir se abre:
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Pl Integrator for
Business Analytics
Advanced Edition

™ My Views

Manage your data views

% Create Asset View

Build a data view starting with
your asset hierarchy

% Create Event View

Build a data view starting with
your event frame hierarchy

% Create Streaming View

Build a streaming view with a
custom output shape

/ Administration

Manage servers, users, and
targets

E possivel abrir esse menu de qualquer lugar no aplicativo e fazer o seguinte:

Navegue até a pagina Minhas Views. Para obter mais informacdes sobre a pagina Minhas Views, consulte
a A pdgina Minhas Views

Criar uma view de ativos — para obter mais informacdes sobre a criacdo de views de ativos, consulte Criar
uma view com ativos.

Criar uma view de evento — para obter mais informagdes sobre views de evento, consulte Criar uma view
para eventos.

Criar uma view de streaming — para obter mais informacgdes sobre a criacdo de views de streaming,
consulte Criar uma view de streaming. Este recurso esta disponivel com a edi¢cdo Advanced do PI
Integrator for Business Analytics.

Navegue até a pagina Administracdo — para obter mais informacgdes sobre as tarefas que vocé pode
executar nesta pagina, consulte Tarefas administrativas.
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A pagina Minhas Views

Quando vocé insere a URL para o Pl Integrator for Business Analytics, o aplicativo abre a pagina Minhas Views.
Nessa pagina, vocé cria e edita views de ativo, views de evento e views de streaming. Essa pagina também exibe
a lista de views que vocé acessou. A captura de tela e a tabela abaixo descrevem as informacdes disponiveis
sobre sua view e como usar essa pagina.

m

Create Asset View @ + Create Event View @ + Create Streaming wwe [ Modify View @ % Remove View @ ‘ @
Name Run Status Type Run Moge A& Start Time =7 @' Last Run Time
Average Building Temperature :Iezruvg Streaming Out duled Stream & B Column A Apr 1 10°:27-38 P
Buil g 16% Assel il Autosize This Column Apr 15, 44 PM
Building HVAC Streaming Streaming Out led Stream Autosize ARl Columns 5, 2018 10:27-00 PM
Daily Temperature Fublished Asset 8 Sort Ascending Apr 15, 2018 3:36:31 PM
Floor One Temperature Scheduled Asset o Continuous &h Sort Descending Apr 15, 2018 10:27-35 PM
Floor Three Published Asset LFY once 8N Remove Sort Apr 15, 2018 3°55:53 PM
Floor Three AVAC Scheduled Asset Continuous 8h Columns. Apr 15, 2018 10:27-28 PM
Floor Two Temperature Pubisning34% LR COMINUCUS ~8n . Apr 15, 2018 10:27-33 PM
Weekly Temperature Stopped By User Asset Continuous ~8h ¥ Apr 15, 2018 10:26.55 PM
(8) 2
2 - ]
Overview Log Security View Cenfiguration Statistics
Run Status Publishing 16% Publish Actions Search Shape
S— Asset Shape
View Name Building AVAT P
4 @ vavee
Pl AF Database Facilities-1600 Alvarado “ # % cooling
Publish Target SOL Server # % heating
) . ore air signal (cooling)
& air signal (heating)
Run Mode Continuous
Run Frequeney 1 Minutes

Last Run Time

Apr 15, 2018 10:27:44 PM

Numero Description

1 Todas as visualizacdes a que vocé tem acesso estdo
listadas na tabela. S6 é possivel editar views para as
guais vocé tem permissdes de acesso de gravagao.
Vocé pode fazer uma copia de uma view para as quais
vocé tem permissdes de acesso de leitura e, em
seguida, editar a cépia.

2 Use Criar View com Ativos para criar uma view com
ativos. Para mais informacdes, consulte Criar uma
view com ativos.

3 Use Criar View Para Eventos para criar uma view para
eventos. Para obter mais informacgdes, consulte Criar
uma view para eventos.

4 Use Criar view de Streaming para criar uma view de
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streaming. Para obter mais informacdes, consulte
Criar uma view de streaming. Este recurso esta
disponivel com a edicdo Advanced do Pl Integrator for
Business Analytics.

Para modificar uma view, selecione uma view na
tabela e clique em Modificar View.

Para excluir uma view, selecione a view na tabela e
cligue em Apagar View. A exclusdo de uma view
remove seu nome da lista de nomes de views
reservadas. Note, excluir uma view nao libera os
streams de saida disponiveis permitidos com sua
licenga até 7 dias terem transcorrido.

Para obter mais informacdes, consulte Recuperando
streams de saida.

Clique nas barras para abrir e fechar o painel de
detalhes com as guias Visao geral, Log, Seguranga,
Configuracio da view e Estatisticas.

Para a view selecionada, as guias Visao geral, Log,
Seguranga, Configuragdo da view e Estatisticas
fornecem os seguintes detalhes sobre essa view:

¢ Visdo Geral indica se a view foi publicada. Essa
guia também resume informagdes sobre a view,
tais como banco de dados do Pl AF utilizado, a
Ultima vez em que a view foi executada e o
formato utilizado pela mesma. Se a view estiver
sendo publicada, a barra de status da execucdo
indicara o progresso e vocé tera a opgao de
interromper o processo de publicacdo.

¢ Log exibe informacGes para a view selecionada.
Vocé pode ajustar as horas de inicio e término e
pode filtrar as mensagens para exibir aquelas de
uma determinada gravidade, por exemplo, erros
criticos.

Nota: para proteger o uso de recursos, os
downloads de logs sao limitados a um maximo de
100 mil linhas, independentemente dos tempos
inicial e final do intervalo de recuperacao de log.
Se vocé precisar de toda a tabela de logs, é
possivel recupera-la do banco de dados SQL.

e Seguranga mostra quem tem acesso a view e, caso
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vocé tenha privilégios suficientes, permitira que
vocé faca alteragdes no nivel de acesso.

¢ Configuragao da view da a vocé uma rdpida visdo
geral de suas views, incluindo os elementos e
atributos na view, detalhes sobre os elementos e
atributos e todos os filtros para linhas.

o Estatisticas exibe estatisticas para a view
selecionada. Para obter mais informacdes,
consulte Visualizar dados de estatisticas.

Coloque o cursor do mouse no cabecalho da coluna

para ativar o icone de menu = e clique nele para
abrir o menu. Neste menu, é possivel redimensionar
as colunas, classificar os dados na coluna e adicionar
ou excluir colunas da tabela.

10

O icone de contador de mensagens vermelho no canto
superior direito exibe o nimero de mensagens de
aviso e de erro registradas pelo Pl Integrator for
Business Analytics. Clique no icone para abrir a lista de
mensagens. Clique nos comandos na parte superior da
lista de mensagens. Suprimir Alertas/Remover
Supressao de Alertas desativa e ativa alertas.
Desativar Agregacao/Ativar Agregacdo controla como
multiplas ocorréncias de uma mensagem sdo
relatadas. Agregacao desativada relata cada
ocorréncia de uma mensagem. Agregacao ativada
exibe a mensagem uma vez e relata o nimero de
ocorréncias. Limpar tudo apaga todas as mensagens
da lista.

ress Alerts Aggregation: Off Clear a

A critical error has occurred, see th

(]
x

vent log for further details.
2272015, 15124 PM Details
[

11

Clique no icone de engrenagem H no canto
superior direito para ver a versao do Pl Integrator for
Business Analytics e do servidor do Pl AF e para alterar
as configuragdes de idioma e localidade.
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Como usar o Pl Integrator for Business
Analytics

O PI Integrator for Business Analytics oferece uma interface de usuario Web facil de usar. Os principais recursos
incluem Criar uma view com ativos, Criar uma view para eventos e Criar uma view de streaming e Modificar uma
view, Copiar uma view e Proteger suas views.

Views do Pl Integrator for Business Analytics

Uma view é uma descricdo modelada dos dados do Pl System que vocé deseja analisar. Ha vérios tipos de views:
views de ativo, views de evento e views de streaming. A pergunta que vocé esta abordando determinara qual
tipo de view é mais adequado para abordar o seu caso de uso. A seguir € mostrado um exemplo de como vocé
pode usar cada tipo de view para responder a diferentes perguntas sobre sua organizacao.

¢ As views de ativos organizam os dados em torno dos seus ativos e permitem que vocé faca comparacoes
entre os ativos.

Por exemplo, digamos que vocé queira analisar um conjunto de turbinas edlicas por poténcia em megawatt e
ver os resultados por modelo e fabricante de turbina. Vocé poderia criar uma view de ativo com base em um
template de elemento de turbina com atributos de poténcia em megawatt, modelo e fabricante. Isso
permitiria que vocé comparasse o desempenho entre sua frota de turbinas edlicas.

¢ As views de eventos organizam dados em torno de event frames e permitem que vocé detecte padrées nos
event frames.

Nota: O Pl Integrator for Business Analytics retorna somente estruturas de evento fechadas (com uma hora
de inicio e de término vdélida). Ele ndo pode publicar dados abertos de event frame.

Usando o mesmo exemplo acima, digamos que vocé agora queira analisar o tempo de inatividade das
turbinas edlicas. Vocé poderia criar uma view de evento que comparasse a duracdo dos tempos de
inatividade e incluissem os atributos de modelo e fabricante para determinar a presenca de um padrdo para
os event frames de tempo de inatividade.

¢ Asviews de streaming organizam dados perto de seus ativos e permitem que vocé disponibilize esses dados
em tempo quase real para andlise preditiva.

Continuando o exemplo acima, suponha que vocé queira calcular a saida de energia de cada turbina edlica
para a proxima hora com base nos dados atuais. Vocé pode criar uma view de streaming que inclua a
velocidade do vento, a densidade do ar e a saida em megawatt da turbina atual e usar esses dados para
preparar um modelo de analise prevendo a saida de energia com base nessas entradas.

O que é um formato?

As views sdo construidas com o uso de um formato, um padrdo para pesquisar dados dentro do PI System. A
definicdo do formato fornece as seguintes informacdes cruciais para criar a view:
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¢ que dados incluir

e como os dados sdo estruturados na view

Os formatos fornecem a capacidade Unica de pesquisar relacionamentos entre os elementos e atributos, bem
como os elementos e os atributos em si. Com o Pl Integrator for Business Analytics é possivel definir pais, filhos e
seu relacionamento como parte do formato, bem como os pardmetros de pesquisa de modelo, o nome e a
categoria mais tradicionais. Vocé também pode estender o formato para encontrar correspondéncias para ativos
ou event frames derivados do mesmo modelo.

Cada formato corresponde a uma respectiva view:

e (Os formatos de ativo contém os ativos, os atributos e seus relacionamentos nas views do ativo.

¢ Formatos de streaming e de ativo sdo criados da mesma maneira. As views diferem no Designer de
mensagem: as views de ativo sdo apresentadas em um formato de tabela e as views de streaming sao
apresentadas em um formato de pares de atributo-valor.

¢ Os formatos de evento contém event frames, atributos de event frame, elementos referenciados e atributos
de elemento referenciado em views de eventos.

Visao geral de como usar Pl Integrator for Business Analytics

Esse esbogo descreve como usar Pl Integrator for Business Analytics para produzir dados de decisdao imediata
para sua ferramenta BI.

Dica: se vocé estiver usando o Pl Integrator for Business Analytics pela primeira vez, recomendamos comecar
explorando como criar uma view de ativos e, depois, prosseguir para a criacdo de views de streaming ou de
eventos.

1. Selecione os dados do Pl System que deseja incluir em sua andlise.

Determine se sua analise requer uma view de ativo, uma view de evento ou uma view de streaming. Caso
vocé deseje analisar seus dados divididos em ativos, crie uma view com ativos. Caso vocé deseje analisar
seus dados divididos em estruturas de evento, crie uma view para eventos. Se vocé quiser analisar seus
dados divididos pelos ativos e precisar de valores transmitidos para analise em tempo real ou alguma outra
analise, crie uma view de streaming.

¢ View de ativo — comece criando um formato simples, por exemplo, para encontrar um uUnico ativo. O
painel Correspondéncias é uma pré-visualizacdo dos elementos que sdo encontrados no banco de dados
do PI AF que correspondem a seu formato.

¢ View de evento — comece criando um formato de evento simples, por exemplo, para focar em um unico
event frame e um elemento referenciado pelo event frame. Adicione atributos de elemento que possam
fornecer mais contexto para os dados de evento ao formato do ativo. O painel Correspondéncias
mantém o controle dos ativos, atributos e estruturas de eventos que correspondem ao formato.

¢ View de streaming — comece criando um formato simples, por exemplo, para encontrar um Unico ativo.
O painel Correspondéncias é uma pré-visualizacdo dos elementos que sdo encontrados no banco de
dados do Pl AF que correspondem a seu formato.

2. Pré-visualizacdo de seu conjunto de dados.

A pré-visualizacdo mostra um subconjunto das informacgdes. O subconjunto é construido a partir das
primeiras dez correspondéncias e usa os 100 primeiros registros para cada correspondéncia. Portanto, vocé
pode ndo ver todos os dados que espera ver. A finalidade da pré-visualizacdo é fornecer a vocé uma ideia de
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qual é a aparéncia dos dados, de modo que vocé possa determinar quais os dados adicionais que deseja
incluir para fornecer contexto ou como excluir linhas e focar nos dados que vocé tem interesse.

3. (Somente views de streaming) Especifique o esquema usado para enviar as mensagens e como a mensagem
€ enviada.

4. Refinar seu conjunto de dados.

Ha vdrias possibilidades de como o conjunto de dados final pode ser manipulado para produzir os resultados
desejados. E possivel fazer o seguinte:

¢ Modificar como as colunas de dados/campos de dados sdo exibidos
¢ Adicionar colunas de dados/campos de dados

¢ Adicionar colunas de tempo/campos de tempo

¢ Adicionar calculos em uma coluna ou campo

¢ Filtrar os dados para incluir apenas os dados de interesse

¢ Especificar como os dados s3o recuperados (valores totalizados, interpolados ou exatos)

Nota: as colunas se aplicam a views de ativos e de eventos e os campos se aplicam a views de streaming.

5. Publique os dados em um destino de publicacgao.
Os dados podem ser publicados uma vez ou podem ser publicados em uma agenda.

6. Visualizar seus dados em uma ferramenta Bl preferencial.
Para procedimentos mais detalhados, comece com um dos seguintes:

e Criar uma view com ativos
e Criar uma view para eventos

e Criar uma view de streaming

Validacao do nome da view

A validagdo do nome da view permite que o Pl Integrator crie/modifique/importe caixas de didlogo. Todos os
caracteres unicode e de localizagdo internacional sdo permitidos, mas certos caracteres especiais ndo sao
permitidos. As views existentes que ja fazem parte do banco de dados do PI Integrator ndo devem ser afetadas, a
menos que o usudrio tente modificar seu nome.

Se o usuadrio inserir um nome de view invalido, a caixa de texto serd destacada em vermelho e uma mensagem
de erro serd exibida especificando que o nome da view é invalido. Este € o mesmo cenario para criar/modificar/
importar caixas de didlogo.

Os usudrios podem substituir o mapa de caracteres padrao permitido seguindo estas etapas:

1. Abra o arquivo C:\Arquivos de Programa\PIPC\Integrators\BA\CAST.Ul.WindowsService.exe.config em um
editor de arquivos.

2. Modifique o valor ViewnameAllowedSpecialCharacters para incluir os caracteres especiais.
Por exemplo, se estiver usando "@"', " " ou "!" em nomes de exibi¢do, o valor serd "@!".

Devido a natureza do XML, certos caracteres reservados, como "&", precisam de uma sequéncia de escape.
Isso resultaria em "&amp", por exemplo.

3. Reinicie os servicos do integrador.
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4. Insira o novo Nome da View. Ele deve passar na validagdo devido a modificacdo de
ViewnameAllowedSpecialCharacters.

ForceCreateTable

O recurso ForceCreateTable permite forcar a criacdo de determinadas tabelas de publicacdo associadas a
destinos SQL (SQL, SQL do Azure, Oracle, AWS Redshift, HANA). Ele for¢a a criagdo de uma tabela de publicacdo
se uma tabela existente nao puder ser encontrada pelo Pl Integrator em um destino de publicagdo especifico.
ForceCreateTable afeta todas as views de publicacdo continua associadas a destinos SQL.

Ele estd localizado em C:\ProgramFiles\PIPC\Integrators\BA\CAST.Ul.WindowsService.exe.config.
Para editar o recurso ForceCreateTable, insira:

<add key="ForceCreateTable" value="false" />

Nota: o valor padrdo é definido como false. Se o usuario definir ForceCreateTable como true, o Pl Integrator
criard uma nova tabela de publicagdo se a tabela original correspondente a essa view ndo puder ser encontrada.

Criar uma view com ativos

Caso vocé deseje analisar seus dados divididos em ativos, crie uma view com ativos. Caso vocé deseje analisar
seus dados em Event Frames, consulte Criar uma view para eventos. Se vocé quiser analisar seus dados divididos
pelos ativos e precisar de valores transmitidos para analises em tempo real ou alguma outra anadlise, consulte
Criar uma view de streaming.

Clique no icone do menu E e clique em Criar View com Ativos.

2. Insira um nome para a view.

Nota: observe as convengdes de nomenclatura do destino em que esta view serd publicada. Para obter mais
informacgdes, consulte Nomes de view e endpoints de destino.

3. Se sua conta de usudrio for atribuida a varias identidades do Pl AF com acesso ao Pl Integrator for Business
Analytics, clique na lista suspensa Visualizar proprietario e selecione a identidade a qual vocé quer dar
acesso a view.

Se sua conta de usudrio estiver mapeada para apenas uma identidade do Pl AF que recebeu acesso ao Pl
Integrator for Business Analytics, essa identidade serd automaticamente atribuida a view.

Ao criar uma view pela primeira vez, sera possivel conceder acesso apenas a uma identidade Pl AF.
Posteriormente, vocé podera conceder acesso a outras identidades Pl AF. Para obter mais informacdes,
consulte Proteger suas views.

4. Clique em Criar View.

No painel Ativos de Origem, clique em Criar uma Nova Forma.

Dica: é possivel usar o formato de uma visualizacao existente clicando em Importar uma forma em outra
view.

6. Use os campos Servidor e Banco de Dados para procurar pelo Pl AF Server e banco de dados.

Nota: se a configuragdo de seguranca de personificacdo do aplicativo estiver ativada, vocé vera um botdo
gue permite ver as identidades de acesso a dados usadas para a view.

7. Pesquise a arvore do Pl AF para encontrar o ativo que vocé deseja analisar.
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8. Arraste o ativo para o painel Formato do Ativo.

Arrastando o ativo para o painel Formato do Ativo

Select Data > Modify View » Publish

@ Source Assets

Server CAST-INT-CL v
Database Datacenter Demo oo
Q) Assets

4 (@ Data Centers
4 [ Americas
4 [P Atianta

| » (D Colol —_—
» [ Colo2

» [ Colo3
» ) Chicago

Attributes | x |

0 select Al

4 ColoNumber

& Zonel.Capacity

& Zonel.CapacityPercent
& ZonelDCIE

& ZonelPUE

& Zonel.PWR

eocooeoeo0

& ZonelRollingCost

-

T Search Shape v/ Matches
T_Asset Shape

E}-\_lto drop and place

Q) Colol

O ativo é adicionado a arvore Formato do Ativo.

Ao selecionar um ativo, o painel Atributos é aberto exibindo os atributos do elemento.

Arraste todos os atributos para incluir em seu formato.

Nota: é possivel classificar, agrupar e filtrar os atributos.

Adicionar um atributo usando Soltar e posicionar automaticamente
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Select Data > Modify View > Publish

Ea Source Assets T Search Shape + Matches
Server CASTANT-CL - T_Asset Shape Found 5 Matches
Database Datacenter Demo ooy & Colot s X & colot
@ Colot
Assets
CD ) @ Colot
A fa Data Centers Q‘ t | @ colof
L utoc drop and place
4 America -
Ea § & Zonel.Capacity @ Colol
4 (@ Atlanta
| » @ Colot
» @ Colo2
» @ Colo3
» @ Chicago
P+ S
Attributes ‘
O Select All
4 ColoNumber

‘ & Zonel.Capacity

& ZonelCapacityPercent
& ZonelDCIE
& ZonelPUE
& ZonelPWR

eocoo

# ZonelRollingCost

-

Dica: se vocé arrastar um objeto para fora da arvore de formato do ativo, uma dica de ferramenta é exibida
com o texto Soltar e posicionar automaticamente. O elemento serd automaticamente adicionado a arvore
em uma localizagdo légica. Ele manterd a mesma relagao na arvore de formato do ativo que tinha na arvore
do PI AF. Caso ndo haja localizagdo que faga sentido, a descida é rejeitada.

Nota: também é possivel posicionar o objeto na arvore de formato do ativo. Uma dica de ferramenta que
orienta vocé no que diz respeito a adicdo do ativo como uma entidade pai, filho ou irm3o. Ela ndo impedira
gue vocé arraste um objeto para um local que ndo corresponde a hierarquia do Pl AF.

Colocagdo de um elemento na arvore de formato do ativo
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Select Data » Modify View > Publish

@ Source Assets T Search Shape + Matches
Server CASTANT-CL v ToAsset Shape Found 5 Matches
Database Datacenter Demo oo 4 anitz;—ga\ert 7 % @ coo
b it Cana P » @ Colot
6 Assets % @
r @ Data Centers Py » © Colot
r @ Americas Py » © Colot
| 4 e Atlanta .
» @ Colot
» @ Colo2
» [ Colo3
» D Chicago
» Ef) Houston
> @ MNew York

3 @ San Leandro

10. Arraste quaisquer ativos e atributos adicionais para o painel Formato do Ativo.
O painel Correspondéncias exibe os elementos que correspondem ao formato definido.

11. Para visualizar os dados para todos os ativos que compartilham o mesmo template do Pl AF:

a. Clique noicone < préximo ao ativo para abrir a caixa de didlogo Editar Filtros.
b. Limpe a caixa de verificagdio Nome do Ativo.

c. Selecione a caixa de verificagdo Modelo do Ativo e clique em Salvar.

O painel Correspondéncias exibe dados de todos os ativos que compartilham esse modelo.
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@ Source Assets T Search Shape ' Matches
. CASTINTCL . T Asset Shape Found 16 Matches
Database Datacenter Demo (s 4 4 @ ColoTemplate 4 % > @coor
& Zonel.Capacity a » @ Colot
@ Assets
& Zonel.CapacityPercent PR . » @ Colot
4 @ Data Centers @ Zonel PUR * % @ Colof
4 @ Americas & ZonelRollingCost " % > @ Colot
4 [ Atlanta » @ Colo2
» ) Colot » @ Colo2
» & Colo2 » @ Colo2
» [ Colo3 » @ Colo2
4 [ chicago » @ Colo2
» ) Colol » @ Colo3
» ) Colo2 » @ Colo3
» @ Colo3 » @ Coloz
» B Houston » @ Colo3
» B New York » @ Colo2
» @ san Leandro » @ Colod

12. Para encontrar correspondéncias para ativos semelhantes que tém um conjunto diferente de atributos:

. , e - . ~ 2 .
a. Cliqgue noicone * proximo ao atributo que ndo é necessario.
b. Na caixa de didlogo Editar Filtros, selecione a caixa de verificacdo Atributo Opcional e clique em Salvar.

Por exemplo, vocé pode usar a opg¢do Atributo Opcional caso vocé tenha adquirido equipamento em um
periodo de tempo e alguns dos atributos sejam diferentes entre o equipamento mais antigo e o mais
recente.

Edit Filters

# Attribute Name

Zonel.RollingCost

Attribute Category

Cost v

(+) Add Filter

¥ Optional Attribute (i

13. Cliqgue em Préximo para pré-visualizar um subconjunto dos seus dados.
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As primeiras 100 linhas para as primeiras 10 correspondéncias do banco de dados do Pl AF s3o exibidas.

14. Para refinar os resultados, vocé pode adicionar mais dados, modificar colunas, filtrar os dados ou alterar
como os valores sdo recuperados.

Para mais informacgdes, consulte Modificar os dados nas views de ativos e de eventos.

Nota: como o Pl Integrator for Business Analytics exibe somente as primeiras 100 linhas para as primeiras 10
correspondéncias do formato, é possivel definir seus filtros de maneira a excluir esses dados. Nesta situacao,
nenhum dado aparecera na pdgina mesmo que a view configurada resulte em correspondéncias.

15. Cliqgue em Préximo.

— Asset View 1
Select Data > Modify View » Publish

Target Configuration Summary

S50L Server ¥ Shape and Matches

= There are 16 Matching Instances

* Run Once
Timeframe and Interval

Run on a Schedule
« our Start Time is *-8h

= Your End Time is *
= “Your Time Interval gets an interpolated
measurement Every 1 minute

16. Na lista Configuragao do Destino, selecione um destino.

17. Cliqgue em Executar Somente uma Vez para criar a view uma vez ou clique em Executar Periodicamente para
anexar novos dados periodicamente a view.

Nota: para obter mais informacgdes sobre views de publicagao, consulte Publicar uma view periodicamente.

18. Clique em Publicar.

Offset de coluna

1. Cligue na coluna para abrir o painel Detalhes da Coluna.
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2. No campo Offset de coluna, desloque as colunas para cima ou para baixo em relagdo as demais colunas
usando os sinais + e -. Dependendo da dire¢ao, o primeiro ou o ultimo ndmero de linhas da coluna produzira

um valor nulo.

3. Quando tiver concluido, clique em Aplicar Alteragées.

Criar uma view para eventos

Caso vocé deseje analisar seus dados divididos em estruturas de evento, crie uma view para eventos. Caso vocé
deseje analisar seus dados divididos em ativos, consulte Criar uma view com ativos. Se vocé quiser analisar seus
dados divididos pelos ativos e precisar de valores transmitidos para analise em tempo real ou alguma outra

andlise, consulte Criar uma view de streaming.

Nota: o Pl Integrator for Business Analytics retorna somente event frames fechados (com tempos de inicio e final

validos). Ele ndo pode publicar dados abertos de event frame.

1. Cligue no icone de menu E e cligue em Criar View para Eventos.

2. Insira um nome para a view.

Nota: observe as conveng¢des de nomenclatura do destino em que esta view serd publicada. Para obter mais
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informacdes, consulte Nomes de view e endpoints de destino.

3. Se sua conta de usuario for atribuida a vérias identidades Pl AF com acesso ao Pl Integrator for Business
Analytics, cligue em Acesso a Permissoes e selecione a identidade a qual vocé quer dar acesso a view.

Se sua conta de usudrio estiver mapeada para apenas uma identidade do Pl AF que recebeu acesso ao Pl
Integrator for Business Analytics, essa identidade serd automaticamente atribuida a view.

Ao criar uma view pela primeira vez, serd possivel conceder acesso apenas a uma identidade Pl AF.
Posteriormente, vocé poderd conceder acesso a outras identidades Pl AF. Consulte Proteger suas views para
obter mais informagdes.

4. Clique em Criar View.

No painel Eventos de Origem, cligue em Criar uma Nova Forma.

Dica: é possivel usar o formato de uma view existente clicando em Importar uma forma a partir de outra
view.

6. Use os campos Servidor e Banco de dados para selecionar o Pl AF Server e o banco de dados em que as
estruturas de evento serdo armazenadas.

Nota: se a configuracdo de seguranca de personificacdo do aplicativo estiver ativada, havera um botdo que
permite ao usudrio ver as identidades de acesso a dados usadas para a view.

7. No painel Estrutura de evento, arraste as estruturas de evento e os elementos referenciados para a arvore
Formato do evento.

Nota: clique no icone Y no painel Eventos de origem e configure os filtros para exibir apenas event frames
de interesse. Por exemplo, é possivel filtrar por tempo, ativos, eventos e modelos do ativo ou do evento. No
painel Mais opcdes, se a opc¢do Todos os descendentes estiver selecionada, toda a hierarquia do Pl AF sera
pesquisada. Caso ndo sejam selecionados, apenas as estruturas de evento em nivel de raiz serdao
pesquisadas.

Dica: para dicas para criar formatos de evento, consulte Dicas para criar formatos em views de evento.

8. Cligue no icone proximo ao elemento para abrir a guia Ativos e va diretamente para sua localizagdo na
hierarquia do PI AF.

9. Arraste quaisquer ativos e atributos da arvore do Pl AF para a arvore Formato do Evento.
Para dicas de como criar formatos de ativo, consulte Dicas para criar formatos em views de evento.

10. Pararecuperar os dados de todas as estruturas de evento que compartilham o mesmo modelo do Pl AF:

2

a. Cligue noicone s ao lado da estrutura de evento na arvore Formato do evento.
b. Limpe a caixa de verificagdo de Nome da Estrutura de Evento.
c. Selecione a caixa de verificagdo Template da Estrutura de Evento e clique em Salvar.
11. Cliqgue em Proximo para pré-visualizar um subconjunto dos seus dados.
A hora de inicio exibida é a hora de inicio da primeira estrutura de evento que foi adicionada ao formato.
O Pl Integrator for Business Analytics recupera somente event frames fechados.

12. Para refinar os resultados, vocé pode adicionar mais dados, modificar colunas, filtrar os dados ou alterar
como os valores sdo recuperados. Consulte Modificar os dados nas views de ativos e de eventos para obter
mais informacdes.

Nota: Como o Pl Integrator for Business Analytics exibe somente as primeiras 100 linhas para as primeiras 10
correspondéncias do formato, é possivel definir seus filtros de maneira a excluir esses dados. Nesta situagao,
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nenhum dado aparecerd na pagina mesmo que a view configurada resulte em correspondéncias validas.

13. Clique em Préximo para publicar seus dados.

14. Na lista Configura¢ao do Destino, selecione um destino.

15. Cliqgue em Executar Somente Uma Vez para publicar a view uma vez ou clique em Executar Periodicamente
para anexar novos dados periodicamente a view.

16. Clique em Publicar.

Dicas para criar formatos em views de evento

Vocé seleciona os event frames para incluir sua view do evento na pagina Selecionar Dados.

A pagina Selecionar Dados

Select Data > Modify View > Publish

"H Source Events

Server O’I DFPIAF v

Database

OSIPharmaCIP - v

l h ‘ Enter Event name or string match patterm @.\

) EPSHUTDOWN

Event Frames Assets

) EPRINSE

| -

) EPWASH
» ) CIP_422_SKID
» ) CIP_432_SKID
» [ Environmental

1 oo temnlate

- —m B
Attributes | Fitter @ * |
O Select All

v " Search Shape

4 CIP Flow Rate (to User)
4 CIP Flow Rate (to User) High
& CIP Flow Rate (to User) Low

# CIP Flow Rate (to User) Parameter

e ¢ ¢ 0 @

4 CIP Supply Pressure

- =

(4)
FH Event Shape @

4 ¥ CIP_SKID_EPRINSE:-1 &
4 FIEPRINSE % &
4 CIP Flow Rate (to User) &

4 CIP Flow Rate (to User) High s

& CIP Flow Rate (to User) Low 4

4 " CONNECTING 4
4 CIP_124_SKID @ l‘
4 ACID SUPPLY FLOW J s

4 ACID SUPPLY TANK LEVEL CON... #

& CIP Acid Tank Level s

& CIP caustic Tank Level s

X %X X X X X X X M x X

+ Matches

&)

Found 62 Matches

»

»

v

v

v

v

v

v

v

v

hd

v

v

v

v

v

v

v

v

v

"4 CIP_SKID_EPRINSE:1-1
"H CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
¥4 CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
"H CIP_SKID_EPRINSE:1-1
"H CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1

¥ CIP_SKID_EPRINSE:1-1

A tabela a seguir descreve as diferentes partes dessa pagina e como vocé a utiliza para criar o formato de view

para eventos.

Numero Descrigao

1 Especifique o servidor e o banco de dados em que o
banco de dados do Pl AF estd localizado.

2 Clique na guia Event Frames para exibir os event
frames. Clique na guia Ativos para exibir os
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Nimero

Descrigao

elementos.

Para filtrar a lista de event frames, insira uma string de
pesquisa para o nome da event frame.

Painel Formato de busca, no qual vocé especifica o
padrao de pesquisa da sua view de eventos.

Painel Formato do evento, no qual vocé adiciona
event frames e seus atributos e elementos
referenciados e seus atributos.

O painel Atributos exibe os atributos que podem ser
adicionados ao painel Formato do evento.

Dica: clique em o ao lado do atributo para abrir
uma janela que exiba dados sobre o atributo.

Vincule um elemento referenciado ao seu préprio
formato de busca separado. Somente facga isso se
quiser incluir atributos e elementos pais ao elemento
vinculado.

O painel Correspondéncias é uma visualiza¢do dos
event frames e ativos definidos no seu formato de
busca para as quais sdo encontradas correspondéncias
no banco de dados do Pl AF.

Ao trabalhar com o formato do evento:

e E possivel adicionar quantas event frames quiser, mas pode haver apenas uma em cada nivel da hierarquia
de event frames, como exibido abaixo. Por exemplo, a maquina do formato do evento pode ter apenas um
event frame filho. Arraste o event frame do painel Event Frames para o painel Formato do Evento.

Formato do evento: uma maquina do formato de evento com um event frame filho
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M4 Search Shape

¥ Event Shape

4 d CIP_SKID_EPRINSE:1-1 &S %
£ EPRINSE % & X

4 4 CONNECTING &S x
£ CIP_124_SKID % & x

¢ Cada event frame pode ter apenas um elemento referenciado. Arraste o elemento referenciado do painel
Event Frames para o formato do evento.

¢ Cligue no event frame no painel Event Frames para exibir seus atributos no painel Atributos. Arraste
gualquer um dos atributos para o formato do evento.

¢ No painel Eventos de Origem, clique na guia Event Frames e depois na lupa ao lado de um elemento para
alternar para o painel Ativos e veja a localizagdo do elemento na hierarquia do Pl AF.

Localizar um elemento na hierarquia do Pl AF
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H4 Source Events v
<EUE DFPIAF v
el 0SIPharmaCIP o v

Y | Enter Event name or string match pattemn

Event Frames Assets

» "8 CIP_SKID_EFPRINSE:1-1
4 "4 CIP_SKID_EPRINSE:1-1

» " CONNECTING

» " DOWNLOADING

» "H STARTING

» " RUNNING

» "H UPLOADING

» "8 COMPLETE

FD EPRINSE Q
» D CIP_124_SKID Q

» "4 CIP_SKID_EPRINSE:1-1

» PH CIP_SKID_EPRINSE:1-1

¢ O painel Atributos exibe os atributos para o elemento selecionado. Arraste qualquer um dos atributos para o
formato do evento.

¢ Somente sera possivel soltar event frames e elementos na drvore Formato do evento usando a opgao Soltar
e posicionar automaticamente se isso fizer sentido ldgico. Se vocé arrastar um elemento para uma area
aberta abaixo do formato do evento, uma dica de ferramenta sera exibida com o texto Soltar e posicionar
automaticamente. O Pl Integrator for Business Analytics leva a relacdo do objeto para outros objetos na
hierarquia do PI AF e tenta corresponder essa relagao no formato. A opgdo Soltar e posicionar
automaticamente pode adicionar o objeto arrastado ao formato somente quando o objeto é um pai ou filho
imediato de um objeto ja exibido no formato.

Soltar e posicionar automaticamente
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M Search Shape

" Event Shape

u

4 ¥y &S X
£0) EPRINSE G & x
FH CONMECTING F x

@i

Auto drop and place
&0 CIP_124_SKID

Dica: se vocé for novo no Pl Integrator for Business Analytics, comece usando Soltar e posicionar
automaticamente.

e Conforme vocé arrasta um event frame, elemento ou atributo para qualquer lugar na arvore Formato do
Evento, uma dica de ferramenta o orienta a soltar o objeto como pai, irmao ou filho.

Nota: isso ndo impedird que vocé posicione um objeto em um local que ndo corresponde a hierarquia do Pl
AF.

Arrastar e soltar objetos em uma arvore de formatos
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M4 Search Shape

" Event Shape

4 P CIP_SKID_EPRINSE:1-1 & %
£7) EPRINSE % &S x
4 " CONNECTING F x
Eﬁ&l; 124 SKID | %l x

Drop as child

# ACID SUPPLY FLOW

Quando e como usar ativos vinculados

Na maioria das vezes, vocé criard sua forma no painel Formato do Evento, adicionando seu event frame, event
frame filho e os elementos referenciados junto com seus atributos, como mostrado na captura de tela abaixo.
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M4 Search Shape

*H Event Shape

4 "4 CIP_SKID_EPRINSE:1-1
4 [ EPRINSE %
& CIF Flow Rate (to User)
& CIP Flow Rate (to User) High
& CIP Flow Rate (to User) Low
4 P CONNECTING
4 FACIP_124_SKID %
& ACID SUPPLY FLOW
& ACID SUPPLY TANK LEVEL CONTROL

& CIP Acid Tank Level

B 0% % % % % % %R N R
X X X X X X X X xXx x X

& CIP Caustic Tank Level

No formato do evento, vocé pode somente adicionar elementos abaixo do elemento que esta referenciado no
event frame superior. No exemplo acima, vocé nao pode adicionar elementos pais que estejam acima do
elemento CIP_124 SKID na hierarquia do Pl AF. Se precisar de elementos ou atributos de um elemento pai ou
referenciado, clique no link Ativos Vinculados para abrir o painel do Formato do Ativo. (Veja a captura de tela
abaixo.)

Link de ativos vinculados
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*H Search Shape

*H Event Shape

4 WY ClP_SKID_EPRINSE:1-1

OO

4 FEPRINSE
& CIP Flow Rate (to User)
& CIP Flow Rate (to User) High
& CIP Flow Rate (to User) Low
4 Y COMNECTING

4 FACIP_124_SKID

CFee

B 0% % % % % % % R R R
X X %X X X X X X X X X

& ACID SUPPLY FLOW
& ACID SUPPLY TANK LEVEL CONTROL
& CIP Acid Tank Level

& CIP Caustic Tank Level

Ao clicar no icone Ativos Vinculados, um segundo painel é exibido, o painel Formato do Ativo. O elemento
vinculado, seus atributos e quaisquer elementos e atributos que descendem dele sao movidos para o painel
Formato do Ativo. Neste exemplo, o elemento CIP_124 SKID é copiado para o painel Formato do Ativo junto aos
quatro atributos. A captura de dela abaixo ilustra isso.

O formato do ativo foi adicionado ao formato de busca
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M Search Shape
HH Event Shape
4 " CIP_SKID_EPRINSE:1-1
4 FIEPRINSE
& CIF Flow Rate (to User)
& CIP Flow Rate (to User) High
& CIP Flow Rate (to User) Low
4 P CONNECTING

£D CIP_124_SKID

T= Asset Shape

4 [CIP_124_SKID
& ACID SUPPLY FLOW
& ACID SUPPLY TANK LEVEL CONTROL
& CIF Acid Tank Level

& CIP Caustic Tank Level
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B O% % % R R K
X X X X X XN X

B % % % N
X X X X 2

No painel Formato do Ativo, vocé pode adicionar quaisquer elementos e seus atributos, ndo importando onde
eles estejam na hierarquia do PI AF. Neste exemplo, o L1 HuMAB, o NorthStreetPllant, e os elementos

Philadelphia sdo adicionados ao formato do ativo.

Elementos adicionados ao formato do ativo
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w " Search Shape

Server DFPIAF . "8 Event Shape
Database OSIPharmaCIP . 4 "4 CIP_SKID_EPRINSE:1-1 S %
4 FJEPRINSE % & X
I h & | Enter Event name or string match pattern & CIP Flow Rate (to User) & x
Event Frames Assets & CIP Flow Rate (to User) High a4
4 [ Data Centers & CIP Flow Rate (to User) Low S x
» € Americas 4 i CONNECTING S x
4 () PharmaCO KD CIP_124_SKID Y #x
4 ) North America
4 () Philadelphia
4 [ NorthstreetPllant
4 @ L1 HuMAB
&) CIP_000_SKID
» @ CIP_123_SKID
» @ CIP_124_SKID ‘ T Asset Shape
» ) CIP_422_SKID 4 [ Philadelphia & x
» € CIP_432_SKID 4 @) NorthstreetPllant # x
» (D Environmental 4 @ L1 HuMAB S x
&) no template 4 QcCIP_124_SKID %G S X
» (D syringe & ACID SUPPLY FLOW & n
» D T.STA 4P ACID SUPPLY TANK LEVEL CONTROL #x
e & CIP Acid Tank Level & x
» QT 4 CIP Caustic Tank Level & n
» @T112

Se clicar no link de Ativos Vinculados no formato do arquivo,

o painel Formato de arquivo desaparece e o ativo

vinculado, assim como todos seus atributos, retornam ao painel Formato do Evento.

Nota: O Unico motivo para separar um elemento no painel Formato do Ativo é incluir elementos e atributos que
acontecem acima na hierarquia do Pl AF. Dependendo da complexidade do formato, pode aumentar o tempo

que leva para publicar a view.

Criar uma view de streaming

Nota: este recurso esta disponivel na edicdo Advanced do Pl Integrator for Business Analytics.

A seguir é apresentada uma visao geral das principais etapas para criar uma view de streaming. Clique nos links

para ver o procedimento especifico.

1. Definir o formato da view de streaming.

2. Escolha o esquema a usar com sua view com uma das opg¢des a seguir:

Use um esquema importado de um arquivo

e Usar um esquema gerado

Use um esquema importado de um registro do esquema

Para obter mais informacgGes sobre esquemas, consulte Sobre esquemas.
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3. Configurar quando mensagens sdo enviadas.
Para obter mais informacdes sobre gatilhos de mensagen
4. (Opcional) Dados de recarga de dados histéricos.

(Opcional) Filtrar os dados.

Pl Integrator for Business Analytics
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s, consulte Sobre gatilhos de mensagem.

Salvar um esquema para o registro do esquema

Qualquer esquema importado de um arquivo ou qualquer esquema gerado pode ser salvo no registro do
esquema. Todos os esquemas, independentemente de sua origem, sdo salvos como esquemas do Avro. Depois

gue o esquema é salvo, o esquema no painel Designer de me

nsagem serd ligado pelas regras impostas pelo

registro do esquema. Portanto, vocé quer fazer alteracbes antes de salvar o esquema no registro.

Nota: sempre é possivel remover a conexao do esquema no painel Designer de mensagem do registro do

esquema clicando em Parar de utilizar o registro.

Nesta versdo, os esquemas podem ser salvos somente em um registro do esquema. Eles ndo podem ser salvos

em um arquivo.

1. Na pagina Modificar View, clique em Salvar o esquema e

m Registro.

Nota: Opgoes de esquema deve ser selecionado para que este botdo seja exibido.

Antes de salvar o esquema no registro, vocé pode editar e excluir as propriedades do esquema. Se o

esquema ndo estiver sincronizado com a forma do ativo,

isto é, se a op¢do Forma livre estiver ativada, vocé

também pode reorganizar as suas propriedades. Arraste e solte as propriedades para alterar a ordem.

Message Designer

Schema Options

Free-form mode

Message Trigger
Trigger & new measage when 1 key
values change

Backfill Data

Do not backfill data

Message Filters
0 filters

‘You are not syncing (free-form) your schema to the asset shape.

mport Schema Select Schema Structure

Select Import Source - | Fres-form

- | Save Schema to Registry

=

“Timestamp": |@ TimeStamp ", &S x
“"Zonel.Capacity"”: "|4 Zone1.Capacity (Value) v |", s
“Zonel.CapacityPercent”: "|J Zonei CapacityPercent (Valug) v | 3 &S x
“Zonel.PWR": "|4 Zonel.PWR (Value) v, & X
“Zonel.RollingCost": "|4 Zonel.RollingCost (Value) v, s
“ColoTemplate™: "|@ Colo1 (Name) v & X
}
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2. Na janela Salvar o esquema em Registro, especifique o local do registro do esquema no campo URL de
Registro do esquema.

Dica: comece digitando no campo e uma lista de registros de esquema disponiveis serd exibida.

3. Insira um nome para o esquema no campo Assunto do esquema e clique em Salvar.

Vocé também pode editar algumas das propriedades do esquema. No entanto, vocé ndo pode mais
reordenar ou excluir as propriedades do esquema.

You are using the schema "ZoneSchema” from the schema registry at http://10.4.200.128:8081.

mport Schema

[¥5]

elect Schema Structure

"=

"Timestamp": "[(¥) TimeStamp v, &S X
"Zonel.Capacity": "4 Zonei.Capacity (Value) ", & K
"Zonel.CapacityPercent™: "|4 Zonel.CapacityPercent (Value) v |", &S K
“Zonel.PWR": "|4 Zonel.PWR (Value) v, R
“Zonel.RollingCost™: "|4f Zonel RolingCost (Value) v, & R
"ColoTemplate™: "/ Colol (Name) " F X

Nota: E possivel clicar em Parar de utilizar o registro para remover a conexdo deste esquema com o registro
do esquema. Depois de fazer isso, vocé pode voltar a fazer as alteracGes que podia antes de salvar o
esquema.

Sobre gatilhos de mensagem

O gatilho de mensagem determina a frequéncia e as condicdes em que uma mensagem ¢é enviada ao destino de
publicacdo. Ha dois tipos de gatilhos, um baseado em um intervalo de tempo e o outro baseado nas alteracbes
dos valores principais. Todos os valores principais devem ser atributos de tag do PI. Estas op¢bes sao exibidas na
captura de tela abaixo.
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G} Trigger a message in regular time intervals:

#) Trigger a new message when the key value(s) selected below have changed
@ #) Trigger a message when any of the selected key values have changed

Trigger a message when all of the selected key values have changed

Trigger on Archive Data (@ Snapshot Data
¢ 1. Gatilho de mensagem baseado em tempo
¢ 2. Gatilho de mensagem baseado em uma alterag¢do nos valores de dados

As secdes abaixo descrevem como usar estas opgoes.

Acionar uma mensagem a intervalos de tempo regulares

Um intervalo de tempo pode ser definido de 30 segundos a 12 meses. Uma mensagem é enviada no intervalo de
tempo especificado, independentemente de haver alguma alteracao nos dados. Views com este tipo de gatilho
de mensagem sdo chamadas de views de transmissdo agendada.

Nota: Dependendo dos buffers e do tamanho da mensagem, pode haver um atraso no recebimento dos dados
no destino. A laténcia de ponta a ponta, o intervalo entre quando um valor chega no PI System e quando ele
chega no sistema de destino pode ser maior que o intervalo entre os gatilhos de mensagem.

Identificar as chaves que acionam a mensagem
Vocé pode decidir quais alteracées de chave acionardo uma mensagem. Views com este tipo de gatilho de

mensagem sdo chamadas de views de transmissdao com valor principal acionado. Na captura de tela abaixo, sdo
selecionadas duas chaves que correspondem as tags do Pl, Zonel.PWR e Zonel.RollingCost.
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Trigger a message in regular time in'tervals:l 1 (v || minutes “ |

® Trigger a new message when the key value(s) selected below have changed A _T_

#® Trigger a message when any of the selected key values have changed

() Trigger a message when all of the selected key values have changed A \'/

Triggeron () Archive Data (®) Snapshot Data (] v
Qe Message Content
{
“Timestamp”: *|(®) TimeStamp v s x
O "Zonel.Capacity”: "|4 Zonel.Capacily (Value) v, s %
) “Zonel.CapacityPercent”: "|4 Zonel.CapacityPercent (Value) v |, s x
@ “Zonel.PWR": " Zonel PWR (Value) v, s %
¥ |  "Zonel.RollingCost": "[ Zonel RolingCost (Value) v s X
"ColoTemplate™: | Colo1 (Name) v s %
¥

Depois de identificar as chaves, vocé pode também personalizar as condi¢gdes nas quais uma mensagem é
enviada.
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Trigger a message in regular time in'ten-'als:l 1 w || minutes vl

® Trigger a new message when the key value(s) selected below have changed A _T_

#® Trigger a message when any of the selected key values have changed

Trigger a message when all of the selected key values have changed A \.,_/

Trigger on Archive Data (® Snapshot Data [er2] v

Q‘. Message Content

I
L

“Timestamp”: *|(®) TimeStamp v, /%
"Zonel.Capacity": “|4 Zonel.Capacity (Value) v |"‘1 &%
“Zonel.CapacityPercent”: "[4 Zonel.CapacityPercent (Value) v |", P

4| "Zonel.PWR": [ Zonel PWR (Value) v, %

# | "Zonel.RollingCost": "[4 ZonelRollingCost (Value) v, , %
"ColoTemplate™: | Colo1 (Name) v e

Essas opgOes estdao descritas abaixo.

Acionar uma mensagem quando qualquer valor principal é alterado

A primeira opgao é acionar uma mensagem sempre que os dados de qualquer uma das chaves selecionadas
forem alterados.

Trigger @ message in reqular time inter'.'als:l 1 bl ” minuies |

® Trigger a new message when the key value(s) selected below have changed

# Trigger a message when any of the selected key values have changed

Trigger a message when all of the selected key values have changed
Trigger on Archive Data (® Snapshot Data

A seguir é mostrada uma representacao grafica dessa opcao. Ela exibe duas chaves, Chave A e Chave B. As
mensagens sao enviadas sempre que ha uma alteracdo em qualquer uma das chaves, indicadas pelos pontos. As
mensagens sao enviadas em t1, t2, t3, t4 e t5, conforme indicado pelas marcas de selecao.
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t1 t2 t3 t4 t5

Key A c".,, —T

Key B Q\

[oee] v v vv v

Acionar uma mensagem somente quando todos os valores principais forem alterados

A segunda opcdo é que uma mensagem seja enviada somente quando os valores de todas as chaves tiverem sido
alterados.

Trigger a message in regular time intervals: | 1 b ” minutess |

# Trigger @ new message when the key value(s) selected below have changed

Trigger a message when any of the selected key values have changed

#) Trigger a meszsage when all of the selected key values have changed

Trigger on Archive Data (® Snapshot Data

O grafico a seguir ilustra isso. Trés mensagens sao enviadas em t2, t4 e t7. Os pontos verdes indicam quais
valores alterados sao registrados. O valor em t5 ndo é enviado, conforme indicado pelo ponto vazio.
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Key A Q‘. l

Key B Q..

t1  t2 t3 t4 t5 t6 t7

1 v v v

Tipo de dado que aciona a mensagem

Além de identificar os dados mais criticos nos quais focar, vocé também pode especificar se deseja usar os
valores de archive ou de snapshot para acionar a mensagem.

Trigger a message in regular time intervals: | 1 W ” minuiess |

® Trigger 2 new message when the key value(s) selected below have changed
Trigger a message when any of the selected key values have changed

# Trigger a message when all of the selected key values have changed

Trigger on Archive Data (® Snapshot Data

Configurar quando mensagens sao enviadas

Leia o tdépico Sobre gatilhos de mensagem. Ele fornece o plano de fundo necessario para definir o gatilho de
mensagem.

Vocé deve gerar seu esquema antes de definir o gatilho de mensagem.

1. Na pagina Modificar View, clique em Gatilho de mensagem.

Opcao Descri¢ao
A Acionar uma mensagem em As mensagens sao enviadas no
intervalos de tempo regulares intervalo especificado
independentemente de haver
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Opgao

Descri¢ao

alguma alterac¢do no valor
principal.

Enviar uma nova mensagem
quando o valor ou valores
principais selecionados abaixo

As mensagens sao enviadas com
base nas alteracdes dos valores
principais.

forem alterados

¢ Escolha uma das seguintes opgdes: se vocé selecionou A, prossiga na etapa 3.
¢ Se vocé selecionou B, va para a etapa 4.
2. (Somente A) Clique nas listas para especificar o intervalo de tempo entre as mensagens.
E possivel especificar intervalos entre 30 segundos e 12 meses.

Intervalo de tempo da mensagem

® Trigger a message in regular time intervals: | 1 w || minutesw

Trigger a new message when the key value(s 1 seconds
2 minutes
3 hours
4 days
3 months
s}
7
8
-

3. (Somente B) Conclua as etapas a seguir:
a. Selecione as chaves cujos valores acionardao a mensagem.

b. Escolha uma das seguintes opg¢oes:

Opgao Descrigao

Somente um valor principal precisa ser alterado
para que uma mensagem seja acionada

Acionar uma mensagem quando qualquer um
dos valores principais selecionados tiver sido
alterado

Acionar uma mensagem quando todos os valores | Todos os valores principais devem ser alterados
principais selecionados tiverem sido alterados para que uma mensagem seja acionada

c. Escolha se a mensagem é acionada por alteracdo no valor do snapshot ou no valor do archive das chaves
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selecionadas.

Para obter mais informacdes sobre como essas op¢des afetam quais dados sdo enviados, consulte Sobre
gatilhos de mensagem.

Quais dados sao enviados para o destino?

Depois de configurar quando uma mensagem é enviada, especifique que tipo de dado é enviado. Para cada
propriedade, é possivel selecionar em uma lista de Opg¢des de valor.

Nota: Para os cenarios baseados em chave, o tipo de dado que envia a mensagem (archive ou snapshot) é
separado dos dados que realmente sdo enviados para o destino. Por exemplo, é possivel especificar se uma
alteragao nos dados do snapshot de uma chave envia a mensagem. No entanto, é possivel especificar se o valor
do archive da chave (ndo o valor do snapshot) é enviado ao destino. Na captura de tela abaixo, Valor é
selecionado para a propriedade Zonel.Capacity.

Gsc Message Content
{

"Timestamp”: "|(® TimeStamp ",

o "Zonel.Capacity”: "'0 Zone1.Capacity (Value) LA

. Template -
"Zonel.CapacityPerc Category lue) v 7,

Fath
v "Zonel.PWR": "|4 Zon Description
Guid
7 "Zonel.RollingCost™ J_UL_::M Tl

"ColoTemplate™: Efﬂ Ifgtsglﬂemrded Value
]. Average

Minimum

Maximum

Range

Standard Deviation
Standard Deviation (Fopulation)
Count
Percent Goad
Snapshot
Time Ophions
TimesStamp
Year -

Os cenarios a seguir descrevem as condi¢des nas quais uma mensagem é enviada.

e Cendrio 1: dados do intervalo
¢ Cendrio 2: qualquer alteragdo de chave dos dados do archive envia uma mensagem

¢ Cendrio 3: qualquer alteragdo de chave dos dados do snapshot envia uma mensagem

Em cada situacdo, as propriedades podem ser configuradas com uma opcdo de valor diferente. Os cenarios
descrevem o efeito de configuracdo das propriedades com as op¢des Valor, Ultimo Valor Registrado e Snapshot.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 123



'AV EVA\TM Pl Integrator for Business Analytics

Como usar o Pl Integrator for Business Analytics

Cenario 1: dados do intervalo

Os dados do intervalo sdo enviados em intervalos especificados. No exemplo a seguir, t1 e t4 marcam o inicio e o
fim do intervalo de tempo. O timestamp da mensagem é a hora em t4. Os dados enviados dependem da opg¢ao
de valor selecionada para a propriedade:

¢ Se a propriedade for configurada como Valor de Snapshot, o valor de snapshot em t3 serd enviado com o
timestamp t4. (1)

¢ Se a propriedade for configurada como Ultimo Valor Registrado, sera enviado o tGltimo valor registrado antes
do timestamp da mensagem, neste exemplo, o valor do archive em t2 é enviado com o timestamp de
mensagem t4. (2)

¢ Se a propriedade for configurada como Valor, os valores de archive e de snapshot no intervalo de tempo
serdo usados para calcular o valor interpolado em t4. (3)

time interval

tl t2 t3 t4

2/
O O

message time stampJ

Key

Valor de archive

Valor do snapshot

Valor interpolado

Cenario 2: qualquer alteracao de chave dos dados do archive envia uma mensagem

Quando um valor de snapshot entra em t3, ele envia o valor de snapshot em t2 a ser arquivado (em t2). O valor
do archive em t2 envia a mensagem e o timestamp é t2. A ilustracdo a seguir mostra quais dados sdo enviados
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para o destino dependendo da op¢do de valor selecionada:

¢ Se A for configurado como dados do Ultimo Valor Registrado, o valor do archive em t2 serd enviado (1).

¢ Se A for configurado como dados do Valor, o valor interpolado em t2 sera enviado (1).
Da mesma forma, os dados que sdo enviados para a propriedade B dependem de como sdo configurados:

e 0O Ultimo Valor Registrado é o primeiro valor no Pl Data Archive antes do timestamps da mensagem ou no
timestamp da mensagem (t2). Neste exemplo, se B for configurado como Ultimo Valor Registrado, o valor do
archive que é o primeiro valor antes de t2 sera enviado (2).

¢ Se B for configurado como dados do Valor, os dados serdo interpolados em t2 usando o valor do archive em
t1 e o valor do snapshot em t3 (3).

message time stamp

—

tl t2 t3

v Key A

Key B

Key

Valor de archive

Valor do snapshot

Valor interpolado

Cenario 3: qualquer alteracao de chave dos dados do snapshot envia uma mensagem
Uma alteracdo no valor do snapshot de qualquer uma das chaves envia uma mensagem. Neste exemplo, a

mensagem nao é enviada da Chave A. Os dados do snapshot para a Chave A envia uma mensagememt3 e o
timestamp da mensagem é t3. O valor do snapshot em t3 é retornado para a Chave A (1).
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A Chave B ndo é selecionada como uma chave de gatilho. Os valores para a segunda chave, Chave B, sdo
determinados por sua configura¢do:

e Se a Chave B for configurada como Ultimo Valor Registrado, o valor do archive em t1 com o timestamp de
mensagem t3 sera enviado. (2)

¢ Se a Chave B for configurada como valor do Snapshot, o valor do snapshot em t2 sera enviado com o
timestamp de mensagem t3. (3)

¢ Se a Chave B for configurada como Valor, o valor interpolado em t3 sera enviado com o timestamp t3. (4)

message time stamp

—

t1 12 t3

v Key A

Key B

Key

Valor de archive

Valor do snapshot

Valor interpolado

Se vocé selecionar a op¢do, Enviar uma mensagem quando todos os valores principais selecionados tiverem
sido alterados, devera haver uma alteragdo em todas as chaves antes de uma mensagem ser enviada. Os valores
do snapshot sdo retornados para todas as chaves selecionadas e o timestamp da ultima chave para retornar um
valor do snapshot é o timestamp da mensagem.

Visualizacoes dos dados da view de streaming
As visualizagdes dos dados sempre mostram valores do archive. Portanto, se o resultado das configuracées do

gatilho de mensagem for que os dados do snapshot serdo enviados ao destino, esses dados do snapshot nao
aparecerdo na visualizagdo. Vocé vera valores do archive.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 126



'AV EVA\TM Pl Integrator for Business Analytics

Como usar o Pl Integrator for Business Analytics

Dados fora de ordem

As views de streaming acionadas pela chave ndo enviardo uma mensagem em um evento que tenha um
timestamp anterior ao timestamp do ultimo evento.

Dados de recarga de dados historicos

Quando vocé publica seus dados, os valores atuais para seu formato sdo enviados para o destino. E possivel
obter valores anteriores recarregando seus dados histéricos.

Nota: os dados de recarga de dados histéricos sao suportados com views de streaming agendadas e permite
atualiza¢6es automaticas de dados. Ela ndo é suportada com views de streaming com valor principal acionado.

1
2
3.
4

Na pagina Modificar View, clique em Dados de recarga de dados histdricos.
Clique em Dados de recarga de dados histdricos iniciando em.
Clique no icone de calendario na caixa de texto para abrir o calendario.

Role o calendario e clique na data de inicio.

Definir o formato da view de streaming

Caso vocé deseje analisar seus dados divididos em ativos, consulte Criar uma view com ativos. Caso vocé deseje
analisar seus dados divididos em event frames, consulte Criar uma view para eventos.

Clique no icone de menu E e cligue em Criar view de Streaming.

Insira um nome para a view.

Nota: observe as convenc¢des de nomenclatura do destino em que esta view serd publicada. Para obter mais
informacdes, consulte Nomes de view e endpoints de destino.

Se sua conta de usudrio for atribuida a varias identidades Pl AF com acesso ao Pl Integrator for Business
Analytics, clique em Acesso a Permissdes e selecione a identidade que receberd acesso a view.

Se sua conta de usudrio estiver mapeada para apenas uma identidade do Pl AF que recebeu acesso ao Pl
Integrator for Business Analytics, essa identidade serd automaticamente atribuida a view.

Ao criar uma view pela primeira vez, serd possivel conceder acesso apenas a uma identidade PI AF.
Posteriormente, vocé podera conceder acesso a outras identidades Pl AF. Consulte Proteger suas views para
obter mais informacdes.

Clique em Criar View.

No painel Ativos de Origem, clique em Criar uma Nova Forma.

Dica: é possivel usar o formato de uma view existente clicando em Importar uma forma a partir de outra
view.

Use os campos Servidor e Banco de Dados para procurar pelo Pl AF Server e banco de dados.

Nota: se a personificacdo estiver ativada, havera um botdo que permitird que o usuario veja as identidades
de acesso a dados usadas para a view.

Pesquise a arvore do Pl AF para encontrar o ativo que vocé deseja analisar.
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8. Arraste o ativo para o painel Formato do Ativo.

Arrastando o ativo para o painel Formato do Ativo

Select Data > Modify View » Publish

Ejl Source Assets T Search Shape v/ Matches
T_Asset Shape

Server CASTINT-CL v

Database Datacenter Demo

0
-

Q) Assets
E}-\_lto drop and place
4 (@ Data Centers @ Colot

4 [ Americas
4 [P Atianta

| » (D Colol —_—
» [ Colo2

» [ Colo3
» ) Chicago

Attributes | x |

0 select Al

4 ColoNumber

& Zonel.Capacity

& Zonel.CapacityPercent
& ZonelDCIE

& ZonelPUE

& Zonel.PWR

eocooeoeo0

& ZonelRollingCost

-

O ativo é adicionado a arvore Formato do Ativo.
Ao selecionar um ativo, o painel Atributos é aberto exibindo os atributos do elemento.

9. Arraste todos os atributos para incluir em seu formato.

Nota: Vocé pode classificar os atributos, agrupa-los por categoria ou filtrar quais atributos sdo exibidos para
encontrar mais facilmente aqueles que deseja.

Adicionar um atributo usando Soltar e posicionar automaticamente
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Select Data > Modify View > Publish

Ea Source Assets T Search Shape + Matches
Server CASTANT-CL - T_Asset Shape Found 5 Matches
Database Datacenter Demo ooy & Colot s X & colot
@ Colot
Assets
CD ) @ Colot
A fa Data Centers Q‘ t | @ colof
L utoc drop and place
4 America -
Ea § & Zonel.Capacity @ Colol
4 (@ Atlanta
| » @ Colot
» @ Colo2
» @ Colo3
» @ Chicago
P+ S
Attributes ‘
O Select All
4 ColoNumber

‘ & Zonel.Capacity

& ZonelCapacityPercent
& ZonelDCIE
& ZonelPUE
& ZonelPWR

eocoo

# ZonelRollingCost

-

Nota: Se vocé arrastar um objeto para fora da arvore Formato do Ativo, uma dica de ferramenta sera exibida
com o texto Soltar e posicionar automaticamente. O elemento é automaticamente adicionado a drvore em
um local Iégico. Ele mantera a mesma relagdo na drvore de formato do ativo que tinha na arvore do Pl AF.
Caso nao haja localizagdo que faga sentido, a descida é rejeitada.

Também é possivel posicionar o objeto na arvore Formato do Ativo. Uma dica de ferramenta que o orienta
no que diz respeito a adi¢cdo do ativo como uma entidade pai, filho ou irmao. Isso ndo impedird que vocé
solte um objeto em um local que ndo corresponde a hierarquia do Pl AF.

Colocagdo de um elemento na arvore de formato do ativo
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Select Data » Modify View > Publish

@ Source Assets T Search Shape + Matches
Server CASTANT-CL v ToAsset Shape Found 5 Matches
Database Datacenter Demo oo 4 anitz;—ga\ert 7 % @ coo
b it Cana P » @ Colot
6 Assets % @
r @ Data Centers Py » © Colot
r @ Americas Py » © Colot
| 4 e Atlanta .
» @ Colot
» @ Colo2
» [ Colo3
» D Chicago
» Ef) Houston
> @ MNew York

3 @ San Leandro

10. Arraste quaisquer ativos e atributos adicionais para o painel Formato do Ativo.
O painel Correspondéncias exibe os elementos que correspondem ao formato definido.

11. Para visualizar os dados para todos os ativos que compartilham o mesmo template do Pl AF:

a. Clique noicone < préximo ao ativo para abrir a janela Editar Filtros.
b. Limpe a caixa de verificagdio Nome do Ativo.
c. Selecione a caixa de verificagdo Modelo do Ativo e clique em Salvar.

O painel Correspondéncias exibe dados de todos os ativos que compartilham esse modelo.
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@ Source Assets T Search Shape ' Matches
GarEr CASTINTCL . T Asset Shape Found 16 Matches
Database Datacenter Demo [ 4 4 @ ColoTemplate s x> Qcoot
& Zonel Capacity /x> ©cool
@ Assets
& Zonel.CapacityPercent PR . » @ Colot
4 @ Data Centers @ Zonel PUR * % @ Colof
4 © Americas & Zonel RollingCost % @ Cobot
4 [ Atlanta » @ Colo2
» ) Colot » @ Colo2
» [ Colo2 » @ Colo2
» &) Colo3 » & Colo2
4 [ Chicago » & Colo2
» ) Colol » @ Colo3
» ) Colo2 » @ Colo3
» [ Colo3 » @ Colo3
» B Houston » @ Colo3
» B New York » @ Colo2
» @ san Leandro » @ Colod

12. Para encontrar correspondéncias para ativos semelhantes que tém um conjunto diferente de atributos:

. , e - . ~ 2 .
a. Cliqgue noicone * proximo ao atributo que ndo é necessario.
b. Na caixa de didlogo Editar Filtros, selecione a caixa de verificacdo Atributo Opcional e clique em Salvar.

Por exemplo, vocé pode usar a opg¢do Atributo Opcional caso vocé tenha adquirido equipamento em um
periodo de tempo e alguns dos atributos sejam diferentes entre o equipamento mais antigo e o mais
recente.

Edit Filters

# Attribute Name

Zonel.RollingCost

Attribute Category

Cost v

(+) Add Filter

¥ Optional Attribute (i

13. Cliqgue em Préximo.
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A pagina Modificar View é exibida. Consulte A pagina Modificar View para obter uma visdo geral das tarefas
gue vocé executara para modificar sua view.

14. Escolha o esquema para os dados concluindo um dos procedimentos a seguir:
e Usar um esquema gerado
e Use um esquema importado de um arquivo

¢ Use um esquema importado de um registro do esquema

Nota: para obter mais informacgdes sobre as opgdes de esquema, consulte Sobre esquemas.

Resultados de grupo utilizando grupos de caractere coringa

Ha situa¢Oes em que agrupar elementos ou atributos de formato pode ser desejavel; por exemplo, ha um padrao
no atributo Nome de varios atributos e vocé deseja produzir uma tabela com uma coluna para cada tipo de
atributo na tabela de saida. No exemplo a seguir, ha trés atributos Zonel: Zonel.Capacity, Zonel.PWR
(poténcia), e Zonel.RollingCost. Esses atributos (capacidade, PWR e RollingCost) também sdo compartilhados
por Zone2, Zone3 e Zone4. (Por exemplo, os atributos Zone2 sdo Zone2.Capacity, Zone2.PWR e
Zone2.RollingCost.) Vocé deseja comparar esses atributos por zonas. A captura de tela a seguir é uma vista
parcial dessa estrutura do Pl AF.
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CAST-INT-CL

Datacenter Demo

0
-

4 [P Data Centers

4 [ Americas

4 [ Atlanta

» ) Colot

» ) Colo2
L —

Attributes

x
—
LT

0O select All

& ColoNumber

 Zonel.Capacity

 Zonel.CapacityPercent

4 Zonel.DCIE

 ZonelPUE

& ZonelPWR

4 ZonelRollingCost

 ZonelStatus

& Zone2 Capacity

4 Zone2 CapacityPercent

 Zone2 DCIE

4 Zone2 PUE

 Zone2 PWR

& Zone2 RollingCost

 Zone2 Status

 Zone3 Capacity

& Zone3 CapacityPercent
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Se vocé usasse um caractere coringa simples, vocé conseguiria o seguinte resultado com 64 correspondéncias.
Embora algumas combinagGes sejam ldgicas (por exemplo, os atributos Zone4 agrupados conjuntamente), ha
outras combinag¢des com uma mistura de zonas diferentes que ndo correspondem ao resultado desejado.

Select Data > Modify View > Publish

@ Source Assets

T Search Shape

Server CASTINT-CL - T.Asset Shape Found 64 Matches
4 " 4 anta
Database Datacenter Demo oo Bt L £
4 @ Colot * X 4 @ Colot
@ Assets
& Zone".Capacity 3 4 # Zone4 Capacity
A Data Centers
@ Data Centers & Zone* PWR a1 # Zoned PWR
- Americas 5
9 & Zone*RollingCost a2 4 Zone4 RollingCost
. o
e LRI 4 @ Atlanta
>
‘ e 4 @ Colot
» Colo2
6 oe 4 Zone3 Capacity
»
@ colos # ZonedPWR
> @ Chicago .
# Zone4 RollingCast
» Houst
@ ousten 4 @ Atlanta
3 i\ -
) New ork 4§ Colot
Attributes | ® ‘ # Zone2 Capacity
O Select Al # Zone4PWR
# Zone4RollingCost
& ColoNumber [ ]
“ Atlanta
4 Zonel.Capacity (i ] ©
4 Colol
4 Zonel CapacityPercent (i ] @
# ZonelCapacity
& Zone! DCE o pacty
# Zoned PWR
& ZonelPUE (i ]
& Zone! PUIR e 4 Zone4RollingCost
v
A= R T
& Zonel RollingCost i ]

+ Matches

Neste caso, vocé deseja gerar um conjunto de dados com uma coluna para cada atributo em vez de 12 colunas
(trés para cada uma das quatro zonas). Vocé pode adicionar grupos de caractere coringa aos atributos na arvore
Formato do Ativo para obter os resultados desejados. O procedimento e o exemplo a seguir ilustram o conceito

de um grupo de caractere coringa e como ele pode ser usado.

1. Crie um formato com o ativo e um conjunto dos atributos de seu interesse.
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Select Data > Modify View > Publish

@ Source Assets T Search Shape + Matches
Server CASTINT-CL . T Asset Shape Found 1 Match
= 4 Atlanta 7 % 4@ Atanta
Database Datacenter Demo Sov @ 5
4 @ colot S n 4 @ Colot
@ Assets X
& Zonel.Capacity s 4 Zonel.Capacity
4 Data Centers
8 & ZonelPWR a3 # Zonel PWR
- Americas i
e & Zone1RollingCost a3 & Zone!RollingCost
4 @ Atlanta
‘ » &) Colol
» ) Colo2
» @ colo3
» fa Chicago
> @ Houston
» @ New York

» fa San Leandro

Attributes | x

0O Select All

4P ColoNumber

4 Zonel.Capacity

& Zonel.CapacityPercent
4 ZonelDCIE

& Zonel.PUE

& ZonelPWR

4 Zonel RollingCost

LI - - T - I - -]

Ll

2

2. Clique em < préximo ao primeiro atributo (Zonel.Capacity).

3. Na caixa de didlogo Editar Filtros, substitua o string no qual vocé estd agrupando os resultados por um
asterisco.

Nesse exemplo, vocé substituiria Zone 1 por um asterisco (*).
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Edit Filters

Show Wildcard Groups &
# Attribute Name

* Capacity

Attribute Category

Capacity r

(#) Add Filter

Optional Attribute o

Isso produz as seguintes correspondéncias. Uma correspondéncia agrupa os atributos da mesma zona
(Zonel), mas as trés correspondéncias restantes agrupam atributos de zonas diferentes.

[

4. Clique em Save.

SelectData > Modify View > Publish
@ Source Assets T Search Shape ' Matches
Server CASTINTCL . TaAsset Shape Found 4 Matches
4 -
Database Datacenter Demo [ Ol i & s
4 @ Colot S x 4 @ Colol
@ Assets
& “.Capacity a4 # Zone4.Capacity
4 Data Centers
© & ZonelPWR P4 # Zone1PWR
4 eAmericas -
& Zone1RolingCost £ xR # ZonelRollingCost
A
e Atlanta i @ Atlanta
| » @ Colol e
3
@ coloz # Zone3.Capacity
3
Bl # ZonelPWR
»
@ chicage # ZonelRollingCost
>
e pCL=tol 4 @ Atlanta
» (D New York N e

3 San Ls d
@ san Leandro & Zone2 Capacity

# ZonelPWR

# Zone1RollingCost

4 @ Atlanta
Adtributes | x| 4 @ coiol
4 ZonelCapacity

O Select Al # ZonelPWR

4 ColoNumber (= # Zone1RoliingCost

4 Zonel.Capacity ]

& Zonel.CapacityPercent e

& Zonel DCIE (5]

# ZonelPUE ;]

# Zonel.PWR [i]

# Zonel RollingCost i ]
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5. Cliqgue em 4 préximo ao segundo atributo (Zonel.PWR).
6. Na caixa de didlogo Editar Filtros, substitua o mesmo string (Zonel) por um asterisco.

A caixa de didlogo Editar Filtros exibe o seguinte:

Edit Filters

Hide Wildcard Groups €
¥ Attribute Name

‘ | ‘ You've added a wildcard symbol (*) to multiple nodes in the
|PWR

Shape Tree:
Attribute Category L 4 *-S:vDRaCity
L

| Power r

Group Together Keep Wildcards
# Add Filter - T

Optior‘laIAttribthe 6 matching group on these Shape Items are — different

Don't show this message again

7. Clique em Grupo no mesmo local.

Na caixa de didlogo Editar Filtros, o asterisco é substituido por Grupo 1. O painel direito mostra os atributos
incluidos no grupo 1 (Group1l.Capacity e Group1l.PWR).

Edit Filters

Hide Wildcard Groups €
¥ Attribute Name Group Name Group Usage

‘ Group 1 & Group 1 .Capacity

| Group 1 x PWR
& Group 1 .PWR

Attribute Category

‘ Power r

® Add Filter

Optional Attribute @ (#) Create New Wildcard Group

8. Clique em Save.

Ambos os atributos no formato do ativo sdo exibidos com o caractere curinga Grupo 1.
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Select Data > Modify View > Publish
@ Source Assets T Search Shape + Matches
Server Jp—— v Tz Asset Shape Found 4 Matches
Database Datacenter Demo oo = LG S @ pne
4 @ Colol S x 4 @ colot
@ Assets & B copeciy £ % # Zonea Capacity
4 [ Data Centers & [Grotplil FWR S n # Zone4 PWR
4 Q@ Americas # ZonelRoliingCost % # Zone1RollingCost
4 [ Atlanta 4 @ Atlanta
‘ » @ Colol 4@ calol
» @ Colo2 # Zone3 Capacity
» @ Colo3 # Zone3PWR
» € Chicago # Zone1RollingCost
» (@ Houston 4 @ Atlanta
» 6D New York 4 @ Colol

> San Leand
& San Leandro # Zone2 Capacity

# Zone2 PWR

# Zone1 RollingCost

4 [‘B Atlanta
Attributes | x| 4 @ colol
# Zone1.Capacity
O Select Al # Zone1PUR
O L] # ZzonelRollingCost
& Zonel Capacity [ ]
4 Zonel CapacityPercent [ )
& Zonel.DCIE ;]
& Zonel PUE [:]
& ZonelPWR ;]
o

& ZonelRollingCost

9. Clique em < ao lado do terceiro atributo (Zonel.RollingCost).
10. Exclua o string compartilhado (Zonel).

11. Cliqgue em Grupo 1 no painel direito, arraste-o para o campo Nome do Atributo.

Edit Filters

Hide Wildcard Groups €

¥ Attribute Name GroupNgme Group Usage

oo Group 1 \ & Group 1 .Capacity
[:% Group 1 I & Group 1 .PWR
Attribute Category
‘ Cost L]
& Add Filter
Optional Attribute € (® Create New Wildcard Group (=) Delete Wildcard Group
Insert Wildcard Group 1 at cursor position

Save

A captura de tela a seguir mostra os trés atributos com o caractere coringa grupo 1.
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Edit Filters

Hide Wildcard Groups €
¥ Attribute Name Group Name Group Usage

‘ Group 1 & Group 1 .Capacity
& Group 1 .PWR
Attribute Category & Group 1 .RollingCost

| Group 1 x .RollingCost

‘ Cost v

® Add Filter

Optional Attribute @ (#) Create New Wildcard Group

Save

12. Cligue em Save.

Select Data > Modify View > Publish
@ Source Assets T Search Shape + Matches

Server CASTINT-CL . T Asset Shape Found 4 Matches
4 @ Atlanta
4 @ cCalot

» [ Atlanta
Database Datacenter Demo

4]
-

» @ Atlanta
@ Assets

& |Group 1 .Capacity » @ Atlanta

4 e Data Centers =

& Group1 PWR » @ Atlanta

4 eAmericas
4 [ Atlanta

| » ) Colot

» @ Colo2

L S W
XX X X X

4 Group 1 RollingCost

» ) Colo3
» B Chicago
r e Houston

» 6D New York -

Attributes | ®

O select All

3

4 ColoNumber

4 Zone! .Capacity

4 Zonel.CapacityPercent
4 Zonel.DCIE

& ZonelPUE

& Zonel PWR

4 ZonelRollingCost

eoecocCeQOoQQOQ

4

Ao usar o caractere coringa de grupo, as quatro correspondéncias mostram os atributos Zonel, Zone2,
Zone3 e Zone4 agrupados conjuntamente.
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v Matches

Found 4 Matches
4 @ Atlanta
4 @ Colo
& Zoned Capacity
& Zoned PWR
& Zone4 Rol ngCost
4 @ Atlanta
4 @ Colo
L 4 Zone3.Capacity
# Zone3a PWR
& Zone3 Rol ngCost
4 @ Atlanta
4 @ Colo
L 4 Zone2 Capacity
& Zone2 PWR
4 Zone2 RollingCost
4 @ Atlanta
4 [ colat
L 4 Zonel.Capacity
& ZonelPWR

& ZonelRollingCost

A pagina Modificar View

Pl Integrator for Business Analytics
Como usar o Pl Integrator for Business Analytics

Na pagina Modificar View, especifique o esquema a ser usado para enviar mensagens e especificar quando as
mensagens sdo enviadas. Como opgao, é possivel excluir dados e recarregar dados de um periodo anterior. A
captura de tela a seguir identifica os diferentes painéis e as fungGes e recursos principais.
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Select Data > Modify View > Publish Next
T Shapes o’ Message Designer @) Preview @

To Asset Shape Preview Start Time

| Schema Options ” Message Trigger ” Backfill Data ” Message Filters |
4 @ colol S X L ‘
& ColoNu.. & x You@cing yoursch@he asset sha@)\aﬂattened 3@. Preview End Time
0 Zonel.. 4 % Import Schema Select Schema Structure ) ‘
® Zonel.. & x | Select Import Source v| | Sync to Asset Shape (Flattened) v| {
"Colol": "Colol",
€ Zonel.. & x “ColoNumber™: "1.664574",
Save Schema to Registry "Zonel.Capacity™: "162",
"Zonel.CapacityPercent™: 171.21975703007812,
"Zonel.DCiE": "38.5215",
{ @ "Times‘tamp": "2@18-19-29T81:51:56.8603267-87:0¢
"Colol": "[& Colo1 (Name) v, & ‘}["
“ColoNumber™: "[4 ColoNumber (Valug) v, & "Colol": "Colol”,
"ColoMumber”: "1
"Zonel.Capacity”: "|O Zone1.Capacity (Value) v |"J & "Zonel.Capacity”
"Zonel.CapacityPercent™: 172.82561950683594,
N "Zonel,.CapacityPercent”: "|0 Zone1.CapacityPercent (Value) v 4 "Zonel.DCiE™: "37.82698",
"Timestamp”: “2018-18-29T@1:52:56.8603267-87:0¢
“Zonel.DCiE": |4 ZonelDCIE (Value) v, Vi 1
"Timestamp”: "|® TimeStamp v 4 ¢ "Colol": "Colol”,
"ColoMumber™: "
3 "Zonel.Capacity™: "
"Zonel.CapacityPercent™: 173.21989440891797,
"Zonel.DCiE": "37.55756",
"Timestamp”: " a7:e¢
b
{
"Colol": "Colol",
"ColoMumber™: "1.67812",
© Add Prope Schema "Zonel.Capacity": "162",
"ZFanael FanaritwPercent”: 177 7A73IA?AAACAARRR

Numero Descricao

1 Formato do ativo — é possivel arrastar e soltar
elementos e atributos do formato até as propriedades
do esquema no painel Designer de mensagem.

2 Designer de mensagem — neste painel, vocé seleciona
0 esquema, especifica o gatilho de mensagem,
modifica propriedades do esquema e recarrega dados.

3 Visualizar — exibe as primeiras 100 mensagens no
formato do esquema exibido no painel Designer de
mensagem.

4 Esquema — exibe o esquema usado para enviar
mensagens.

5 Opcoes de esquema — seleciona o esquema usado
para enviar mensagens. E possivel usar um esquema
gerado com base no formato do ativo ou importar um
esquema de um arquivo ou de um registro.

6 Modificar as propriedades do esquema, alterar a
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Numero Descrigao

ordem das propriedades do esquema ou excluir as
propriedades do esquema. Nem todas as opcdes estdo
disponiveis com todos os tipos de esquema.

7 Gatilho de mensagem — especifica a frequéncia e as
condi¢Ges em que uma mensagem é enviada ao
destino de publicacao.

8 Dados de recarga de dados histéricos — especifica
valores anteriores a serem enviados ao destino de
publicacdo.

9 Filtros de mensagem — especifica os resultados de

dados a serem excluidos.

Para obter informacgdes sobre como concluir as tarefas na pagina Modificar View, consulte o seguinte:

¢ Use um esquema importado de um arquivo

¢ Use um esquema importado de um registro do esquema
e Usar um esquema gerado

¢ Configurar quando mensagens sao enviadas

e Dados de recarga de dados histéricos

Sobre esquemas

Nota: este recurso esta disponivel na edicdo Advanced do Pl Integrator for Business Analytics.

e Por padrio, o formato de busca é usado para gerar o esquema para as mensagens de streaming. E possivel
usar este esquema gerado ou importar um esquema, e os valores de dados do formato serao atribuidos ao
esquema.

Esquemas importados

Os esquemas podem ser importados de um arquivo ou de um registro do esquema.

e Esquemas importados de um arquivo — os esquemas nos formatos a seguir podem ser importados de um
arquivo: notag¢do de objeto JavaScript (JSON), valores separados por virgula (CSV) e Apache Avro. Uma vez
importados, vocé atribui valores as propriedades e as edita.

¢ Esquemas importados de um registro do esquema — esta versao suporta o Registro do esquema confluente
usando os esquemas do Apache Avro.

¢ Os esquemas do Avro importados do registro do esquema impdem regras rigorosas. Uma vez importados, o
nome da propriedade e o tipo de dado sdo definidos com base no nome e no tipo de campo do Avro,
respectivamente, e estes ndo podem ser alterados. Se qualquer uma das opc¢des a seguir for verdadeira, a
view ndo sera publicada

¢ Um valor ndo é atribuido a uma propriedade
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¢ Uma propriedade tem uma incompatibilidade de tipo, e 0 campo do Avro correspondente ndo suporta o
tipo nulo

¢ Se houver uma incompatibilidade de tipo e o campo do Avro suportar o tipo nulo, a view serd publicada, mas
0 campo sera omitido.

Esquemas gerados

Os esquemas gerados sdo sincronizados com o formato do ativo em uma estrutura aninhada, mesclada ou de
forma livre. Os nomes de propriedades do esquema correspondem aos nomes do ativo e do atributo no formato.
O valor da propriedade é preenchido com os valores de dados do ativo relacionado ou do atributo do formato.
No modo Mesclado, o esquema é exibido em uma estrutura nao hierarquica. No modo Aninhado, a hierarquia
do esquema é preservada. Os esquemas Mesclado e Aninhado permitem alterar os nomes das propriedades, os
valores associados a elas e os tipos de dados. Vocé pode pegar um esquema aninhado ou mesclado e
transformd-lo em um esquema de forma livre. O esquema de forma livre da a vocé flexibilidade maxima para
modifica-lo. Além de poder fazer tudo o que quiser com um esquema mesclado ou aninhado, vocé também
pode fazer altera¢des nas propriedades adicionando, excluindo e reordenando as propriedades.

Use um esquema importado de um arquivo

Leia Sobre esquemas para obter informacdes sobre as diferentes maneiras de usar um esquema.

1. No painel Designer de mensagem, clique em Opg¢odes de esquema.
2. Clique em Selecionar Esquema e escolha Arquivo.
Na janela Abrir, selecione o arquivo do esquema e clique em Abrir.

Os esquemas nos seguintes formatos sao suportados: JSON, CSV e Apache Avro. Os arquivos devem ter uma
extensao .json, .csv ou .avsc para serem exibidos no Designer de mensagem.

4. Atribua o valor as propriedades do esquema usando um dos métodos a seguir:
¢ Arraste um ativo ou atributo do formato do ativo para o esquema.

¢ Clique no icone de lapis para abrir a janela Editar propriedade. Selecione um ativo ou atributo da forma
e, em seguida, escolha um valor d a lista Contetido dos dados da propriedade. Clique em Atualizar
propriedade.

5. Arraste e solte uma propriedade do esquema para mové-la a um lugar diferente.
6. Clique no x para excluir a propriedade do esquema.

Cligue em Adicionar propriedade ao esquema no canto inferior esquerdo para adicionar uma propriedade
do esquema.

a. Insira o nome da propriedade e clique em Confirmar.

b. Atribua um valor a propriedade arrastando um atributo do formato do ativo ou clique no icone do <

8. Continue com o proximo procedimento Configurar quando mensagens sao enviadas.

Use um esquema importado de um registro do esquema

Leia Sobre esquemas para obter informacgdes sobre as diferentes maneiras de usar um esquema.
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No painel Designer de mensagem, clique em Opg¢des de esquema.
Clique em Selecionar Importar Esquema e escolha Registro do Esquema.

Selecione o esquema em Navegador do registro de esquema e clique em Usar esquema selecionado.

.

Atribua o valor as propriedades do esquema usando um dos métodos a seguir:
e Arraste um ativo ou atributo do formato do ativo para o esquema.

¢ Clique noicone de lapis para abrir a janela Editar propriedade, escolha um ativo ou atributo no formato
e, em seguida, escolha um valor na lista Contetido dos dados da propriedade. Clique em Atualizar
propriedade.

Antes de poder continuar e publicar sua view, vocé deve fornecer valores validos para todas as propriedades
em seu esquema. Os esquemas do Avro importados do registro do esquema impdem regras rigorosas. O
nome e o tipo de dado ndo podem ser alterados. Se houver uma incompatibilidade de tipo de dado entre o
esquema e o valor selecionado, o Pl Integrator for Business Analytics tentara uma conversdo de tipo de dado.
Se nao for possivel converter o tipo de dado, valores nulos aparecerdo para essa propriedade. Verifique o
painel Visualizar para ver se ha valores nulos. E necessario resolver todos os valores digitados
incorretamente. Se houver valores nao resolvidos, a view nao sera publicada. A exce¢do a isso é se o
esquema permitir nulos; nesse caso, as incompatibilidades de tipo de dado nao resolvidas nao terdo que ser
resolvidas e vocé podera publicar sua view.

5. Continue com o préximo procedimento Configurar quando mensagens sao enviadas.

Usar um esquema gerado

Leia Sobre esquemas para obter informacdes sobre as diferentes maneiras de usar um esquema.

1. No painel Designer de mensagem, clique em Opg¢oes de esquema.

Por padrdo, o esquema que aparece é sincronizado com o formato do ativo e exibido em uma estrutura
mesclada.

2. Cligue em Selecionar estrutura do esquema e escolha uma das opcées.
¢ Sincronizar ao formato do ativo (plano) — o esquema é exibido em uma estrutura nao hierarquica.
¢ Sincronizar ao formato do ativo (aninhado) — a hierarquia do esquema é preservada.
¢ Forma livre — a forma livre é aplicada a hierarquia que estiver exibida (aninhada ou plana) no momento.

0 esquema exibe as propriedades com os valores de dados dos ativos e atributos do formato atribuidos. E
possivel escolher um valor de propriedade diferente em uma lista de todas as propriedades disponiveis para
o elemento ou o atributo do Pl AF.

3. Para atribuir um valor diferente a propriedade do esquema, clique na seta e selecione uma propriedade na
lista.

4. Para fazer outras alteragdes na propriedade do esquema, clique no icone de lapis para abrir a janela Editar
propriedade.

Nota: E possivel, por exemplo, fazer alteracdes no nome da propriedade do esquema ou no tipo de dado
padrdo da propriedade.

5. (Somente esquema de forma livre) Arraste e solte a propriedade do esquema para mové-la a um lugar
diferente.

Dica: propriedades no mesmo nivel de hierarquia ndo podem ser reorganizadas. Uma propriedade somente
pode ser movida para ser o filho de um diferente pai.
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Todas as propriedades filhas de um determinado pai devem possuir nomes exclusivos. A descida é rejeitada
sempre que viole esta regra.

(Somente esquema de forma livre) Clique no x para excluir a propriedade do esquema.
(Somente esquema de forma livre) Clique em Adicionar propriedade ao esquema no canto inferior
esquerdo para adicionar uma propriedade do esquema.

8. Continue com o préoximo procedimento Configurar quando mensagens sao enviadas.

Usar filtros para refinar o formato da view

Na pagina Selecionar Dados, costuma-se comegar adicionando um Unico ativo ou event frame ao formato da
busca. Assim, é possivel usar filtros para estender esse formato para outros ativos ou event frames. Clique no

-

icone s para abrir a caixa de dialogo Editar Filtros. A captura de tela a seguir é a caixa de didlogo Editar Filtros
para um formato de view de ativo.

Nota: O exemplo desta sec¢do trata dos filtros de edicdo para um formato de view de ativo. Os filtros de event
frame tém condigdes com nomes semelhantes, e o comportamento dos filtros € o mesmo dos filtros de view de
ativo.

Caixa de didlogo Editar Filtros para um formato de view de ativo

Edit Filters

¥ Asset Name @J

MS301:Anne Morth:T1

o —_— ¥ Asset Template @_)

M5 Transformer r

Asset Category @

MS Transformer r

(¥ Add Filter

A captura de tela identifica o filtro e as condi¢Ges que o compdem.

Numero Descrigao
1 Exemplo de um filtro de view de ativo
2 Condicdo Asset Name (Nome do Ativo)

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 145



'AV EVA\TM Pl Integrator for Business Analytics

Como usar o Pl Integrator for Business Analytics

Numero Descrigao
3 Condicdo Asset Template (Modelo do Ativo)
4 Condicdo Asset Category (Categoria do Ativo)

E possivel fazer uma busca com base em uma ou mais dessas condi¢des. Todas as condigdes selecionadas
precisam ser cumpridas para que seja considerada uma correspondéncia. Por exemplo, na captura de tela, o
Asset Name (Nome do Ativo) e o Asset Template (Modelo do Ativo) estdo selecionados, e ambas as condi¢Ges
precisam ser cumpridas para que se encontre uma correspondéncia. Somente os ativos cujo nome for
MS301:Anne North:T1 e que forem baseados no modelo MS Transformer aparecerdo no painel
Correspondéncias.

Para views de evento, as condic¢des de filtro sdo chamadas Event Name (Nome do Evento), Event Template
(Modelo do Evento) e Event Category (Categoria do Evento). Entretanto, o comportamento dos filtros é o
mesmo dos filtros de view de ativo.

E possivel expandir a busca para incluir mais correspondéncias possiveis adicionando filtros. Basta clicar no sinal
de mais (+) para adicionar outro conjunto de filtros.

Nota: use a barra de rolagem para descer a tela e ver filtros adicionais.

Cada filtro consiste em um conjunto de condi¢des de Asset Name (Nome do Ativo), Asset Template (Modelo do
Ativo) e Asset Category (Categoria do Ativo) que funcionam como condig¢des E. Cada condigao selecionada no
filtro precisa corresponder para que um ativo seja considerado uma correspondéncia.

Se houver dois ou mais filtros, as condi¢des de qualquer um dos filtros precisarao ser cumpridas para que um
ativo seja considerado uma correspondéncia.

Retornando ao exemplo, um segundo conjunto de filtros é adicionado, e a condi¢dao Asset Name (Nome do Ativo)
é configurada como DrillBit*.

Segundo filtro na view de ativo
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Edit Filters

¥ Asset Name -

DrillEit*

Asset Template

ElementTemplate r

Asset Category

(=) Remove Filter

(+) Add Filter

O servico Pl Integrator Framework busca no Pl AF Server:

¢ Usando o primeiro filtro, ele procura todos os ativos cujo nome for MS301:Anne North:T1 e que forem
baseados no modelo MS Transformer.

¢ Usando o segundo filtro, ele procura todos os ativos cujo nome comecarem com DrillBit.

A busca retornara todos os ativos que cumprirem qualquer uma dessas condi¢Ges. Portanto, varios filtros
funcionam como filtro OU.

Modificar os dados nas views de ativos e de eventos

Nota: é possivel fazer alteragdes a uma view publicada. Para obter mais informag¢des sobre como modificar uma
view publicada, consulte Modificar uma view

Antes de publicar uma view, é possivel refinar seus resultados de dados, incluindo:

¢ Alterar como seus dados sdo recuperados

E possivel ajustar o intervalo de amostragem ou escolher usar uma coluna principal para organizar os dados
na view. Consulte Opcdes de recuperacao de dados para obter informacgdes sobre as diferentes formas pelas
guais os dados podem ser recuperados e quais opgoes produzirdo as representacdes de dados desejadas.
Para obter mais informacgGes sobre como especificar o método de recuperagdo de dados nas views, consulte
Ajuste como os valores sao recuperados.

¢ Adicionar colunas de dados que exibem informacdes de atributo
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Consulte Adicionar uma coluna de dados para obter mais informacoes.

¢ Adicionar uma coluna de tempo que exibe os dados de tempo em um formato diferente
Consulte Adicionar uma coluna de tempo para obter mais informacgdes.

e Modificar uma coluna
Consulte Modificar uma coluna para obter mais informacdes.

¢ Filtrar os dados em uma view

Consulte Filtrar os dados para obter mais informacdes.

Opcdes de recuperacao de dados

Vocé pode controlar como os dados sdo recuperados dentro da sua view ajustando o intervalo de amostragem
ou organizando os dados baseados em um atributo como uma coluna-chave.

e Em uma view com ativos, os dados sdo recuperados em uma das formas seguintes:
¢ uniformemente espacados no tempo (também conhecido como interpolados)
¢ baseados em um tempo de atributo referencial (também conhecido como comprimidos)

¢ Timestamps sdo obtidos do atributo de referéncia; dependendo da op¢do escolhida, todos os outros

serao interpolados ou receberdao um valor nulo se ndao houver nenhum valor para esse atributo no
timestamp exato.

e Em uma view para eventos, os dados sdo alinhados por estruturas de eventos e sdo formatados em uma das
formas seguintes:

e um relatdrio analitico para cada evento. Isso é ideal para diagramas de Pareto.

¢ Um diagrama de Pareto mostra tanto barras quanto uma linha. Os valores individuais sdo representados
por barras com barras mais longas a esquerda. A execugdo total é representada pela linha.
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Ajuste como os valores sao recuperados

1. Na pagina Minhas Views, selecione a view que vocé deseja modificar e clique em Modificar View. Em
seguida, clique em Préximo para abrir a pagina Modificar View.

Nota: caso vocé ja esteja na pagina Modificar view, pule para a préxima etapa.

2. Cligue em Editar Modo de Valor e escolha como vocé deseja que os seus dados sejam relatados:

¢ (Somente views de evento) Valores Totalizados retorna uma linha por event frame dentro do quadro
geral de tempo especificado para a view de evento. Use esta opc¢do para gerar resultados que podem ser
exibidos em um diagrama de Pareto. A opgao Valores Totalizados aparecera somente se vocé estiver
modificando uma view de evento.

Valores Totalizados
Edit Value Mode

* Summarized Values

Sampled Values

Save Changes

Os valores totalizados sdo valores de event frame que vocé visualizada no Pl System Explorer. Por padrao,
esse é o valor da tag do PI no final do event frame.

"

Nota: O valor do event frame é configurado no Pl System Explorer no nivel de atributo. O parametro Por
Intervalo de Tempo na caixa de didlogo Referéncia de Dados da Tag do PI, mostrada abaixo, é o local em
que o método de recuperacao de valores é configurado.
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() Attribute: |

Lnit of Measure

S

Value retrieval methods

By Time: |Automaﬁc

Relative time: |

By Time Range: | End Time

Calculation basis: Time Weighted

Min percent good: a0

Read only

O Pl Integrator for Business Analytics ndo suporta o método de recuperacdo de valores Por tempo
configurado como Néo suportado. Para obter mais informacdes, consulte o informativo Os valores de
calculo resumido dos Event Frames do Integrador estdo em branco.

¢ Amostrar valores a cada altera o intervalo de amostragem para que um valor seja interpolado no
intervalo de tempo especificado, por exemplo, a cada 15 minutos.

Amostrar valores a cada

Edit Value Mode

) Summarized Values

® Sampled Values

® Sample values every | 1+ || minutes =

® |nterpolate €@
O Exact ©®

© Use Key Column | cdi158 v
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Clique em Amostrar valores a cada e configure o intervalo de tempo:

¢ Interpolar sempre retorna um valor no intervalo de tempo especificado, interpolando valores
conforme necessario.

Exato retorna os valores, caso existem, no intervalo de tempo especificado. Se nenhum valor existe,
retornar nulo.

¢ Usar Coluna-Chave usa um atributo para organizar como os dados sado interpolados.
Usar Coluna-Chave

Edit Value Mode

Summarized Values

* Sampled Values

Sample values every | 1+ || minutes =

* Use Key Column | cdt158 »
® Interpolate @
Exact @

Interpolar encontra os valores da coluna-chave em suas timestamps registradas. Os valores para as
outras colunas sao interpolados nas mesmas timestamps da coluna.

Escolha o atributo e, em seguida, escolha uma das opcdes seguintes:

¢ Exato encontra os valores da coluna-chave em suas timestamps registradas. Se um valor ndo existir

nessas timestamps registradas para as outras colunas, entdo, um valor nulo serd retornado.
3. Cligue em Salvar Alteragées.

Como os dados resumidos sao calculados

Na pagina Modificar View, é possivel adicionar uma coluna com dados resumidos para qualquer coluna numérica
em sua view. Os seguintes sdo exemplos dos valores calculados que vocé pode especificar:

¢ Total — total de todos os valores para o intervalo

e Meédia — média de todos os valores para o intervalo

¢ Minimo — valor minimo no intervalo

e Maximo — valor maximo no intervalo

e Alcance — valor maximo no intervalo menos o valor minimo no intervalo
O intervalo é determinado com o uso de timestamps na view:

¢ O horario inicial é o timestamp da linha anterior
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¢ O horario final é o timestamp da linha atual

A captura de tela e a tabela abaixo ilustram a relagdo entre os timestamps e os valores calculados. Nesse
exemplo, foram adicionadas duas colunas, Volume 1 - Minimum (Volume 1 - Minimo) e Volume 1 - Average
(Volume 1 - Média). Ambas sdao baseadas na coluna Volume 1. A linha atual é a linha cujo timestamp marca o
fim do intervalo de tempo. O timestamp da linha anterior marca o inicio do intervalo de tempo. Volume 1 -
Minimum (Volume 1 - Minimo) toma todos os valores de dados entre esses dois horarios, encontra o valor
minimo e preenche a coluna Volume 1 - Minimum (Volume 1 - Minimo) para a linha atual (ou seja, a linha do
hordrio final). De forma semelhante, ele calcula o valor para a coluna Volume 1 - Average (Volume 1 - Média)
fazendo a média dos valores do Volume 1 entre o horario inicial e o horario final e preenche a coluna Volume 1 -
Average (Volume 1 - Média) para a linha atual.

— Asset View 1

Select Data > Modify View > Publish

Y Edit Row Filters 3= Edit Value Mode

0 Row Filters

o Add Column

& columns

Interpolated Values

Every 1 minute

TimeStamp

Volume1

Volume1 - Minimum

Volume - Average

2072017 6:12:04.514 AM
2/10/2017 6:14:04.514 AM
2M0/2017 6:15:04.514 AM
2M10/2017 6:16:04.514 AM @
2072017 6:17:04.514 AM @J
2/10/2017 6:18:04.514 AM
2M10/2017 6:19:04.514 AM
2M10/2017 6:20:04.514 AM

45.5642967224121
45.1628189086914
44.7613410949707
44.35986328125

43.9583892822266
43.5569114685059
43.1554336547852
42 7539596557617

45.5642949855283
45.1628183669969
44 7613417484654
44.359865129934

43.9583885114025 )

43.556911892871
43.1554352743396
42 7539586558081

45.7650332947941
45.3635566762626
44.9620800577311
44.5606034391997
44.1591268206682
43.7576502021368
43.3561735836053
42.9546969650738

Numero Descrigao

1 Horario inicial do intervalo

2 Horario final do intervalo

3 Volume minimo no intervalo entre os horarios inicial e
final

4 Média dos volumes no intervalo entre os horarios
inicial e final

5 Linha atual

Para obter informagdes sobre como adicionar uma coluna de dados resumidos, consulte Adicionar uma coluna

de dados.

Adicionar uma coluna de dados

E possivel adicionar colunas de dados com informagdes de atributo.
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1. Na pagina Minhas Views, selecione a view que vocé deseja modificar e clique em Modificar View. Em
seguida, cliqgue em Préximo para abrir a pagina Modificar View.

Nota: caso vocé ja esteja na pagina Modificar view, pule para a préxima etapa.

2. Clique em Adicionar Coluna.

3. Cligue na guia Coluna de Dados e selecione o atributo que é a fonte de dados.

Add Column

ata Column Time Column

Select Column Data Source

F @ Floo*
e Column Name
A Any
|Unic:|L.eCo|umr*Nar‘1e |
4 @ vav

Use Default Name

& Terminal Load

& Cold Deck Damper Pasiticn Column Data Content @
Health Status |‘-.fa|L|-& hd |
& Hot Deck Damper Position
ata Type
Latitude
~  [Double v |
=l

b i

Add Column

4. Dé um nome Unico a coluna.
Defina um calculo (por exemplo, uma média) sobre o atributo no campo Contetido dos Dados da Coluna.

Nota: A fungdo Last Recorded Value é usada com dados que ndao devem ser interpolados, por exemplo, um
atributo de status que estd ativado ou desativado. O Last Recorded Value faz uma consulta retroativa e
retorna o valor mais recente da alteragao no atributo de status.

(Opcional) Altere o tipo de dado no campo Tipo de Dados.

7. Clique em Adicionar Coluna.

Adicionar uma coluna de tempo

Use Coluna de Tempo para exibir informacgdes sobre o tempo adicionais para suas views.

Nota: Algumas etapas variam dependendo se vocé esta criando uma view com ativos ou uma view para eventos.
No local em que o procedimento varia, a etapa é registrada com o tipo de view a qual se aplica.

1. Na pagina Minhas Views, selecione a view que vocé deseja modificar e clique em Modificar View. Em
seguida, clique em Préximo para abrir a pagina Modificar View.

Nota: caso vocé ja esteja na pagina Modificar view, pule para a préxima etapa.

2. Clique em Adicionar Coluna.

3. (Views com Ativos) Clique na guia Coluna de Tempo.
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Use Coluna de Tempo para adicionar colunas que exibem seus dados de timestamp em um formato
diferente.

Add Column

Select Time Column Options for

Data Column Time Column

Year (2016)

b.

C.

Maonth

Month Name
Week of the Year
Day

Day of the Week
Hour

Minute

Second
Milliseconds

UTC Seconds
UTC Milliseconds
Ticks

Time Zone Offset

ocal

GMT

+ 1

TimeStamp

Display 1time column

Na lista Selecionar Opgoes de Coluna de Tempo para, selecione cada hora local na Hora Média de

Greenwich (GMT).

Por exemplo, se vocé escolher Hora e GMT, essa selecdo adicionara uma coluna a sua view que exibira

apenas a hora do seu ponto Pl na hora GMT.

Selecione uma unidade de tempo na coluna da esquerda e clique na seta da direita.

Ao finalizar esse procedimento, clique no botado Exibir coluna de tempo.

(Views para Eventos) Clique na guia Coluna de tempo.

A lista Selecionar Opg¢des de Coluna de Tempo para exibe um dado relacionado ao tempo diferente que
vocé pode exibir na view para eventos, inclusive a hora de inicio e a hora de término da estrutura de evento.
E possivel exibir essa hora na hora local do computador que esta rodando o Servico Pl Integrator Framework

ou a Hora Média de Greenwich (GMT).
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Add Column
Data Column Time Column
Select Time Column Options for | Local v
Year fl(_gor\j;-'ll tStamp
Month :Sta
on Event Frame Local Start Time amp
Month Name Event Frame Local End Time Stamp
Week of the Year Event Frame GMT Start Time
Day Event Frame GMT End Time
Day of the Week (wednesds Event Frame Duration
Hour Event Frame Relative Time
Minute
Second
Milliseconds

UTC Seconds
UTC Milliseconds
Ticks

Time Zone Offset

Display 4 time columns

a. Na lista Selecionar Opgoes de Coluna de Tempo para, selecione os dados que vocé deseja exibir em sua
view.

A tabela a seguir descreve os tempos diferentes que podem ser exibidos em sua view.

Opgoes da lista Descricao

Local Ao usar valores amostrados, timestamp dos dados
na hora local. Ao usar valores totalizados, este
tempo é a Hora de término local da estrutura de
evento.

GMT Ao usar valores amostrados, timestamp dos dados
na hora GMT. Ao usar valores totalizados, este
tempo é a Hora de término GMT da estrutura de

evento.
Hora inicial local da estrutura de evento Hora de inicio da estrutura de evento na hora local.
Hora de término local da estrutura de evento Hora de término da estrutura de evento na hora
local.
Hora de inicio GMT da estrutura de evento Hora de inicio da estrutura de evento na hora GMT.
Hora de término GMT da estrutura de evento Hora de término da estrutura de evento em hora
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Opg¢oes da lista Descri¢ao
GMT
Duragao do event frame Hora de término da estrutura de evento — (menos)

hora de inicio da estrutura de evento.

Tempo relativo do event frame Tempo de registro — (menos) hora de inicio da
estrutura de evento.

5. Selecione a unidade de tempo na coluna da esquerda e clique na seta da direita.

Por exemplo, se vocé selecionar Hora inicial local da estrutura de evento e Hora, essa selecdo adicionara
uma coluna apenas com a hora de inicio da estrutura de evento no formato de hora local.

6. Ao finalizar esse procedimento, clique no botdo Exibir coluna de tempo.

Modificar uma coluna

Vocé pode renomear uma coluna, definir um calculo como uma média dos valores na coluna, alterar o tipo de
dados, alterar a unidade de medida ou remover a coluna.

1. Cligque na coluna para abrir o painel Detalhes da Coluna.

¢ O Pl Integrator Framework reserva as strings com diferenciacdo entre maidsculas e minusculas, ID,
PlIntTSTicks e PlintShapeld, como nomes de coluna. E possivel usar essas strings para nomear colunas nas
views de ativos e eventos. Entretanto, se isso for feito, um sublinhado (_) sera anexado ao nome da coluna
nos dados de destino, por exemplo, ID_ou Id_.

Nota: Esta restricdo ndo se aplica aos seguintes destinos: Amazon Kinesis Data Streams, Amazon S3, Apache
Kafka, Azure Event Hubs, Azure loT Hub, Google Cloud Storage, Google Pub/Sub, Hadoop Distributed File
Storage e Text File.

¢ Os nomes de colunas sdo reformatados com base nas limitacGes de cada armazenamento de destino. Por
exemplo, os nomes de colunas do Oracle sao limitados a 30 caracteres e os nomes de colunas com mais de
30 caracteres sao truncados.

e Os destinos de bancos de dados Oracle tém strings reservadas; se essas strings aparecerem nos nomes de
colunas, um sublinhado (_) serd anexado a string.

e Os nomes da coluna devem ser exclusivos.

¢ Afuncdo Last Recorded Value no campo Contetido de Dados é usada com dados que ndao devem ser
interpolados, por exemplo, um atributo de status que estd ativado ou desativado. O Last Recorded Value faz
uma consulta retroativa e retorna o valor mais recente da alteracdo no atributo de status.
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@ Column Details

MName

Forecasted Chance of Rain |

Reset Name to Default

Data Content 0

VEINE v |

Data Type

Double v |

Remove

Apply Changes

1. Faga quaisquer alteragGes a coluna.

2. Quando tiver concluido, clique em Aplicar AlteragGes.

Filtrar os dados

E possivel filtrar os dados em uma visualizacdo usando varios parametros. Por exemplo, é possivel especificar
gue deseja incluir linhas se os conteddos da coluna incluirem um valor numérico em particular ou
corresponderem a um padrdo de string.

Ao aplicar um filtro, o Pl Integrator pega o conjunto de dados que corresponde ao formato do seu ativo, une-o ao
conjunto de dados que corresponde ao seu filtro e produz o subconjunto de dados que satisfaz ambos os
critérios.

1. Na pagina Minhas Views, selecione a view que vocé deseja modificar e clique em Modificar View. Em
seguida, clique em Préximo para abrir a pagina Modificar View.

Nota: caso vocé ja esteja na pagina Modificar view, pule para a préxima etapa.

2. Cligue em Editar Filtros de Linha e escolha o tipo de filtro que deseja.

Nota: os filtros mais usados sao filtros numéricos e de string.

Os filtros de estrutura de evento aplicam-se apenas a views com ativos. Portanto, se vocé estiver criando
uma view de evento, esse tipo de filtro ndo aparecerd como uma opg¢ao.
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Row Filters x

Add New Row Filter

String Include rows based on whether the contents of a column match a
string pattern
Diqit Include rows based on whether the contents of a column contain
- certain digital values
NuUmeric Include rows based on whether the contents of a column contain
certain numeric values
. Include rows where the contents of a column contain a value
Mull Values
Include rows where certain Event Frames are active
Event Frame

Close

Para mais informacgdes sobre a aplicagao de um filtro Estrutura de evento, consulte Filtro por estruturas de
evento.

Quando tiver terminado de definir o filtro, clique no botao Salvar.

4. Na caixa de dialogo Filtro de Registros, clique em Fechar.

Filtro por estruturas de evento

O procedimento a seguir mostra como aplicar um filtro de linha de estrutura de evento a uma view com ativos.

Nota: A filtragem por estruturas de evento aplica-se apenas a views com ativos.

Ao definir um formato de ativo, vocé cria uma colec¢do de correspondéncias que atende aos mesmos critérios. Ao
aplicar um filtro de estrutura de evento a essa view, vocé define um formato de evento que cria uma colecdo de
correspondéncias para um conjunto de estruturas de evento. O Pl Integrator, entdo, une essas duas colecbes
com base em um ativo comum para obter o subconjunto de dados que corresponde a ambas as cole¢des.

Por exemplo, supondo que vocé tenha um nimero de fontes em que uma determinada parte do equipamento
estd rodando uma por vez em cada fonte e que as estruturas de evento sejam usadas para registrar os dados
coletados por esse equipamento. Cada estrutura de evento tem uma hora de inicio e hora de término diferentes
e aplica-se a uma fonte diferente. E possivel usar os filtros de registros da estrutura de evento para incluir dados
de view com ativos do container apenas durante o periodo de funcionamento do equipamento no container.

1. Na pagina Minhas Views, selecione a view que vocé deseja modificar e clique em Modificar View. Em
seguida, clique em Préximo para abrir a pagina Modificar View.
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Nota: caso vocé ja esteja na pagina Modificar view, pule para a préxima etapa.

2. Use os campos Hora de inicio e Hora de término para ajustar o intervalo de tempo de modo a incluir as
horas em que as estruturas de evento de interesse foram registradas.

Nota: caso os tempos de inicio e final estejam fora do intervalo de tempo do event frame, nenhum event
frame sera encontrado.

3. Clique em Editar Filtros de Linha e escolha Estrutura de Evento para o tipo de filtro.

O Pl Integrator agora pesquisa event frames em seu banco de dados do Pl AF para essa view e exibe um
subconjunto daquelas encontradas.

Create New Event Frame Row Filter

Event Frames _ Shape Tree

4 [ Catalytic Cracking
i Erames Palette here 4 () Boiler-210
» ¥4 Casing Temperature Excursion Rog T & Feed Rate

» ¥4 Casing Temperature Excursion Roc & Fuel Gas Flow
3 v

» "d Casing Temperature Excursion Roc & Fuel Gas Volume
» " Casing Temperature Excursion Roc
» "§ Casing Temperature Excursion Roc
» "§ Casing Temperature Excursion Roc
» ' Casing Temperature Excursion Roc
» " Casing Temperature Excursion Roc
» "§ Casing Temperature Excursion Roc

» "§ Casing Temperature Excursion Roc ¥

Event Frame Related Asset Start Time E|

4. Clique no icone Y para abrir o menu. Clique no suporte triangular voltado para direita (>) em uma das
categorias de filtragem para abrir o painel relacionado.

Y

Nos campos de filtragem, especifique os parametros para restringir as estruturas de evento a fim de
encontrar aquelas que vocés esta procurando. Por exemplo, insira um string com padrao correspondente no
campo Nome do Evento ou selecione um modelo em Template de Evento.
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Event Frames

ki

Event Name

Event Template

Clear All Filters Apply Filters

Clique em Aplicar Filtros.
6. A partir das estruturas de evento encontradas, arraste uma estrutura de evento para o painel central.
Agora o filtro inclui linhas para as quais essa estrutura de evento estd ativa.

7. Opcionalmente, vocé pode ampliar os critérios de pesquisa de filtro de linha para incluir todas as estruturas
de evento com o mesmo modelo ou categoria. Para fazer isto, use a lista suspensa para alterar a pesquisa de
Nome do Evento para Template de Evento ou Categorias de Evento.

Create New Event Frame Row Filter

Event Frames [ ? | ‘ Include rows with this Event Frame Active
matches |EventFrameAnalysis 20150612 01:46:32 X

Event Name

EventFrameAnalysis 20150612 01:46:32
EventFrameAnalysis 20150612 01:46:32

EventFrameAnalysis 20150612 01:46:32
EventFrameAnalysis 20150612 01:46:32
FuantFrameafAnalsic 201RNART? M14R-37

v

O Pl Integrator busca os event frames correspondentes e os mostra no painel de visualizagdo na parte
inferior da janela.

F ¥ ¥ ¥ ¥
R -

8. Cligue noicone proximo a condicdo do evento.

9. Para alinhar as estruturas de evento com o ativo correto, arraste o ativo ou atributo da Arvore de Formatos
para os critérios de filtro.

Esta etapa define a relagdo entre os dois conjuntos de dados (o conjunto de dados de estrutura de evento e
o conjunto de dados de ativos e atributos). Isso é semelhante a disposicdo em uma mescla de tabela
relacional que equipara um atributo em uma tabela (ou conjunto de dados) a um atributo na outra tabela
(conjunto de dados). Aqui, equipara-se o ativo "que possui" a estrutura de evento ao ativo a partir de seu
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Arvore de Formatos.
O Pl Integrator atualiza a exibi¢cdo de event frames correspondentes na visualizagao.

10. Ao finalizar a defini¢do do filtro, clique em Salvar Filtro de Linha da Estrutura de Evento.

Sobre publicar grandes views

Grandes views com 100 ou mais elementos e atributos combinados provavelmente encontrardo um limite com o
protocolo de transporte Web Sockets, que tem um pacote maximo de dados no tamanho de 64 K. Antes de
publicar grandes views, talvez vocé precise mudar o tipo de transporte para Servidor Enviou Eventos, para
acomodar os pacotes de maior tamanho. Isto deve ser exigido apenas para usuarios utilizando o navegador
Microsoft Edge.

De qualquer pagina, clique no icone da engrenagem n no canto superior direito e altere Tipo de Transporte
para Servidor Enviou Eventos.

Sobre views publicadas continuamente

As views podem ser publicadas continuamente de maneira programada. Vocé pode publicar novamente uma
view em intervalos de, no minimo, um minuto e, no maximo, 12 meses. Por exemplo, vocé pode configurar sua
view para ser publicada novamente a meia-noite todos os dias.

Nota: As views continuas sdo executadas no hordrio local em que o Servico Pl Integrator Framework estd sendo
executado. Portanto, os usuarios que estiverem em um fuso horario diferente precisarao levar isso em
consideragdo ao agendar suas execugoes.

Toda vez que a view é publicada, dados novos sdo anexados aos dados existentes. Em razao disso, a tabela ou o
arquivo de destino continua crescendo toda vez que a view é publicada seguindo uma programacao. Ao publicar
views em uma agenda, ndo ha atualmente a op¢ao de sobrescrever os dados. Portanto, vocé deve excluir
manualmente os dados na tabela ou no arquivo de destino de publicacdo que ndo sdo mais necessarios.

E necessério especificar o intervalo de tempo para o periodo que vocé quer que seja atualizado. Se houver
alguma preocupacao em relagdo ao consumo de muitos recursos, é possivel especificar intervalos de tempo mais
curtos e atualizar os dados publicando vérias vezes.

E necessério especificar que vocé quer que sua view seja publicada periodicamente na pagina Publicar. Consulte
Publicar uma view periodicamente para obter mais informacdes.

Na pagina Minhas Views, as views publicadas continuamente tém um Modo de Exibi¢gao chamado Continuo.

O Pl Integrator suporta atualiza¢cdes automaticas de dados do Pl System publicados para destinos selecionados.
Para obter mais informacdes sobre este recurso, consulte Como os dados publicados sdo atualizados.

Nomes de view e endpoints de destino

Quando o PI Integrator publica uma view, o nome da view é usado para criar o nome da tag de destino. Cada
destino tem suas préprias convencdes e regras de nomenclatura para o que seria um nome aceitdvel. Se um
nome da view contém um caractere que nao é permitido pelo destino, o Pl Integrator remove o caractere ou o
substitui com um caractere sublinhado (_).

Os destinos também possuem regras sobre o comprimento dos nomes. Se o nome do endpoint excede esses

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 162



'AV EVA\TM Pl Integrator for Business Analytics

Como usar o Pl Integrator for Business Analytics

limites, o Pl Integrator exibe um aviso ou uma mensagem de erro.

Verifique a documentacao para seu destino especifico ou para as convengdes de nomenclatura aplicaveis e os
limites de comprimento.

Publicar uma view uma vez

As views executadas apenas uma vez podem ser publicadas imediatamente ou vocé pode especificar que elas
sejam publicadas posteriormente.

Para obter informagdes sobre como publicar views de forma agendada, consulte Publicar uma view
periodicamente. Para obter informagdes sobre como publicar views de streaming, consulte Publicar uma view de
streaming.

1. Na pagina Publicar, selecione o destino na lista Configuragdo do Destino.
2. Clique em Executar Somente Uma Vez.

(Opcional) Especifique a data e a hora em que vocé deseja publicar a view.

Nota: As views agendadas sdo executadas no hordrio local do computador que esta executando o Servico Pl
Integrator Framework. Se vocé estiver em um fuso hordrio diferente, talvez seja necessario converter o
horario local agendado para o fuso horario do Servigo Pl Integrator Framework para obter o resultado
desejado.

4. Cliqgue em Publicar.

Publicar uma view periodicamente

Vocé pode publicar uma view periodicamente. Na pagina Publicar, é possivel especificar a frequéncia com a qual
vocé deseja publicar a view. Os resultados de cada execu¢ao serao anexados aos resultados anteriores. Para
obter mais informacdes sobre view publicadas continuamente, consulte Sobre views publicadas continuamente.

1. Na pagina Modificar View, insira a frequéncia da amostra e os horarios de inicio e término.

Nota: o Pl Integrator for Business Analytics devolve os dados a partir do intervalo de tempo especificado
pelo Tempo inicial e Tempo final somente na primeira execucgdo.

Clique em Préximo.
Na pdgina Publicar, selecione o destino na lista Configuragao do Destino.

Clique em Executar Periodicamente.

vk W

Especifique a data e o hordrio da primeira execugao.

Nota: As views agendadas sdo executadas no hordrio local do computador que esta executando o Servigo Pl
Integrator Framework. Se vocé estiver em um fuso horario diferente, talvez seja necessario converter o
horario local agendado para o fuso horario do Servico Pl Integrator Framework para obter o resultado
desejado.

6. Especifique a frequéncia das execu¢bes subsequentes.

Nota: é possivel especificar uma frequéncia de, no minimo, um minuto e, no maximo, 12 meses.

7. Clique em Publicar.
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Agendamento de views para views de ativos

Quando as visualizagGes de ativos sdo publicadas em uma programacao, o Pl Integrator for Business Analytics
usa os seguintes parametros para determinar os intervalos de tempo discretos nos quais ele recupera dados:

e Tempo inicial

e Tempo final

* Frequéncia de execugdo
* Frequéncia da amostra

e Primeira Execugéo

O Pl Integrator for Business Analytics publica dados a partir do intervalo de tempo especificado pelos parametros
Start Time e End Time somente na primeira execu¢do. Para as execugdes subsequentes, o Pl Integrator for
Business Analytics avalia a janela de recuperag¢do de dados com a seguinte formula:

e Start Time = Ultima publicacdo End Time + Sample Frequency

e End Time = End Time configurado, avaliado no momento de execuc¢ao

Dependendo de como os parametros estao configurados, pode haver diferencas significativas nos dados
recuperados. Para obter mais informacgdes, incluindo exemplos que ilustram o efeito de diferentes configuragdes
nos dados recuperados, consulte How does view scheduling work for Pl Integrator Asset Views?

Publicar uma view de streaming

Grandes views com 100 ou mais elementos e atributos combinados provavelmente encontrardo um limite com o
protocolo de transporte Web Sockets, que tem um pacote maximo de dados no tamanho de 64 K. Antes de
publicar qualquer view grande, mude o tipo de transporte para Servidor Enviou Eventos para acomodar os
maiores tamanhos de pacotes.

Na pdgina Minhas Views, clique no icone da engrenagem n no canto superior direito e alterne Tipo de
Transporte para Servidor Enviou Eventos.

Nota: Os destinos de streaming podem transmitir somente 25.000 correspondéncias do formato de busca. Uma
vez que o limite é alcangado, nenhuma outra correspondéncia é transmitida e uma mensagem de erro é gravada
no arquivo de registro.

Na pdgina Publicar, selecione um destino na lista Configuracdo do Destino.

2. (Somente Apache Kafka) Selecione um tdpico para o qual a mensagem é enviada.
Por padrao, as mensagens sdo enviadas para um tépico que tenha o0 mesmo nome que a view.
E possivel também escolher enviar as mensagens para os topicos existentes.

a. Cligue em Obter tépicos para preencher a lista de topicos disponiveis entre os quais vocé pode
selecionar.

b. Clique na seta para exibir a lista de tdpicos.
Especifique o tempo inicial para a primeira publicacdo da view.

4. Cliqgue em Publicar.
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A guia Estatisticas exibe informac&es sobre o processo de publicagdo de views. Isso é util para solucionar
problemas de gargalos durante a leitura de dados do Pl System por meio da gravac¢ao dos dados no destino. As
estatisticas incluem a hora de cada execucdo publicada; isso pode ser Gtil com o agendamento quando os
aplicativos de downstream leem os dados do destino.

Se vocé ndo ver as estatisticas para um periodo anterior, o Pl Integrator pode ter excluido esses registros do SQL
Server, onde eles ficam armazenados para prevenir o consumo excessivo do disco. Consulte Definir as politicas
de retencdo de registro para obter mais informagdes sobre quando esses arquivos sao excluidos. Use o
procedimento abaixo para se familiarizar com as informacgdes na guia de estatisticas.

1. Na pagina Minhas Views, selecione a view na qual vocé estd interessado.

2. Se o painel Visualizar detalhes ndo estiver aberto, clique no botdo no canto inferior direito para abri-lo. Em
seguida, clique na guia Estatisticas.

As estatisticas para a view selecionada sdo exibidas.

Qverview Log Security View Configuration Statistics
Run History
Run Instances + Duration Rows Written Rows Filtered Error Count
seconds ¥

1/22/207:18 AM 22.327 [} 0 0

1/22/20 7:28 AM 23.23 0 0 0

1/22/20 7:38 AM 24.019 0 0 0

1/22/20 7:48 AM 2229 [} 0 0

Total 96 2,121.159 0 o (]

| Download All Reports || Enable Full Reporting |

Duration (seconds)
All Runs

26:
24 A Aa n .\ AT n » L A

22 J
20 |

12 |
16 - ‘ ‘
14 -
12 | |
10 ‘ ‘
] | |
o] )

T T T T T T T T T T T T T T T n
10PM 11PM Wed2z 01AM DZAM O0ZAM O4AM O05AM 0BAM OTAM 08AM ODAM 10AM 1AM 12PM 01PM

3. Clique e escolha uma das estatisticas no cabecgalho da tabela para visualizar os dados de tendéncia.

Qverview Log Security View Configuration Statistics
Run History [
Run Instances + Duration Rows Written Rows Filtered Error Count
seconds ¥

1/22/20 7:18 AM 22.327 0 0 0

1/22/20 7:28 AM 23.23 0 0 0

1/22/20 7:38 AM 24.019 0 0 0

1/22/20 7:48 AM 22.291 0 0 0

Total 96 2,121.159 0 ] 0

| Download All Reports || Enable Full Reporting |

Duration (seconds)
All Runs

26:
24 R ARa A AR a! AR » AN

22 g
20 |

12 |
16 - ‘ ‘
14 -
12 | |
10 ‘ ‘
. | |
o] )

T T T T T T T T T T T T T T T n
10PM 11PM Wed2z 01AM DZAM O0ZAM O4AM O05AM 0BAM OTAM 08AM ODAM 10AM 1AM 12PM 01PM

4. Cliqgue em uma linha na tabela para visualizar estatisticas adicionais para a execu¢do selecionada no painel a

direita.

5. Cligue em Mostrar todas as execugdes para voltar a view de tendéncia.
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Qverview Log Security View Configuration Statistics

Run History Duration (seconds)
ZD:

1/22/20 7:18 AM 22.327 0 0 [} -
1/22/20 7:28 AM 23.23 0 0 [:} 15
1/22/20 7:38 AM 24.019 0 0 [:}
10
1/22/20 7:48 AM 22.291 0 0 0
5
Total 96 2,121.159 0 0 0 |
Download Selected Report || Enable Full Reporting o 1

| View Logs for Run

T T
Reading from FI Filtering & Caleulating Wiriting to MSSQL

6. Selecione uma parte do grafico de tendéncia para aumentar o zoom.

Duration (seconds)
All Runs

26 |23.7 01/22/20 05:43:47 AM|

o R e L. ey 8
224 i
20 -

L}.
T T T T T T T T T T T T T T T T1
10PM 11 PM Wed22 01AM O2AM 03 AM 04AM 05 AM OHAM OF AM OB AM CBAM 10AM 11AM 1ZPM 01FPM

A area selecionada é expandida para preencher o eixo X do grafico.
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Duration (seconds)

All Runs
26

24 -

22 -

20 -

18

18

14

12

10

S_

.

4

.

o

06 AM 08115 06:20 06:45 07 AM 07:15 07:30 0745 08 AM

7. Clique no icone da lupa diminuir o zoom.

Duration (seconds)
All Runs

26 4
&
22 4 -
20—
12 -
16 -
14+
12
10 -
S_
&
44
2
o T T T T T T T T
0G5 AM 08:15 0630 0545 o7 AM 0715 0730 0745 08 AM

8. Clique em um nd no grafico de tendéncia para ver detalhes dessa execucao.
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Duration (seconds)

All Runs
ii: 222 01722120 06:38:47 AM a
27 _:".....f.-‘:‘.-\-.\-"."‘:ﬁ‘._...-.-.-.-.-.-.-. Ir.——'—'_'__r_ 'k\“-___‘—._____. I—
20- . /
12 A III."
] A /
14 — E I|III I|I
12 - L\ Ill"
10 - ".II |
2 : \ /
S /
# S /
N E II". ,Jll
2 : 1 —'-'-""'_F
o T T : T T T T T T T T
08:15 05:30 0645 ar AmM 0715 a7:30 0745 08 AM 08:15 08:30

9. Cligue em Visualizar registros da execuc¢ao para ver os registros de logs para a execugao.

O Pl Integrator leva vocé para a guia Log para a execucdo selecionada.

Ativar o relatério completo

Nota: o Suporte técnico usa Ativar relatdrio completo para coletar estatisticas abrangentes que ajudam a
solucionar problemas com as views de publicacdo. Ndo ative este recurso a ndo ser que seja direcionado pelo
Suporte Técnico. Com o relatério completo ativado, o espaco disponivel em disco pode ser rapidamente
preenchido.

1. Identifique as views que estdo com problemas de desempenho.

2. Va para a guia de estatisticas da exibi¢do e clique no botao Ativar relatério completo.
3. Aguarde até que a préxima publicacdo agendada seja executada para a view.
4

Na guia de estatisticas, role para visualizar as instancias de execucdo que ocorreram apds a ativacao do
relatério completo.

5. Clique na instancia de execugdo e selecione Baixar relatdrio selecionado. A instancia de view deve ter um
icone de grafico de barras ao lado do timestamp, indicando que o relatério completo foi habilitado durante
essa instancia de execugao.

6. Clique no botdo Desativar relatério completo.

Como os dados publicados sao atualizados

O Pl Integrator Sync monitora os ativos no Pl System para views de ativos, views de transmissdo agendada e
views de transmissdao com valor principal acionado. Ele mantém os dados publicados atuais das maneiras a
seguir:

¢ O Pl Integrator Sync monitora o formato da view e controla as altera¢des no Pl AF que afetam as
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correspondéncias na view. Por exemplo, suponha que vocé tenha uma view de bombas e que haja 10
correspondéncias. Uma nova bomba é adicionada ao Pl AF e isso resulta em 11 correspondéncias do formato
da view. O Pl Integrator Sync publica dados para as 11 correspondéncias encaminhadas e ele recalculara os
dados para a nova bomba para views de ativos e views de transmissao agendada.

¢ O Pl Integrator Sync monitora altera¢cdes nos dados no Pl Data Archive e atualiza todos os dados publicados.
Por exemplo, quando um valor de dados no Pl Data Archive é atualizado com um novo valor, o Pl Integrator
Sync publica o novo valor no destino.

Nota: para uma defini¢ao dos diferentes tipos de views de streaming, consulte Sobre gatilhos de mensagem.

O Pl Integrator Sync monitora dados fora de ordem e de recdlculo de dados histéricos e atualiza dados
previamente publicados uma vez a cada 30 minutos. Portanto, uma vez que uma mudanca é feita no Pl AF ou no
Pl Data Archive, pode levar até 30 minutos para que essa alteracdo seja refletida em seus dados. Se os dados
chegarem atrasados no Pl Data Archive e o Pl Integrator for Business Analytics ja tiver publicado dados para o
intervalo de tempo desses dados atrasados, os dados atrasados ndo serdo atualizados automaticamente na
tabela de destino. Para garantir que todos os dados sejam publicados, configure um atraso no parametro Tempo
final da view (por exemplo, *-1h) ou faca o recalculo de dados histéricos manualmente assim que os dados
chegarem ao PI Data Archive. Para obter mais informacgdes, consulte Atualizar dados manualmente.

Para aproveitar os recursos de sincronizacao do Pl Integrator Sync, vocé deve estar usando o Pl Data Archive
2017 ou posterior.

A tabela a seguir mostra cada destino e o tipo de sincroniza¢do suportada.

Suporta sincronizagao Suporta sincronizagao

Tipo Destino com PI AF com PI Data Archive

Banco de dados relacional | Banco de dados do Azure
sQL

Microsoft SQL Server

Banco de dados Oracle

SAP HANA

Data Warehouse Amazon Redshift

Apache Hive

Pool de SQL Dedicado do
Azure

Google Big Query

Nao estruturado Arquivo de Texto

AN NENE N NENENEN
ANEANA NN NANANEN
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Tipo

Destino

Suporta sincronizagao
com Pl AF

Suporta sincronizagao
com Pl Data Archive

Data Lake

Amazon S3

*

Azure Data Lake Storage
Gen 2

*

v

Google Cloud Storage

*

Hadoop HDFS

*

Hub de Mensagem

Amazon Kinesis Data
Streams

Apache Kafka

*
*

Hubs de Evento do Azure

*
*

Hub loT do Azure

*
*

Google Cloud Pub/Sub

SINKNKNCKINEA

AN NE NN

Nota: para o data lake e destinos de arquivos, o Pl Integrator Sync monitora as altera¢des no formato de views
de ativos e publica os dados para as correspondéncias a partir de agora. No entanto, as altera¢des do Pl Data
Archive ndo sdo suportadas. Portanto, o Pl Integrator Sync ndo recarrega os dados para esses destinos nem
atualiza altera¢Oes nos dados publicados. A exceg¢do a isso é o Azure Data Lake Storage Gen 2, que oferece
suporte ao formato de view de ativos e as altera¢des nos dados.

Nota: os destinos de streaming oferecem suporte de sincronizagdo apenas para streaming agendado. As

visualiza¢Oes de streaming acionadas por chave ndo tém suporte a sincronizacao.

Como os dados publicados sao sincronizados com Pl AF

O texto a seguir descreve como os dados publicados sdo sincronizados com as alteragGes na hierarquia do Pl AF:

¢ O elemento é adicionado ao PI AF

Nota: certifique-se de que todas as alteragdes feitas no Pl System Explorer/Servidor AF tenham sido
verificadas antes de criar uma view com destino a essas alterages. Os elementos que ndo corresponderam
ao formato da view na criagao, que foram modificados posteriormente para corresponderem ao formato da
view, ndo serdo automaticamente adicionados as suas view(s) existentes. Além disso, se o formato da view
contiver atributos que ndo estdo marcados como opcionais na configuracao da view, esses atributos deverao
estar presentes no elemento no momento da criacdo do elemento para esse elemento e os atributos
correspondentes serdo adicionados a(s) sua(s) view(s) existente(s).

¢ Views de ativos e views de transmissao agendada — se um elemento ou uma combinac¢ao de elementos e
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atributos for adicionada ao Pl AF e isso resultar em uma nova correspondéncia na view, os dados para o
novo elemento serdo publicados adiante e os dados serdo recalculados para o tempo inicial da view
original.

¢ Views de streaming com valor principal acionado — se um elemento ou uma combinacao de elementos e
atributos for adicionada ao Pl AF e isso resultar em uma nova correspondéncia na view, os dados para o
novo elemento serao adicionados somente adiante. Os dados publicados anteriormente nao sao
recalculados.

¢ O elemento é excluido do Pl AF — se um elemento for excluido do Pl AF e isso alterar o numero de
correspondéncias na view, os dados para o elemento ndo serdo publicados adiante. No entanto, os dados
publicados anteriormente serdo mantidos.

¢ O elemento é renomeado no Pl AF —se um elemento for renomeado no Pl AF, ele sera automaticamente
renomeado na view. O novo nome aparecera nos dados publicados adiante, mas os dados publicados
anteriormente manterdo o antigo nome do elemento.

Nota: as alteragOes nas permissdes de identidade do AF em elementos existentes ndo sao rastreadas pelo Pl
Integrator Sync. Por exemplo, se as permissdes de seguranca AF forem adicionadas a um elemento que ndo
estd sendo publicado por uma view, os dados desse elemento ndo serdo publicados automaticamente daqui
para frente, nem serdo incluidos em recargas de dados histdricos. Se as permissdes de seguranca AF forem
removidas de um elemento, as publicacdes subsequentes ainda poderdo acessar os dados do elemento,
apesar das permissdes revogadas. Para refletir as alteracées de permissées de identidade do AF em um
elemento existente, as views que fazem referéncia a esse elemento precisardo ser republicadas ou o préprio
elemento devera ser recriado. Para obter detalhes sobre qual identidade AF o PI Integrator Sync usa,
consulte Seguranca de dados.

O texto a seguir descreve como os dados publicados sdo sincronizados com dados do Pl Data Archive fora de
ordem e de recdlculo de dados histéricos para cada tipo de view:

¢ Views de ativos — quando h4 altera¢des nos dados do Pl Data Archive, os dados de destino sdo atualizados
automaticamente. O Pl Integrator Sync substitui os dados no destino.

¢ Views de transmissdao agendada — se houver uma alteracao no valor dos dados, o novo valor serd publicado
no destino. No entanto, o valor publicado anteriormente nao serd excluido. A op¢cao Dados de recarga de
dados histéricos na pagina Modificar View deve ser definida para ativar essa funcionalidade.

¢ Views de streaming com valor principal acionado — a atualiza¢do de dados n3do é suportada para views de
streaming com valor principal acionado.

¢ Views de evento — views de evento nao capturam dados de altera¢do e dados fora de ordem
automaticamente, mas esse tipo de dados pode ser publicado manualmente usando o recurso atualizar
dados (botdo). O intervalo de tempo especificado na atualizagdo manual de dados capturara todos os event
frames que tém um tempo final dentro desse intervalo.

Atualizacao manual

Vocé pode atualizar manualmente os dados, independentemente de sua versao do Pl Data Archive.

Se vocé estiver usando o Pl Data Archive 2016 R2 ou anterior, no entanto, o Integrador Pl para Business Analytics
nao suporta a atualizacdo automatica de dados. Portanto, atualizar manualmente os dados que mudaram desde
a publicacdo é a Unica opcdo disponivel.

Vocé pode atualizar dados manualmente somente nas views de ativos, views de evento e views de streaming
agendadas para destinos suportados. Vocé nao pode atualizar dados em views publicadas somente uma vez ou
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que sdo publicadas em um arquivo ou destino HDFS, e também ndo pode atualizar views de streaming com valor

principal acionado.

Serd necessario atualizar manualmente somente se os dados tiverem sido alterados desde sua ultima publicacao
no armazenamento de dados de destino. Todas as mudangas que ocorrerem nos dados antes de uma publicacao
agendada sdo gravadas no armazenamento de dados com os valores mais recentes.

Essas sdo algumas das circunstancias que podem fazer os dados mudarem:

¢ Dados estavam sendo armazenados em buffer em um né de interface no momento em que a view foi

publicada.

¢ Dados foram recarregados em histérico ou recalculados. Isso costuma acontecer com tags do Pl AF Analytics.

¢ Dados sdo inseridos manualmente apds a view ter sido publicada.

Atualizar dados manualmente

1. Selecione uma view na pdgina Minhas Views cujo status Modo de Exibi¢do é Continuo ou Transmissdo

agendada.

2. Clique na barra horizontal no canto inferior direito da pagina Minhas Views para abrir o painel de detalhes.

My Views

AL OSNasato £

+ Create Asset View + Create Event View c’; Modify View X Remove View
=11 starting with your Build a data wiew starting with time Medify existing data view Remove selech
am sar
] Name Run Status Type Run Mode Start Time
PUmp A19375X1 Not Yet Published Asset Continuous *-8h
| Pump C97534X2 Not Yet Published | Asset ‘Once ~-8h
‘Pump G27834V3 Not Yet Published Asset ‘Once *-8 hours
‘Pump B90853V1 Not Yet Published Asset ‘Once ~-8h
‘Pump G78359x2 ‘Not Yet Published Asset ‘Once *-8h
‘Pump U57328X2 ‘Not Yet Published [Event ‘Once
‘PUmp X75132X3 Not Yet Published Asset ‘Once *-8h
——*
—m
3. Cligue na guia Visao Geral.
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My Views L OShasato £
+ Create Event View c"’ Maodify View R Remove View
g with you :B-HI;:;(-*E siew starting with time Modify existing data vie Remave selected vie:
i a Name Run Status Type Run Mode Start Time EI v=

Pump A19375X1 Scheduled Asset Continuous *
‘Pump C97534X2 Not Yet Published ‘Asset ‘Once 5
\Pump G27834V3 Not Yet Published Assel ‘Once
-Pump B90853V1 Not Yet Published Asset ‘Once
‘Pump G78359X2 Not Yet Published Asset ‘Once
{Pump U57328X2 Not Yet Published {Event ‘Once :
{Pump X75132X3 Not Yet Published Asset ‘Once ~8h

Qverview Log Security

Run Status Scheduled Publish Actions Search Shape
View Name Pump A19375X1 Asset Shape
Pl AF Database Datacenter Demo 4 [ Atlanta
Publish Target SQL Server 4 @ colof
View Type Asset & ColoNumber

) & Zonel Capacity
Run Mode Continuous

& Zonel CapacityPercent

Last Run Time Never o - -

L 7 i

¢ No painel A¢Ges de Publicagdo, clique em Atualizar dados do.

Nota: caso o botdo Atualizar Dados esteja desativado, isso significa que a atualizacdo manual ndo é
suportada para esta view. Para obter informacdes sobre quais views podem ser atualizadas, consulte
Como os dados publicados s3do atualizados.

4. Especifique o periodo dos dados que vocé deseja atualizar.

Nota: somente é possivel atualizar dados para um periodo no passado.

5. Clique em Confirmar.

Nota: primeiramente, o Pl Integrator exclui os dados existentes especificados no intervalo de tempo e, em
seguida, publica novos dados.

Modificar uma view

Quando vocé modifica uma view, ha implicacdes na forma como os dados existentes sdo tratados:

¢ Quando uma visualizacdo de ativo ou de evento publicada anteriormente é modificada e republicada, os
dados existentes sdo excluidos. Os dados publicados anteriormente ndo sdo preservados. A view de ativo ou
de evento modificada usa a hora de inicio da primeira publicagdo como sua hora de inicio. Quando uma
visualizagcdo que publica em um elemento monitorado de publicacdo baseada em arquivo é republicada, os
arquivos de dados publicados existentes sdo excluidos. Para elementos monitorados de publicacdo baseados
em tabela, a acdo de republicar derruba a tabela de elementos monitorados existente. Em qualquer caso, os
dados publicados anteriormente ndo sao preservados. A view de ativo ou de evento modificada usa a hora
de inicio da primeira publicacdo como sua hora de inicio.
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¢ Todos os dados lidos de um destino de streaming em outro sistema ndo sao modificados. Serad necessario
reconciliar todas as diferengas nos dados que sdo enviados para a view original e a view modificada. Na
maioria dos casos, vocé provavelmente excluird os dados armazenados existentes antes de publicar a view
modificada.

Como alternativa, é possivel fazer uma cépia de uma view e editar a cépia; esta view é tratada como uma view
nova.

1. Na pagina Minhas Views, selecione a view que deseja modificar e clique em Modificar View.
2. Na caixa de didlogo Modificar View, execute uma destas opgdes:
¢ Para editar a view — clique em Editar esta view.

¢ Para editar uma cépia da view — selecione Editar uma copia desta view, insira um nome exclusivo para a
view e clique em Editar View.

A view selecionada é exibida na pagina Selecionar Dados. Vocé pode continuar fazendo alteragdes ao
formato de dados, modificando a view e publicando os dados.

Para obter mais informagGes sobre como editar uma view, consulte Criar uma view com ativos, Criar uma
view para eventos e Criar uma view de streaming.

Nota: se a configuracdo de seguranca de personificacdo do aplicativo estiver ativada, a view modificada ou
copiada usara as identidades do AF mapeadas para o usudrio que copiou ou modificou a view para acesso a
dados em vez das identidades do AF associadas ao usudrio que publicou a view pela ultima vez. Consulte a
secdo Seguranca de dados para obter mais informacdes.

Copiar uma view

E possivel criar uma cépia de qualquer view selecionando-a na pagina Minhas views e clicando em Modificar
view.

Renomeie uma view

E possivel renomear uma view usando a pagina Minhas Views.

1. Na pagina Minhas Views, clique em uma das barras no canto inferior direito da pdgina para abrir o painel de
detalhes.

O painel se abre com a guia Visao Geral selecionada.

2

. r .
2. Cliqgueem * aolado do nome da view.

Nota: A renomeacdo de views ndo é suportada para destinos Amazon Kinesis Data Streams, Amazon S3,
Apache Kafka, Azure Event Hubs, Azure loT Hub, Azure Data Lake Storage Gen 2, Google BigQuery, Google
Cloud Pub/Sub, Google Cloud Storage, Hadoop Distributed File System, e Text File.

3. Edite o nome da view e clique em Renomear.
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Proteger suas views

E possivel controlar o acesso a quaisquer views para as quais vocé tenha permissdes de proprietario. Consulte a
secdo Permissdes de acesso de view para obter mais informacdes.

Clique no icone de menu E e clique em Minhas Views.
2. Na pagina Minhas Views, selecione uma view na lista.
Os detalhes da view sdo exibidos abaixo da lista no painel Detalhes.

3. Cligue na guia Seguranga.

* Create Asset View * Create Event View + Create Streaming View H [# Modif
Name Run Status Start Time Run Mode Creatiod
Baller Wiew Published "-Bh Once QIB22 §
Compressor View Pubdished *.8h Once IRF22 3
Pump View Fublished “8h Once 0112022
| L1l ]

Owerview Log Security View Configuration Statistics
Identities
View Access @ Data Access @

-l- o hagrator Sarv -

FI Inbegrator Servis & Administrators L World

A ergneers

* Add i=! Remove

Nota: as identidades de acesso a dados sao as identidades do AF que sdao usadas para acessar os dados de
origem quando a configuracdo de seguranca de personificacdo do aplicativo esta ativada. Elas sdo mostradas
apenas quando a configuragao estd ativada.

4. Vocé pode executar as seguintes acdes na view selecionada em Acesso a view.
¢ Altere as permissdes de uma view
¢ Adicione uma nova identidade e conceda permissao a view

e Remova 0 acesso a uma view

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 175



'AV EVA\TM Pl Integrator for Business Analytics

Seguranca do Pl Integrator Framework

Seguranca do Pl Integrator Framework

Ha trés areas gerais a serem consideradas ao planejar a seguranga do Pl Integrator for Business Analytics:

e Seguranca do aplicativo — define as praticas recomendadas para proteger os servicos do Pl Integrator for
Business Analytics, como medidas defensivas contra ataques de negacdo de servico (DoS).

e Seguranca de dados — Determina que usuarios recebem acesso a dados no Pl AF e como essa segurancga é
gerenciada.

Nota: a seguranga dos dados publicados que residem no destino designado precisa ser considerada. A
segurancga de dados publicados é manipulada e gerenciada dentro do préprio destino de publicagao. Para
obter mais informacdes sobre como gerenciar o acesso aos dados de destino, consulte Secure views for an
identity.

e Seguranca de acesso do usuario — define quais usuarios recebem acesso ao aplicativo da web do PI
Integrator for Business Analytics, seu nivel de acesso (Administrador) e quais sdo suas permissées para
acessar e configurar views especificas e destinos de publicacdo dentro da interface de usudrio (Ul) do PI
Integrator for Business Analytics.

Seguranca do aplicativo

Medidas defensivas contra Negacao de Servico (DoS)

Para maximizar a seguranca do Integrador Pl para Business Analytics, recomendamos instalar o Integrador Pl
dentro de uma arquitetura de intranet, para que ele seja protegido pela seguranca de sua rede.

Nos casos em que for necessario gravar em elementos monitorados baseados na Internet, como uma plataforma
em nuvem, o Integrador Pl deve ser configurado para publicar nesses elementos através de um proxy HTTP. Para
obter mais informagdes, consulte: Como conectar-se ao Pl Integrator para publicar elementos monitorados por
um proxy HTTP.

Seguranca de dados

O acesso a dados do Pl AF na interface de usuario do Pl Integrator for Business Analytics e quais dados podem
ser publicados pelos servicos do Pl Integrator dependem da configuracao de personificacao do Pl Integrator for
Business Analytics. O modo de personificagdo permite que os usudrios acessem recursos do Pl AF da interface de
usudrio do PI Integrator com base nas permissdes de seguranga do AF de uma conta do Active Directory.

A configuragao de personificacdo do aplicativo esta desativada por padrao:

¢ Ao configurar uma view, os usuarios em maquinas cliente fazem solicitagdes para o PI AF por meio do servigo
do PI Integrator Framework. O usuario herda as permissdes do Pl AF e Pl Data Archive que foram concedidas
a conta de servigo do Pl Integrator for Business Analytics.

¢ Todas as publicacdes agendadas e atualizacdes do servico do Pl Integrator Sync usam as permissées
concedidas a conta de servico do Pl Integrator for Business Analytics.

¢ Quando o modo de personificacdo esta desativado, o Pl Integrator usa as permissdes de seguranca do AF da
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conta de servigo do Pl Integrator para acessar recursos do Pl AF.

A configuragdo de segurancga da personificacdo do aplicativo esta em:

Ao configurar uma view para publicacao, um usudrio faz solicitacdes de dados para um Pl AF Server por meio
do servico do Pl Integrator Framework. O servico do Pl Integrator Framework soé retorna dados ao usudrio
final que recebeu acesso a dados de leitura dentro de servidores do PI AF.

Quando a personificagdo esta ativada, sdo usadas as permissdes de seguranc¢a do AF de um usuario de login
atualmente autenticado. A comutagdo do modo de personificacdo permitira que o usudrio acesse recursos
do PI AF com as permissdes de seguranga do AF do usudrio de login atualmente autenticado. Todas as
publicagdes agendadas e atualizagdes pelo servigo do Pl Integrator Sync usam as permissdes concedidas ao
usuario de login atualmente autenticado.

Comecgando no PI Integrator for Business Analytics 2020 R2 SP2, uma lista das identidades do AF mapeadas
para o criador de views no momento da primeira publicacdo para cada view é usada para determinar quais
dados uma view pode publicar em cada publicagdo subsequente. Especificamente, o acesso do usuario aos
objetos do AF do Pl AF Server de origem (como elementos, atributos e templates) para uma view é
determinado pelas permissGes de seguranca do AF definidas para as identidades do AF mapeadas desse
usudrio especifico de uma conta de usuario do Active Directory. Quando uma view é publicada, as
identidades do AF mapeadas para o usuario que publica a view sdo salvas com a configuracdo da view.

Acesso seguro a dados

Limite as permissdes do Pl AF para a conta de servigo do Pl Integrator as permissGes minimas necessarias
para que elas possam ver e publicar os dados que devem ser capazes de ver. Consulte Tarefas pds-instalacao
para obter mais informacées.

Limite as permissdes do Pl Data Archive para a conta de servico do Pl Integrator a apenas as permissoes
minimas necessarias para publicacdo de dados no Pl Integrator for Business Analytics. Consulte Tarefas pos-
instalacdo para obter mais informacoes.

Permissoes de acesso do usuario

Um usuario pode acessar a interface de usuario (Ul) do Pl Integrator for Business Analytics quando uma
identidade do AF para a qual ele estda mapeado estiver presente na pagina Usuarios de administracdo do Pl
Integrator for Business Analytics. Ha duas funcdes de permissdo de acesso no nivel de aplicativo, Pl Integrator
Administrator e Pl Integrator User.

Administrador — usudrios mapeados para uma identidade do AF com a caixa de selecao Administrador
selecionada podem executar todas as fun¢des administrativas com a interface de usuario do PI Integrator for
Business Analytics, como adicionar ou modificar identidades existentes, views e destinos de publicacdo, bem
como a capacidade de adicionar e configurar permissdes para outros usudrios. Eles também podem ver e
modificar todas as views, independentemente de uma identidade do AF ter permissGes de Leitor ou
Proprietdrio.

Usudrio — usuarios que nao estdao mapeados para uma identidade do AF com a caixa de selegao
Administrador selecionada ndo podem acessar a pagina Administra¢do. O acesso a views individuais por
meio da interface Web depende de qual permissdo de view é atribuida ao usudrio para essa view
(proprietario da view, leitor da view). Os administradores tém acesso total a views criadas por qualquer
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usudrio, independentemente da permissao da view. Consulte Permissées de acesso de view para obter mais
informacdes. As permissdes de acesso do usuario podem ser modificadas na guia Usudrios da pagina
Administragao, conforme descrito em Adicionar e configurar identidades.

Permissoes de acesso de view

Quando uma view é criada, uma identidade do Pl AF para a qual o usudrio que cria a view esta mapeado recebe
a permissao Proprietario da view. Se o usudrio que cria a view for atribuido a varias identidades do Pl AF com
acesso ao Pl Integrator for Business Analytics, ele poderd selecionar uma dessas identidades na lista suspensa
Proprietdrio da view para ser o Proprietario da view. Somente as identidades do Pl AF que receberam acesso ao
Pl Integrator for Business Analytics estdo disponiveis. Se o usudrio que cria a view nao escolher uma identidade
do AF como Proprietdrio da view, uma identidade do Pl AF sera atribuida, por padrdo, na seguinte ordem:

e Se 0 usudrio estiver mapeado a apenas uma identidade Pl AF, essa identidade sera usada.

¢ Se 0 usudrio estiver mapeado a varias identidades, a identidade com o menor nimero de mapeamentos sera
atribuida. Identidades com um Unico usuario e identidades de grupo sao tratadas da mesma forma. Se
diversas identidades tiverem o mesmo de mapeamentos, a primeira delas na ordem alfabética de nomes de
identidade sera atribuida.

Apds a criagdo de uma view, é possivel atribuir identidades Pl AF adicionais a view. Para obter mais informacdes,
consulte Proteger suas views.

Identidades do Pl AF podem receber as seguintes permissdes de uma view:

¢ O Proprietario concede acesso de gravacao a configuracao da view e da a identidade a capacidade de alterar
permissdes na view e conceder acesso a view.

¢ O Leitor concede acesso de leitura a configuracao da view.
¢ Os leitores podem parar e retomar uma view
¢ Os leitores podem executar uma atualizacdo manual de dados usando o botdo Atualizar Dados
¢ Os leitores podem fazer uma cépia de uma view
¢ Os leitores nao podem remover uma view

e Os leitores ndo podem editar uma view

Nota: as permissdes da view podem ser alteradas na guia Usuarios da pagina de administracao,
conforme descrito em Adicionar e configurar identidades.

Gerenciar permissoes

Na pagina Usudrios, é possivel gerenciar todos os usudrios e o acesso deles a todas as views e destinos de
publicacdo. Vocé deve ser um administrador do Pl Integrator para acessar esta pdgina.
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A tabela descreve as tarefas que vocé pode realizar. Os niUmeros correspondem aos numeros na captura de tela e
identificam em que local da pagina a tarefa é realizada.

Numero Tarefa de seguranga

1 Criar identidades Pl AF

2 Atribuir usudrios e grupos a uma identidade
3 Especificar em quais destinos a identidade

selecionada pode publicar dados

4 Especificar quais views a identidade selecionada tem
permissdo para acessar e o nivel do acesso

5 Conceder os privilégios de administrador de
identidade selecionados na interface de usuario do Pl
Integrator for Business Analytics

Para obter mais informacgGes sobre como concluir essas tarefas, consulte Adicionar e configurar identidades.

How to secure views

Garantir que apenas os usuarios apropriados possam acessar uma interface de usuario e limitar os privilégios de
administrador é importante para manter a supervisdo e a seguranca adequadas dos seus dados.

¢ Se houver identidades do AF em Permissdes de acesso do usudrio as quais vocé nao deseja fornecer acesso a
interface de usuario do Pl Integrator for Business Analytics, use o botdo Remover para remover o acesso.

e Marque apenas a caixa de selecdo Administrador para identidades do AF as quais vocé deseja conceder
privilégios de Administrador do Pl Integrator.

Ha duas maneiras de proteger views:

¢ Vocé pode configurar o acesso a quaisquer views para as quais vocé esta mapeado para uma identidade com
permissdes de proprietdrio na pagina Minhas views.
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¢ Se vocé for um administrador do Pl Integrator for Business Analytics, podera configurar o acesso da view por
identidade ou por views na pdgina Administragdo:

¢ Se quiser configurar a quais views uma identidade tem acesso, consulte Secure views for an identity.
¢ Se quiser configurar as identidades para uma Unica view, consulte Gerenciar o acesso a uma Unica view.

e Se quiser configurar as identidades para varias views de uma s6 vez, consulte Gerenciar o acesso a varias
views.

Para obter mais informagdes, consulte Proteger suas views.

Migrar para a seguranca de dados baseada em identidades do AF

A migragdo para a seguranca de dados baseada em identidades do AF sé é necessdria quando a configura¢do de
seguranca de personificacdo do aplicativo estiver ativada para o Pl Integrator for Business Analytics e vocé estiver
se preparando para realizar o upgrade para o Pl Integrator for Business Analytics 2020 R2 SP2. Se seus usuarios e
recursos, como os servidores do Pl AF, estiverem em um unico dominio ou em um ambiente de dominio de
confianca de floresta bidirecional, a migracdo serd incluida como parte do processo de upgrade regular dentro
do instalador do Pl Integrator for Business Analytics para upgrades interativos e silenciosos. A maioria dos
upgrades ndo requer nenhuma etapa fora do instalador para migrar para a seguranca de dados baseada em
identidades do AF.

Se o Pl Integrator for Business Analytics estiver instalado em um ambiente de dominio de confianga de floresta
unidirecional em que os usudrios criadores de view estdao em um dominio de usudrio e a conta de servico e
recursos do Pl Integrator for Business Analytics, como Pl AF, estdo em um dominio de recursos separado, vocé
deverd concluir uma etapa adicional antes de executar o instalador. Execute a ferramenta de migragao de
identidade separadamente em uma mdquina dentro do dominio do usudrio para preparar suas views existentes
para usar o modelo de seguranga de dados baseado em identidades do AF.

A ferramenta de migracao de identidade prepara suas views do Pl Integrator for Business Analytics para usar o
novo modelo de seguranca de dados baseado em identidades do AF.

e A AVEVA recomenda primeiro executar a ferramenta em um modo de somente visualiza¢do, que gera um
relatério de resultados esperados, mas ndo modifica o template de elemento da view ou elementos da view.

¢ Os arquivos de backup, log e relatdrio gerados tém a data e hora anexadas a eles para que as novas
execucdes ndo sobrescrevam os resultados das antigas, por exemplo,
SetupPlintegratorSetup_ldentityMigration_Report_Preview 2022-08-02_07-34-44-188.html.

Quando estiver no modo sem visualizagdo, a ferramenta de migrac¢do de identidade:

1. Fard um backup em XML dos elementos de view existentes especificados por InstancePath que vocé passar
para a ferramenta.

2. Modificara o template de elemento PI_INTEGRATOR_VIEW.

3. Modificara os atributos existentes no banco de dados Configuracdo do AF incluidos em InstancePath que
vocé especificar para prepara-los para upgrade para usar o modelo de seguranca baseado em identidades do
AF.
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Como executar a ferramenta de migracao de identidade

Antes de executar a ferramenta de migracdo de identidade:

O cliente Pl Asset Framework (AF), incluindo o PI System Explorer, deve ser instalado na maquina em que
vocé estd executando a ferramenta de migracdo de identidade.

Uma entrada na tabela de servidores conhecidos deve ser adicionada no PI System Explorer para o servidor
AF que hospeda a configuragdo do PI Integrator for Business Analytics. (Consulte Adicionar um Pl AF Server a
lista de conexdes). Além disso, é preciso haver uma entrada para cada servidor AF de origem que sua
instancia do Pl Integrator for Business Analytics usa para publicar dados para views. Vocé deve ser capaz de
se conectar a cada um desses servidores por meio do Pl System Explorer usando a mesma maquina que
executara a ferramenta de migracdo de identidade.

Crie um mapeamento para a identidade Administradores do AF no servidor AF que hospeda a configuragdo
do PI Integrator for Business Analytics.

O usuario que executa a ferramenta de migragao de identidade precisa de permissdes de acesso de leitura
no servidor AF para identidades de seguran¢a, mapeamentos de seguranca, bancos de dados e objetos de
segurancga do AF para todos os servidores AF de origem que a instancia do Pl Integrator for Business
Analytics usa para publicar dados para views. A identidade World AF incorporada abrange o acesso
necessario.

O usuario que esta executando a ferramenta de migracdo de identidade precisa de permissdes para criar e
gravar arquivos na pasta %PIHOME%\dat . Os privilégios de administrador local abrangem o acesso
necessario.

A ferramenta de migracao de identidade esta compactada e incluida no Pl Integrator.

Copie o arquivo zip baixado para uma maquina no mesmo dominio de seus usudrios do Pl Integrator for
Business Analytics.

Descompacte o arquivo zip copiado para um diretdrio local.

Execute a ferramenta de migracdo de identidade usando uma das seguintes opgOes: Executar a ferramenta
de migracao de identidade interativamente ou Executar a ferramenta de migracao de identidade usando
argumentos de linha de comando.

Executar a ferramenta de migracao de identidade interativamente

Execute a ferramenta de migracdo interativamente para fazer sele¢cbes conforme a ferramenta é executada. Se
preferir, é possivel executar a ferramenta usando argumentos de linha de comando.

1.
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Na maquina em que vocé descompactou a ferramenta de migracdo de identidade, abra um command
prompt e navegue até o diretério em que os arquivos descompactados estdo localizados.

Para executar a ferramenta, digite IdentityMigrationTool e pressione Enter.

Quando solicitado, especifique se deseja migrar suas views, o que inclui alterar o template
PI_INTEGRATOR_VIEW e elementos das views.

¢ Na&o (N), digite N ou pressione Enter para executar no modo somente visualizagao; isso ndo fara
nenhuma alteragao no template PI_INTEGRATOR_VIEW ou nos elementos das views. Pule para a etapa 5.

e Sim (Y), digite Y para modificar seu elemento e template das views conforme necessario.
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4. No prompt "Vocé deseja que essa ferramenta tente fazer um backup em XML do seu elemento
InstancePath?" especifique a opgao de backup:

¢ N3&o (N), digite N. Com essa opcdo, nada sera feito. Vocé devera realizar um backup manualmente. Se
vocé ndo tiver um backup e a ferramenta alterar suas views, ndo serd possivel reverter totalmente ao
estado anterior do seu banco de dados do AF. Faga um backup manual no Pl System Explorer com as
opc¢oes Incluir todos os objetos referenciados e Incluir strings de sequran¢a marcadas. (Consulte Opcoes
de exportacdo XML.)

e Sim (Y), digite Y ou pressione Enter para que a ferramenta tente realizar um backup em XML e encerre se
o arquivo de backup nao for criado com sucesso.

5. No prompt "Se o valor da lista de identidades do AF (atributo IDList) de uma view ndo estiver em branco,
vocé deseja que a ferramenta sobrescreva o valor existente", especifique a opg¢do de substituicdo:

¢ Na&o (N), digite N ou pressione Enter para ignorar views cujo valor de atributo IDList ndo esteja em
branco.

e Sim (Y), digite Y para substituir o valor do IDList existente.

6. Insira o valor InstancePath de %PIHOME64%\Integrators\BA\CAST.Ul.WindowsService.exe.config. Por
exemplo, \\MyAFServer\Configuration\OSIsoft\PI Integrator for Business Analytics\Instancel.

7. Asviews agora serdo carregadas. Selecione as views que deseja migrar. A ferramenta processara apenas
views ndo excluidas (views cujo valor do atributo IsDeleted é false), independentemente da opc¢do escolhida.

¢ (A), digite A ou pressione Enter para migrar todas as views.
e (B), digite B para especificar o dominio dos criadores de views cujas views vocé gostaria de migrar.

¢ (C), digite C para inserir um caminho do arquivo de ID da view de entrada para migrar um conjunto
especifico de views.

Ao executar a ferramenta, ela cria um arquivo
SetupPlintegratorSetup_ldentityMigration_FailedViews_TimeStamp.txt que contém os IDs das views que
falharam.

8. No prompt "Se alguma identidade do AF no servidor AF e banco de dados de origem da view ndo puder ser
encontrada para o criador de views, vocé deseja que a ferramenta use as identidades do AF da conta de
servico, se validas?" prompt, especifique a opg¢do a ser usada:

¢ Na&o (N), digite N ou pressione Enter se desejar que a ferramenta pule qualquer view cujo criador ndo
possa ser mapeado para identidades do AF com acesso a dados de leitura no banco de dados do AF de
origem da view.

e Sim (Y), digite Y para usar as identidades do AF da conta de servigo em vez dessas views.
9. No prompt, especifique se deseja continuar com a migracao:

¢ N&o (N), digite N.

e Sim (Y), digite Y para executar a ferramenta.

10. ApOds executar a ferramenta de migragdo de identidade, os seguintes arquivos estardo presentes na pasta
%/PIHOME%\dat.

¢ SetupPlintegratorSetup_ldentityMigration_FailedViews_.txt: lista de IDs de views aos quais nao foi
possivel adicionar identidades do AF. Esse arquivo pode ser usado como entrada para a ferramenta para
uma execugdo posterior.

¢ SetupPlintegratorSetup_ldentityMigration_Report_.csv: resultados no formato CSV.

¢ SetupPlintegratorSetup_ldentityMigration_Report_.html: resultados no formato HTML, que pode ser
visualizado em um navegador da Web.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 182


https://docs.aveva.com/bundle/pi-server-af-pse/page/1021578.html
https://docs.aveva.com/bundle/pi-server-af-pse/page/1021578.html

'AV EVA\TM Pl Integrator for Business Analytics

Seguranca do Pl Integrator Framework

SetupPlintegratorSetup_ldentityMigration_Logs.txt: logs de migracdo de views.

*SetupPlintegratorSetup_ldentityMigration_InstancePathBackup_.xml: backup dos elementos do AF,
atributos e templates do InstancePath. Esse arquivo ndo estara presente se a ferramenta for executada
no modo de visualizacao.

Executar a ferramenta de migracao de identidade usando
argumentos de linha de comando

1. Na maquina em que vocé descompactou a ferramenta de migracdo de identidade, abra um command
prompt como administrador e navegue até o diretdrio local onde os arquivos descompactados estao
localizados.

2. Paravisualizar o texto de ajuda voltado aos argumentos de linha de comando para a ferramenta, insira:
IdentityMigrationTool /?

3. Para executar a ferramenta de migracdo de identidade, insira: IdentityMigrationTool /l:InstancePath
[/D:ServiceAccountSAM] [/M [/N]] [/O] [/S:SAMDomain /U:UPNDomain] [/V:pathTolnputViewlIDsFile].

em que:

/l:InstancePath — o valor de InstancePath do arquivo %PIHOMEG64 \Integrators\BA\
CAST.UL.WindowsService.exe.config.

/D:ServiceAccountSAM — (opcional) se for especificado, a ferramenta usara como padrio as identidades
do AF da conta de servico UPN. As identidades ndo podem ser determinadas ou ndo sdo mapeadas para
guaisquer identidades do AF que tenham acesso a dados de leitura no banco de dados do AF de origem
da view. Se ndo for especificado, a ferramenta ignorard essas views. Especifique ServiceAccountSAM no
formato SAM (dominio\usudrio).

/M — (opcional) se especificado, a ferramenta modificard o template de elemento PI_INTEGRATOR_VIEW
e/ou elementos das views. Se ndo for especificado, a ferramenta sera executada no modo somente
visualiza¢do e ndo fard nenhuma modificacdo.

/N- (opcional) se especificado com ou sem /M, a ferramenta n3o tentard fazer um backup em XML do
elemento listado no valor /l:InstancePath e seus filhos. Se ndo for especificado, mas /M for especificado,
a ferramenta tentara realizar esse backup e sera encerrada se ndo for possivel confirmar se o arquivo de
backup foi criado com sucesso.

/O — (opcional) se especificado, a ferramenta processara views independentemente de o valor do
atributo IDList estar em branco. Se ndo for especificado, a ferramenta ignorara views cujo valor do
atributo IDList ndo estiver em branco.

/S:SAMDomain /U:UPNDomain — (opcional, ndo pode ser especificado se /V for especificado) se
especificado, a ferramenta processara apenas views cujo dominio de conta SAM dos criadores
corresponda ao dominio SAM especificado. Se a opgdo /U:UPNDomain for especificada, a ferramenta
usara o valor de UPNDomain como o dominio UPN (Nome principal do usuario) ao criar identidades do
Windows para esses criadores de views, ou, se fU:UPNDomain n3o estiver presente, a ferramenta
configurard o valor de UPNDomain igual ao valor de SAMDomain.

/V:PathTolnputViewlIDsFile — (opcional, ndo pode ser especificado se /S for especificado) se
especificado, a ferramenta lera IDs de views de entrada do caminho de arquivo especificado e processara
apenas views cujos IDs estejam presentes no arquivo.

4. Apods executar a ferramenta de migragdo de identidade, os seguintes arquivos estardo presentes na mesma
pasta na qual a ferramenta foi executada:
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¢ SetupPlintegratorSetup_ldentityMigration_FailedViews_.txt: lista de IDs de views aos quais nao foi
possivel adicionar identidades do AF. Esse arquivo pode ser usado como entrada para a ferramenta para
uma execugdo posterior.

¢ SetupPlintegratorSetup_ldentityMigration_Report_.csv: resultados no formato CSV.

¢ SetupPlintegratorSetup_ldentityMigration_Report_.html: resultados no formato HTML, que pode ser
visualizado em um navegador da Web.

¢ SetupPlintegratorSetup_ldentityMigration_Logs_.txt: logs de migracao de views.

¢ SetupPlintegratorSetup_ldentityMigration_InstancePathBackup_.xml: backup dos elementos do AF,
atributos e templates do InstancePath, *ndo estara presente se a ferramenta for executada no modo de
visualizac¢do.

Exemplos de parametros de entrada para IdentityMigrationTool

Os exemplos a seguir demonstram o uso de parametros de entrada para a ferramenta de migracdo de
identidade, onde:

¢ A configuracdo da view do Pl Integrator é armazenada no seguinte elemento \\PIAF\Configuration\OSlIsoft\
Pl Integrator for Business Analytics\Instancel.

e Os servicos do Pl Integrator sdo executados na conta de servico prod\piintegratorservice.

¢ O dominio para os criadores de views, como prod\user01, é prod. O sufixo de dominio que queremos aplicar
a esses criadores de views, como user01@prod.opsmain.com é prod.opsmain.com.

¢ O arquivo de ID da view de entrada esta localizado no caminho de arquivo C:\Users\user01\Downloads\
IdentityMigrationTool\SetupPlintegratorSetup_ldentityMigration__FailedViews.txt.

Retornar ao padrao de conta de servico, nao realizar um backup e modificar
views

IdentityMigrationTool.exe /I:"\\PIAF\Configuration\OSlIsoft\PI Integrator for Business Analytics\Instancel"
/D:"prod\piintegratorservice" /M /N

Neste exemplo, a ferramenta executa as seguintes agoes:

¢ (/M) Modifica o template PI_INTEGRATOR_VIEW e elementos de views conforme necessario.
¢ (/N) N3o tenta fazer um backup em XML do InstancePath especificado.
¢ lIgnora todas as views cujo atributo IDList ndo esteja em branco.

¢ (/D:ServiceAccountSAM) A ferramenta usara como padrdo as identidades do AF prod\piintegratorservice da
conta de servigo especificada para quaisquer views cujo criador de views ndo possa ser encontrado ou nao
possa ser mapeado para uma identidade do AF que tenha acesso a dados de leitura no banco de dados do
AF de origem da view.
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Filtrar por dominio do criador de views, modificar views e substituir valores
de atributos IDList ndo vazios

IdentityMigrationTool.exe /I:" \\PIAF\Configuration\OSIsoft\PI Integrator for Business Analytics\Instancel"
/M /O /S:"prod" /U:"prod.opsmain.com"

Neste exemplo, a ferramenta executa as seguintes agoes:

¢ (/M) Modifica o template PI_INTEGRATOR_VIEW e elementos de views conforme necessario.
¢ Tenta fazer um backup em XML do InstancePath especificado.
e (/0O) Substitui qualquer atributo IDList, mesmo que ele ndo esteja em branco.

¢ Ignora views cujo criador de views ndo pode ser encontrado ou ndo pode ser mapeado para nenhuma
identidade do AF que tenha acesso a dados de leitura no banco de dados do AF de origem da view.

e (/S:SamDomain) Ignora quaisquer views cujo criador de views ndo pertenca ao dominio prod especificado.
Para qualquer view cujo criador de views pertenca a esse dominio, sera assumido que o sufixo UPN (Nome
principal do usuario) do criador de views é prod.opsmain.com.

Modificar views e filtrar por uma lista de view de entrada

Neste exemplo, a ferramenta executa as seguintes agoes:

IdentityMigrationTool.exe /I:"\\PIAF\Configuration\OSIsoft\PI Integrator for Business Analytics\Instancel" /M
/V:"C:\Users\user01\Downloads\IdentityMigrationTool\
SetupPlintegratorSetup_ldentityMigration_FailedViews.txt"

¢ (/M) Modifica o template PI_INTEGRATOR_VIEW e elementos de views conforme necessario.
¢ Tenta fazer um backup em XML do InstancePath especificado.
¢ Ignora todas as views cujo atributo IDList ndo esteja em branco

¢ lIgnora views cujo criador de views nao pode ser encontrado ou ndo pode ser mapeado para nenhuma
identidade do AF que tenha acesso a dados de leitura no banco de dados do AF de origem da view.

¢ (/V) Ignora todas as views que ndo estiverem na lista de ID de views de entrada.

Secure views for an identity

Os administradores de servi¢o do Pl Integrator Framework podem atribuir acesso a views para todas as
identidades na pagina Administragao.

1. Cligue noicone de menu E e clique em Administragdo.
2. Na pagina Administragao, clique na guia Usudrios.
A lista Permissoes de acesso do usuario mostra uma lista das identidades do PI AF.

3. Selecione a identidade cujas permissGes vocé deseja configurar. Consulte Permissdes de acesso de view.
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View Permissions

JoyceTest Chwner W' A
EventFrameRowiFilter Chamer W
Test2
- Feader

est

Add View Permissions Remove View Permissions

A lista PermissOes de View exibe as views para a identidade selecionada e as permissGes atuais para essas
views. Consulte a se¢do Permissdes de acesso de view para obter mais informagodes.

4. Selecione a view que deseja configurar.

Selecione a permissdo Proprietario ou Leitor na lista.
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Arquitetura de escala do Pl Integrator for
Business Analytics

O diagrama a seguir mostra a arquitetura do PI Integrator for SAP HANA.

Pl Integrator for Business Analytics com um PI Integrator Worker Node

Cluster Manager

[ Represents separate processes

Destination Targets . _
B Represents required services

Todos os processos do Pl Integrator Framework, Pl Integrator Worker Node e Pl Integrator Sync residem no
mesmo computador.

Cada instancia do Pl Integrator for Business Analytics tem um minimo de um processo do worker node que
gerencia a publicacdo de views incluindo trabalhos agendados, trabalhos de streaming e trabalhos de execucdo
Unica. E possivel adicionar mais maquinas de trabalho para melhorar o desempenho da publicacdo. Isso pode ser
feito durante a instalacdo do Pl Integrator for Business Analytics. Apds a instalagao, é possivel adicionar mais
maquinas usando a op¢ao Adicionar e remover programas no Painel de controle do Microsoft Windows.

Observe que cada processo adicional do Worker Node tem exigéncias de RAM e CPU adicionais. Para obter mais
informacdes, consulte Requisitos do sistema. Ndo sera possivel adicionar nés usando o aplicativo Web do PI
Integrator for Business Analytics.

O Pl Integrator Worker Node publica trabalhos nos destinos. O Gerenciador de Cluster distribui automaticamente
trabalhos, por sua vez, entre as maquinas disponiveis. Por exemplo, suponha que haja duas maquinas de
trabalho e cinco trabalhos. O primeiro trabalho é atribuido a primeira maquina de trabalho, o segundo trabalho
é atribuido a segunda mdaquina de trabalho, o terceiro trabalho é atribuido a primeira maquina de trabalho e
assim por diante. Quando um worker node é adicionado ao cluster, todos os servigos do PI Integrator for
Business Analytics sdo reiniciados e o Gerenciador de Cluster equilibra os trabalhos em todas as maquinas
disponiveis, incluindo a maquina recém-adicionada.

Nota: as tarefas ndo sdo atribuidas as maquinas em ordem alfabética. Se uma maquina ficar inativa, o
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Gerenciador de Cluster reatribuira os trabalhos que foram atribuidos a ela as maquinas de trabalho restantes. O
worker node off-line é reiniciado automaticamente pelo servi¢o do Pl Integrator Framework. Depois de
reiniciada, os trabalhos existentes ndo sdo reequilibrados para incluir a maquina de trabalho reiniciada. No
entanto, novos trabalhos sdo equilibrados entre todas as maquinas que estao funcionando. Se isso resultar em
uma distribuicdo ndo equilibrada de trabalhos, vocé podera reequilibrar manualmente os trabalhos.

Otimizacao dos processos das maquinas de trabalho

Siga estas diretrizes para otimizar o desempenho das maquinas de trabalho:

Instale no minimo dois Pl Integrator Worker Nodes, garantindo que vocé tenha a RAM e CPU necessarias
para suportar worker nodes adicionais. Entdo, se uma das maquinas falhar, a outra podera selecionar os
trabalhos da maquina com falha e os dados da view ainda poderdo ser publicados.

Revise as estatisticas da view e identifique quais views estdo demorando tanto tempo para publicar que a
proxima scan esta faltando. Divida as views problematicas em vdrias views menores. Se o problema persistir,
considere adicionar outra maquina.

Verifique se suas views estdo estruturadas de forma eficiente. Use modelos do PI AF sempre que possivel,
mas ndo crie formatos que retornem resultados inchados. O nimero de correspondéncias de formato tem
um impacto direto sobre o desempenho. Portanto, se possivel, projete o formato de busca na pagina
Selecionar Dados de criar uma view para especificar somente os elementos necessarios e filtrar os
desnecessarios. (Isso é antes dos filtros para linhas serem aplicados.)

Agende suas views para que elas ndo estejam todas publicando ao mesmo tempo. Desloque os trabalhos
entre si.

Se, ap6s otimizar suas views, vocé ainda precisar melhorar o desempenho, adicione uma maquina de trabalho ao
cluster. Consulte Requisitos do sistema para os requisitos de memoria e de hardware. E possivel ter até cinco PI
Integrator Worker Nodes. Todos os worker nodes devem estar no mesmo computador em que o Pl Integrator for
Business Analytics estd instalado.

Pl Integrator for Business Analytics com varios nés do Pl Integrator Worker

Cluster Manager

\j

1 Represents separate processes

Destination Targets ‘ ) .
I Represents required services
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Gerenciar os Pl Integrator Worker Nodes

O Pl Integrator for Business Analytics fornece um Gerenciador de Cluster que pode ser usado para visualizar o
status do cluster e para gerenciar os worker nodes. Para cada mdquina, ele exibe o seguinte:

Nome do servico — nome do servico da maquina de trabalho. Cada worker nodes padrdo é chamado de PI
Integrator Worker Node 1. Cada worker node subsequente é identificado com um ndmero, por exemplo, Pl
Integrator Worker Node 2, Pl Integrator Worker Node 3 e assim por diante.

Nota: os servigos do Pl Integrator Worker Node sdo instalados com o Tipo de Inicializagao definido como
Manual. O servico Pl Integrator Framework reinicia automaticamente o servico conforme necessario.
Portanto, os usudrios ndo precisam reiniciar o servico.

Status — mostra se a maquina estd ativa ou inativa. O servico Pl Integrator Framework reiniciard o servico do
worker node em um minuto.

Endereco — um identificador exclusivo usado internamente que indica o local do TCP para o processo. Esse
identificador muda cada vez que o servico da maquina de trabalho é inicializado.

Os trabalhos em execug¢ao em cada maquina sao exibidos com as seguintes informacgdes:

ID do trabalho — GUID atribuido ao trabalho
Nome do trabalho — nome da view
Status do trabalho — exibe o status do trabalho, por exemplo, Agendado, Publicando, Streaming

Ultimo tempo de execugdo — timestamp da ultima publicacdo da view

E possivel executar as seguintes tarefas de gerenciamento:

Conforme necessario, vocé pode redistribuir os trabalhos de maneira mais uniforme nas maquinas de
trabalho clicando em Reajustar nés.

Clique em um trabalho para ir para a pagina Minhas views em que é possivel obter mais detalhes sobre a
view, incluindo mensagens de log e estatisticas de execucao.
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Destinos Oracle

O Pl Integrator for Business Analytics reserva as strings ID, PlintTSTicks e PlintShapelD que nao fazem distincao
entre mailsculas e minusculas. Se quaisquer colunas forem nomeadas com essas strings reservadas, um
sublinhado (_) serd anexado a string, por exemplo, ID_ou Id_.

O Banco de dados Oracle reserva uma lista adicional de palavras. Se essas palavras aparecerem em um nome de
coluna de view, um sublinhado (_) sera anexado a elas. Por exemplo, ACCESS seria alterado para ACCESS_.
Consulte a documentagdo Oracle para obter mais informagdes sobre as palavras reservadas da Oracle.

A lista de palavras reservadas do Banco de dados Oracle é a seguinte:
ACCESS
ADD

ALL

ALTER
AND

ANY

AS

ASC
AUDIT
BETWEEN
BY

CHAR
CHECK
CLUSTER
COLUMN
COMMENT
COMPRESS
CONNECT
CREATE
CURRENT
DATE
DECIMAL
DEFAULT
DELETE
DESC
DISTINCT
DROP
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ELSE
EXCLUSIVE
EXISTS

FILE

FLOAT

FOR

FROM
GRANT
GROUP
HAVING
IDENTIFIED
IMMEDIATE
IN
INCREMENT
INDEX
INITIAL
INSERT
INTEGER
INTERSECT
INTO

IS

LEVEL

LIKE

LOCK

LONG
MAXEXTENTS
MINUS
MLSLABEL
MODE
MODIFY
NOAUDIT
NOCOMPRESS
NOT
NOWAIT
NULL
NUMBER
OF

OFFLINE
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ON
ONLINE
OPTION
OR

ORDER
PCTFREE
PRIOR
PRIVILEGES
PUBLIC
RAW
RENAME
RESOURCE
REVOKE
ROW
ROWID
ROWNUM
ROWS
SELECT
SESSION
SET
SHARE
SIZE
SMALLINT
START
SUCCESSFUL
SYNONYM
SYSDATE
TABLE
THEN

TO
TRIGGER
uiD
UNION
UNIQUE
UPDATE
USER
VALIDATE
VALUES
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VARCHAR
VARCHAR2
VIEW
WHENEVER
WHERE
WITH
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Para obter assisténcia técnica, contate o Suporte Técnico da OSlsoft pelo telefone +55 11 3053 5040 ou por
Pagina de contato do portal do cliente da OSlsoft. A pagina Fale conosco fornece op¢des de contato adicionais
para clientes fora dos Estados Unidos.

Ao contatar o Suporte Técnico da OSlsoft, tenha estas informag¢Ges em maos:

¢ Nome do produto, versdao e nimeros de compilacdo

¢ Detalhes sobre a plataforma do computador (tipo da CPU, sistema operacional e nimero da vers3o)
¢ Horario em que o problema comecou

¢ Arquivos de log nesse horario

¢ Detalhes de todas as alteracdes no ambiente anteriores ao inicio do problema

¢ Resumo do problema, inclusive os arquivos de log relevantes durante o horario em que o problema ocorreu

Para fazer perguntas a outros usuarios do software OSlsoft, entre na comunidade de usudrios do

OSlsoft, PISquare. Os membros da comunidade podem solicitar conselhos e compartilhar ideias sobre o PI
System. O espaco Pl Developers Clube dentro do Pl Square oferece recursos para ajuda-lo na programacao e
integracdo dos produtos OSlsoft.
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Visao geral

O Pl Integrator for Business Analytics 2020 R2 SP2 (versdo 2.7.0.112) é uma versdo de recurso focada em
aprimorar a flexibilidade de integracao, a seguranca e os recursos de registro em log. Os principais destaques
incluem:

¢ Suporte de contas de servigos virtuais
¢ Ul de escopos de log

e Aprimoramentos adicionais de destino, incluindo selecao dinamica de regido da AWS e compatibilidade
atualizada com as versdes mais recentes do Oracle Database e do Oracle Data Access Components (ODAC)

Esta versao substitui o Pl Views e oferece varias melhorias de log e desempenho.

Para obter mais informacdes sobre recursos e funcées do produto, incluindo requisitos do sistema e instrucdes
de upgrade, consulte Requisitos do sistema e Upgrade do Pl Integrator for Business Analytics.

Aprimoramentos

Foram adicionados os recursos a seguir:

Item de trabalho Descrigao

106816 Adicionado suporte para contas de servigo virtual,
aprimorando a seguranca e a flexibilidade de
implantacgao.

95689 Introduzida uma nova interface de usudrio para
gerenciar e configurar escopos de log, melhorando a
usabilidade.

104079 Descontinuada a funcionalidade do Pl Views para
resolver uma vulnerabilidade critica de seguranga.

108693 Corrigida a configuracdo de destinos da AWS, a lista de
regiGes da AWS agora é carregada dinamicamente de
endpoints de servico em vez de usar uma lista
estatica.

103656 Atualizada a compatibilidade para suportar as versées
mais recentes do Oracle Database e do Oracle Data
Access Components (ODAC).

53833 Aprimorado o registro interno para melhor
diagndstico e monitoramento.
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Correcoes

Esta secdo lista os itens que foram resolvidos nesta versao:

Item de trabalho Descrigao

107139 Aplicado um hotfix para resolver problemas com o
processamento de ID de linha do Redshift.

73695 Corrigido um problema em que o AdIGen2Writer nao
fechava corretamente os arquivos na liberagdo,
garantindo a integridade dos dados.

54501 Aprimoradas as mensagens de excecdo incluindo o
nome da tabela em erros Getlastld para facilitar a
solucdo de problemas.

113283 Implementado o Wrapper de Destino Assincrono no
NLog para melhorar a velocidade de registro em log e
o desempenho geral.

112268 Desativada a capacidade de modificar a porta ao
atualizar por meio do kit de instalagdo para evitar
problemas de configuragdo.

112329 Resolvido um problema em que, apds publicacdes de
gravador HDFS com falha, a préxima publicacdao bem-
sucedida poderia perder dados enfileirados
anteriormente.

117900 Resolvida a validagao em nomes de exibicao durante
operagdes de criacdo, modificacdo ou importacao.

48813 Corrigido um erro ("Nao foi possivel encontrar a View
para o Usudrio") que ocorria ao descartar alteragGes
ou apds tentativas de republicagdo com falha em
views clonadas.

108733 Resolvido um problema em que as views ndo podiam
ser carregadas quando a representacdo do usudrio
estava ativada.

48893 Corrigido um problema em que a porta padrao nao
era liberada apds a desinstalagdo do Integrador se
uma porta ndo padrdo (ndo 443) fosse usada.

48906 Resolvido um problema em que as views de streaming
com valor de chave paravam de enviar dados apds
uma excecao de conexdo AFListener.

48805 Corrigido um bug que fazia com que as views de ativos
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e streaming parassem de publicar dados apds uma
excecao de conexdo do SQL Server de back-end.

48850

Corrigido um problema do instalador em que a
verificagdo do servidor AF falhava se o dominio da
conta de servico gMSA estivesse incorreto.

113281

Aprimorada a légica de processamento de exce¢do
para evitar reinicializacGes desnecessarias do worker
node em determinadas implantacGes.

113475

Resolvido um problema duplicado em que as views de
streaming com valor de chave paravam de enviar
dados apds uma excec¢do de conexao AFListener.

48626

Mensagens de erro do conjunto de dados
aprimoradas para serem mais precisas quando os
dados de atualizagao falham.

48731

Politicas de retencdo fixas para que os limites
filterMinimum/MaximumFrequency agora sejam
incluidos corretamente.

48880

Resolvido um problema em que as mensagens
disparadas por eventos ndo eram enviadas
imediatamente para o Hub de Eventos do Azure.

95089

Corrigido um bug em que os arquivos de saida do
Parquet publicados no S3 poderiam estar sem uma
linha de dados.

69017

Corrigido um problema em que o SqlWriter poderia
relatar estatisticas imprecisas, especialmente durante
a inicializacao do aplicativo.

107603

Atualizagdo do PI Integrator for Business Analytics
usando o .NET Framework 4.6.2 para 4.8 para resolver
vulnerabilidades de seguranca conhecidas e aprimorar
a postura geral de segurancga do sistema.

Problemas conhecidos

Os problemas existentes e as solicitacdes de aprimoramento podem ser examinados no Portal do Cliente.
Consulte o informativo 16600, Como posso ver os anuncios de versao, alertas, problemas conhecidos e
informativos relacionados aos meus produtos? e siga 0 método 2: pesquisa geral para obter instrugdes sobre

como exibir uma lista de problemas conhecidos.
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'AV EVA\TM Pl Integrator for Business Analytics

Notas da versdao

Informacoes de seguranca e informacgoes de orientacao

Temos o compromisso de lancgar produtos seguros. Esta secdo destina-se a fornecer informacgdes relacionadas a
seguranga relevantes para orientar sua decisdo de instalagdo ou upgrade. Nos divulgamos proativamente
informagdes agregadas sobre o nimero e a severidade das vulnerabilidades de seguranga abordadas em cada
versdo. As tabelas abaixo fornecem uma visdo geral dos problemas de seguranga abordados e sua severidade
relativa com base na pontuagdo padrao.

Categoria de severidade Pontuagao CVSS Ndmero de Vl:m:‘erablhdades
corrigidas
Critica 9-10 1
Alta 7-89 4
Média 4-6,9 21
Baixa 0-3,9 5
Arquivos do kit de distribuicao
Product (Produto) Versdo de software

AVEVA PlintegratorBA_ADV_1000_2.7.0.112 .exe |2.7.0.112

AVEVA.PlintegratorBA_ADV_5000_2.7.0.112_.exe | 2.7.0.112

AVEVA.PlintegratorBA_ADV_20000_2.7.0.112_.ex |2.7.0.112
e

AVEVA.PlintegratorBA_ADV_100000_2.7.0.112_.e |2.7.0.112
xe

AVEVA.PlintegratorBA_STD_1000_2.7.0.112_.exe |2.7.0.112

AVEVA.PlintegratorBA_STD_5000_2.7.0.112_.exe |2.7.0.112

AVEVA.PlintegratorBA_STD_20000_2.7.0.112_.ex |2.7.0.112
e

AVEVA.PlintegratorBA_STD_100000_2.7.0.112_.e |2.7.0.112
xe
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AVEVA believes the information in this publication is correct as of its publication date. As part of continued product development, such information is subject to
change without prior notice and is related to the current software release. AVEVA is not responsible for any inadvertent errors. All product names mentioned are
the trademarks of their respective holders.




	PI Integrator for Business Analytics
	PI Integrator for Business Analytics 2020 R2 SP2
	O que é o PI Integrator for Business Analytics?
	Edições do PI Integrator for Business Analytics
	Arquitetura do sistema
	Requisitos do sistema
	Como instalar o PI Integrator for Business Analytics
	Implementação do PI Integrator
	Adicionar servidores e bancos de dados PI AF
	Adicionar e configurar identidades

	Upgrade do PI Integrator for Business Analytics
	Configurar destinos de publicação
	Dicas para configurar Apache Hive
	Obter a ID do locatário para Azure Active Directory
	Configurar o destino do banco de dados do Azure SQL
	Configuração de destino do Pool de SQL dedicado do Azur
	Dicas para configurar o Hadoop Distributed File System (HDFS)
	Instalar os Componentes de acesso ao Banco de dados Oracle
	Configure o destino do Oracle

	Tarefas administrativas
	Adicionar um esquema ao registro do esquema
	Gerenciar o acesso a uma única view
	Gerenciar o acesso a várias views
	Movendo views entre ambientes
	Política de retenção de log
	Política de retenção de estatísticas
	Recuperando streams de saída

	Tipos de dados não suportados
	Iniciar o PI Integrator for Business Analytics
	A página Minhas Views
	Como usar o PI Integrator for Business Analytics
	Offset de coluna
	Dicas para criar formatos em views de evento
	Salvar um esquema para o registro do esquema
	Sobre gatilhos de mensagem
	Configurar quando mensagens são enviadas
	Quais dados são enviados para o destino?
	Dados de recarga de dados históricos
	Definir o formato da view de streaming
	Resultados de grupo utilizando grupos de caractere coringa
	A página Modificar View
	Sobre esquemas
	Use um esquema importado de um arquivo
	Use um esquema importado de um registro do esquema
	Usar um esquema gerado

	Opções de recuperação de dados
	Ajuste como os valores são recuperados
	Como os dados resumidos são calculados
	Adicionar uma coluna de dados
	Adicionar uma coluna de tempo
	Modificar uma coluna
	Filtrar os dados
	Filtro por estruturas de evento

	Atualizar dados manualmente

	Segurança do PI Integrator Framework
	Segurança de dados
	Acesso seguro a dados

	Como executar a ferramenta de migração de identidade
	Retornar ao padrão de conta de serviço, não realizar um backup e modificar views
	Filtrar por domínio do criador de views, modificar views e substituir valores de atributos IDList não vazios
	Modificar views e filtrar por uma lista de view de entrada

	Arquitetura de escala do PI Integrator for Business Analytics
	Strings reservadas
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